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1
Dasar-Dasar 

Internet

Bab 

Internet merupakan hasil perkembangan teknologi informasi dan 
komunikasi yang sangat berguna bagi kehidupan manusia. Internet 
banyak digunakan oleh manusia dalam berbagai aktivitasnya, seperti 
untuk mencari informasi, berkomunikasi, hiburan, dan aktivitas lainnya. 
Internet memudahkan manusia untuk melakukan berbagai aktivitas 
tanpa terbatas oleh tempat dan waktu. Apa yang dimaksud dengan 
Internet? Apa yang dimaksud dengan Intranet? Apa saja keunggulan 
dan kelemahan dari Internet? Bagaimanakah ukuran kecepatan akses 
Internet? Ayo temukan jawaban dari pertanyaan-pertanyaan tersebut 
dengan mempelajari bab ini.

Setelah mempelajari bab ini, diharapkan kamu dapat memahami 
dasar-dasar penggunaan Internet, menjelaskan pengertian dasar 
Internet/Intranet, menyebutkan fasilitas-fasilitas yang ada pada Internet, 
menyebutkan keunggulan dan kelemahan dari Internet, dan mengenal 
ukuran kecepatan akses Internet.

Gambar 1.1 Menggunakan Internet
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Bab 4 | Menggunakan Program Aplikasi

Kegiatanmu, tugas 
praktik untuk siswa.

Tahukah Kamu, 
wawasan tambahan 
untuk siswa yang 
berkaitan dengan 
materi yang dipelajari.

Latihan, soal untuk 
mengasah kemampuan 
kognitif siswa.

Kilasan Materi, 
rangkuman dari materi 
yang telah dipelajari 
pada bab tersebut.

Refleks , umpan balik 
dari materi yang telah 
dipelajari, berupa 
manfaat dari materi 
tersebut.

Kegiatanmu

Carilah informasi dari berbagai sumber untuk menemukan istilah-
istilah lain yang berhubungan dengan Internet dan pengertiannya. 
Tukarkan hasil kerjamu dengan temanmu yang lain, kemudian 
tuliskan istilah yang belum ada di hasil kerjamu untuk menambah 
perbendaharaan istilah.

Mengukur Kecepatan Akses Internet
Pada dasarnya kecepatan akses dari Internet yang kita peroleh 

besarnya tergantung dari jenis ISP (Internet Service Provider) yang 
kita gunakan. Saat ini di Indonesia pada khususnya sudah banyak 
sekali instansi atau badan atau perusahaan yang bertindak sebagai 
ISP. Diantaranya adalah Speedy, Telkomnet instant, Indosat 
Broadband, fastnet, dan masih banyak lagi. 

Tahukah Kamu

1.	 Apa yang dimaksud dengan Internet?
2.	 Apa yang dimaksud dengan Internet?
3.	 Apa perbedaan antara Internet dengan Intranet?
4.	 Jelaskan pengertian world wide web!
5.	 Jelaskan istilah-istilah berikut ini:

a.	 web				   d.  protokol
b.	 browser			   e.  search engine
c.	 HTML

Latihan

1.	 Internet adalah singkatan dari Interconnection Network yang 
secara harfia  berarti hubungan antarjaringan komputer 
(network).

2.	 Intranet adalah sebuah kumpulan jaringan komputer lokal yang 
menggunakan perangkat lunak Internet dan protokol TCP/IP 
atau HTTP.

3.	 Untuk mendapatkan akses Internet, sebuah komputer harus 
menggunakan jasa perusahaan penyedia layanan Internet 
atau Internet Service Provider (ISP).

4.	 Web adalah sekumpulan komputer yang terhubung melalui 
kabel atau tanpa kabel.

5.	 Keunggulan Internet adalah jangkauannya bersifat umum, 
aksesnya tidak terbatas oleh waktu, lebih efektif dan efisien  
dan komunikasi menjadi lebih interaktif.

6.	 Kelemahan Internet adalah adanya penyebaran virus 
komputer, akses melambat jika banyak penggunanya, dan 
penggunaan yang terlalu lama akan menghabiskan biaya yang 
besar.

7.	 Satuan kecepatan akses Internet disebut kbps (kilobits per 
second) atau mbps (megabits per second).

8.	 Kecepatan akses Internet dengan dial up connection dapat 
mencapai 56 kbps, sedangkan dengan WAP (Wireless 
Application Protocol) dapat mencapai 9,6 kbps.

Kilasan Materi

Refleksi
Kamu telah mempelajari dasar-dasar Internet. Manfaat apa yang 
kamu dapatkan dengan mempelajari materi tersebut? Apakah kamu 
dapat menerapkannya dalam kehidupan sehari-hari? Coba ambil 
salah satu materi untuk diterapkan dalam kehidupan sehari-hari.

TIK SMP/MTs Kelas 7vi

A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Sekumpulan komputer individu yang dihubung-hubungkan dengan 
menggunakan protokol Transmission Control Protocol/Internet 
Protocol (TCP/IP) disebut ....
a.	 Internet
b.	 Intranet
c.	 jaringan komputer
d.	 personal computer

Soal-Soal Evaluasi Soal-Soal Evaluasi, 
pertanyaan untuk 
mengukur pemahaman  
siswa setelah 
mempelajari materi 
tersebut.
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Dasar-Dasar 
Internet

Internet merupakan hasil perkembangan teknologi informasi dan komunikasi 
yang sangat berguna bagi kehidupan manusia. Internet banyak digunakan 
oleh manusia dalam berbagai aktivitasnya, seperti untuk mencari informasi, 
berkomunikasi, hiburan, dan aktivitas lainnya. Internet memudahkan manusia 
untuk melakukan berbagai aktivitas tanpa terbatas oleh tempat dan waktu. Apa 
yang dimaksud dengan Internet? Apa yang dimaksud dengan Intranet? Apa saja 
keunggulan dan kelemahan dari Internet? Bagaimanakah ukuran kecepatan 
akses Internet? Ayo temukan jawaban dari pertanyaan-pertanyaan tersebut 
dengan mempelajari bab ini.

Setelah mempelajari bab ini, diharapkan kamu dapat memahami dasar-
dasar penggunaan Internet, menjelaskan pengertian dasar Internet/Intranet, 
menyebutkan fasilitas-fasilitas yang ada pada Internet, menyebutkan keunggulan 
dan kelemahan dari Internet, dan mengenal ukuran kecepatan akses Internet.

Gambar 1.1 Menggunakan Internet
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A.	 Pengertian Internet dan Intranet
Apa yang dimaksud dengan Internet dan Intranet? Apa perbedaan-nya? 

Ayo cermati uraian berikut ini agar kamu memahaminya.

1. 	 Internet
Internet merupakan ‘dunia baru’ yang penuh pesona. Sejak diciptakan 

pada 1970-an, Internet terus memikat untuk dieksplorasi, digali, serta 
dikembangkan oleh para ahli dan pemerhati teknologi. Selain sangat terkenal 
di berbagai kalangan, Internet mudah digunakan siapapun, bahkan mereka 
yang hanya memiliki pengetahuan relatif minim. Internet dapat pula menjadi 
ajang untuk bergaul yang murah, tempat mencari informasi tentang dunia 
hiburan, pendidikan, dan lowongan kerja yang terkini karena para penyaji 
informasi memiliki kepentingan untuk selalu memperbaharui informasi yang 
disajikannya di Internet.

Gambar 1.2 Informasi yang ada di Internet
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Internet adalah singkatan dari Interconnection Network yang secara 
harfiah berarti hubungan antarjaringan komputer (network). Sedangkan, 
network sendiri diartikan sebagai suatu sistem komunikasi data antarkomputer. 
Contoh jaringan komputer yang paling sering ditemukan adalah LAN (Local 
Area Network). LAN menghubungkan komputer-komputer yang berada dalam 
suatu areal atau lokasi tertentu, seperti kantor, sekolah, perusahaan, warnet, 
dan lain-lain.

Gambaran sederhana dari Internet adalah beberapa komputer 
dihubungkan satu sama lain sehingga membentuk jaringan komputer 
(network). Kemudian, sejumlah network (jaringan komputer) digabung dan 
dihubung-hubungkan lagi sehingga jadilah Internet. Jadi, pengertian Internet 
secara umum (menurut bahasa) adalah kumpulan dari jaringan komputer 
yang terhubung dan bekerja sebagai suatu sistem. Sedangkan, pengertian 
Internet secara khusus adalah suatu jaringan komputer terbesar di dunia 
karena menghubungkan seluruh jaringan komputer yang ada di dunia ini. 
Untuk ringkasnya, Internet adalah jaringan komputer global, sedangkan 
jaringan komputer lokal (LAN) dinamakan Intranet.

Internet berasal dari impian J.C.R. Licklider (1915-1990) seorang 
psikolog di Massachusetts Institute of Technology. Impiannya itu tentang 
sebuah Galactic Networks di awal tahun 1960-an yang kemudian dapat 
terwujud setelah ia bekerja di Advanced Research Project Agency (ARPA) di 
Pentagon. Kemudian, Internet dikembangkan dalam suatu penelitian militer 
Amerika Serikat yang disebut Advanced Research Project Agency Network 
(ARPANet). ARPANet menghubungkan pusat penelitian Departemen 
Pertahanan dengan pusat-pusat penelitian yang ada di universitas-universitas 
di Amerika Serikat. Tujuannya adalah menghadapi kemungkinan terjadinya 
serangan nuklir karena sifat jaringan Internet tidak mudah dilumpuhkan 
hanya dengan merusak satu titik pusat layanan. Apabila satu titik diserang, 
maka sistem jaringan tetap dapat berfungsi. Internet memiliki protokol dan 
sistem pencari rute-rute alternatif untuk mengalirkan data dan informasi.

Untuk mendapatkan akses Internet, sebuah komputer harus menggunakan 
jasa perusahaan penyedia layanan Internet atau Internet Service Provider 
(ISP). Dengan jasa perusahaan ISP ini, kamu akan mendapatkan jalur 
Internet (online) setelah menghubungkan komputermu dengan komputer 
servernya. Hubungan (koneksi) antara komputer pengguna dengan komputer 
server perusahaan ISP tersebut biasanya dilakukan lewat jaringan telepon 
(dial up) dengan menggunakan peralatan modem. Melalui komputer server 
yang dimiliki oleh ISP itu, kamu dapat terhubung dengan jaringan komputer 
sedunia (Internet).  

Internet merupakan sebuah kumpulan global (mendunia) ribuan 
jaringan komputer dan jutaan komputer pribadi yang dikelola secara 
bebas. Internet telah memungkinkan komunikasi antarkomputer dengan 
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menggunakan TCP (Transmission Control Protocol) atau IP (Internet 
Protocol) disingkat (TCP/IP) yang didukung media komunikasi, seperti 
satelit dan paket radio. Jadi, jarak jangkauannya tidak terbatas.

Internet dapat menghubungkan komputer dan jaringan komputer yang 
berada di ratusan negara dan departemen atau instansi, baik swasta maupun 
pemerintah. Melalui Internet, siapa pun dapat leluasa mengakses berbagai 
macam informasi dan berbagai tempat. Informasi yang dapat diakses dapat 
berupa teks, grafik, suara, maupun video. Siapa pun yang terhubung ke 
dalam jaringan dapat memperoleh atau memberikan informasi karena Internet 
menyediakan fasilitas-fasilitas yang memungkinkan setiap pengakses untuk 
berbagi informasi.

Jaringan Internet dapat pula berfungsi sebagai media konferensi. 
Sejumlah orang dapat melakukan diskusi dan komunikasi tanpa harus 
bertatap muka secara langsung satu dengan yang lainnya, tetapi hanya 
melalui layar komputer pribadi masing-masing.

Gambar 1.3 Berkomunikasi melalui Internet
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Internet bukan lagi menjadi istilah yang asing bagi sebagian besar orang 
yang bekerja di dunia komputer. Bahkan, bagi orang awam sekalipun, kata-
kata world wide web (www) sudah menjadi bahasa keseharian mereka. Situs-
situs web menampilkan informasi apapun yang ada di segala penjuru dunia 
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ini, tidak peduli seberapapun jauhnya.  Informasi sains dan teknologi, berita 
perang, hasil pertandingan olahraga, sampai informasi yang sifatnya pribadi 
sekalipun sangat mudah didapatkan di web.

Web adalah sekumpulan komputer yang terhubung melalui kabel 
maupun tanpa kabel. Di antara komputer dapat berinteraksi sehingga data 
yang terdapat di komputer lain dapat diakses oleh komputermu. Sebaliknya, 
data yang ditampilkan di komputermu dapat diakses oleh komputer lain. 
Kemampuan akses ini tidak terbatas pada jarak sehingga data di seluruh 
dunia dapat saling dipertukarkan atau saling diakses. Keadaan ini yang 
memunculkan istilah world wide (mendunia) sehingga world wide web (www) 
artinya jaringan yang mendunia.

Gambar 1.4 Salah satu web yang ada di Internet
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Bukannya tidak beralasan apabila manusia saat ini memilih web sebagai 
media penyampaian informasi. Dengan web, seseorang bisa mendapatkan 
informasi mengenai pendidikan, iklan, dan sebagainya. Web juga menjadi 
sarana komunikasi yang digemari karena sifatnya mendunia (world wide) dan 
menjadi ajang tukar pendapat bagi penggunanya.
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Gambar 1.5 Contoh web e-learning
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Karena hal-hal tersebut, maka perkembangan web menjadi sangat 
cepat. Saat ini, web tidak sekedar menampilkan informasi saja, namun 
fungsi web makin meluas. Web mulai digunakan untuk aplikasi yang banyak 
membutuhkan interaksi dari pengguna. Bahkan, belakangan ini muncul istilah 
e-learning, e-commerce, e-goverment, virtual university, dan sebagainya, 
yang semuanya menggambarkan pemanfaatan teknologi informasi, termasuk 
web sebagai  media penyampaian dan pengambilan informasi.

2. 	 Intranet
Intranet adalah sebuah kumpulan jaringan komputer lokal yang 

menggunakan perangkat lunak Internet dan protokol TCP/IP atau HTTP. Oleh 
karena itu, sebuah jaringan Intranet memiliki semua fasilitas yang dimiliki oleh 
Internet seperti e-mail, File Transfer Protocol (FTP), dan lain sebagainya. 
Jaringan Intranet merupakan jaringan Internet yang hanya dimiliki oleh 
kelompok atau perusahaan tertentu dan tidak dapat diakses oleh orang lain. 
Tetapi, Intranet juga dapat terkoneksi ke Internet sehingga memungkinkan 
pertukaran informasi dan data dengan jaringan Intranet lainnya (Internet 
working) melalui backbone Internet.
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Intranet sangat mudah diterapkan, dipelajari, dikembangkan, dan 
dikonfigurasi ulang. Salah satu hal yang terpenting dalam Intranet adalah 
keamanan jaringan (network security). Isu ini sangat sensitif karena jaringan 
telekomunikasi komersial yang dipakai bersifat umum (public service 
communication network) sehingga rentan penyusupan dan penyadapan 
jaringan serta pembajakan data. Sejumlah teknologi keamanan canggih 
terus dikembangkan, seperti firewall dan enkripsi sehingga menjadi kelebihan 
tersendiri ketika diterapkan dalam Intranet. 

Intranet mulai didengung-dengungkan pada pertengahan 1995 oleh 
beberapa penjual produk jaringan yang mengacu pada kebutuhan informasi 
dalam bentuk web di dalam perusahaan. Intranet merupakan jaringan 
komputer dalam perusahaan yang menggunakan komunikasi data standar 
seperti dalam Internet. Artinya, semua fasilitas Internet dapat digunakan 
untuk kebutuhan dalam suatu organisasi atau komunitas.

Dalam perkembangannya, VPN (Virtual Private Network) diciptakan 
untuk membangun sebuah Intranet dengan jangkauan yang luas melalui 
jaringan Internet. Intranet sudah menjadi komponen penting dalam suatu 
perusahaan dewasa ini. Intranet dalam perusahaan akan berkembang sesuai 
dengan perkembangan perusahaan tersebut. Dengan kata lain, semakin 
besar suatu perusahaan, maka Intranet yang diperlukan juga semakin besar. 
Permasalahan ini akan semakin kompleks apabila perusahaan tersebut 
mempunyai banyak kantor cabang yang tersebar di berbagai kota dengan 
jarak yang jauh. Sedangkan, di lain pihak seluruh kantor tersebut memerlukan 
suatu metode untuk selalu berhubungan, misalnya untuk transfer dan 
sinkronisasi data.

Ada beberapa alasan mengapa suatu organisasi menggunakan Intranet, 
di antaranya adalah sebagai berikut:

1)	 Memungkinkan keterpaduan yang mudah antara e-mail internal dan 
eksternal.

2)	 Memungkinkan dipergunakannya perangkat lunak yang mudah, 
berkemampuan cukup, serta terjangkau biayanya maupun teknologi 
penyimpanan, pencarian kembali, mengkomunikasikan, dan mengolah 
sumber-sumber informasi organisasi.

3)	 Memungkinkan kemudahan dalam akses pada berbagai sumber yang 
menarik dari internet, khususnya materi yang dipublikasikan pada World 
Wide Web. 

Penggunaan Intranet dapat mendatangkan beberapa keuntungan, di 
antaranya:

1)	 Produktivitas kerja. Adanya Intranet dapat membantu pekerja dalam 
suatu organisasi untuk memperoleh informasi yang dibutuhkan mereka 
untuk menunjang peran dan tanggung jawabnya masing-masing.
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B.	 Sejarah Perkembangan Internet
Internet yang dikenal pada saat ini merupakan pengembangan dari 

sebuah jaringan yang disebut ARPANet (Advanced Research Projects 
Agency). ARPANet dikembangkan oleh Departemen Pertahanan Amerika 
Serikat sejak 1969. Pada awal 1980-an, ARPANet terpecah menjadi dua 
jaringan, yaitu ARPANet dan MILNet (jaringan militer rahasia), akan tetapi 
keduanya masih mempunyai hubungan sehingga komunikasi antarjaringan 
tetap dapat dilakukan.

Pada mulanya, jaringan ini disebut DARPA Internet, tetapi kemudian 
disebut sebagai Internet saja. Di awal penggunaannya, akses Internet hanya 
terbatas untuk kalangan militer, Departemen Pertahanan, dan Perguruan 
Tinggi. Namun, setelah dibukanya layanan USENet dan BITNet, Internet 
dapat diakses melalui sarana komputer pribadi. Selanjutnya, protokol 
TCP/IP diperkenalkan pada 1982, dan disusul dengan penggunaan sistem 
DNS (Domain Name Service) pada 1984.

Pada 1990, Internet mengalami perkembangan yang sangat pesat. 
Pada masa ini, World Wide Web mulai dikembangkan oleh CERN (Swiss). 
Barulah pada 1992 muncul World Wide Web pertama dengan nama Viola 
yang diluncurkan oleh Pei Wei. Berikutnya, InterNIC didirikan pada 1993 
untuk menjalankan layanan pendaftaran domain. 

Penggunaan Internet secara komersial dimulai pada 1994 yang dipelopori 
oleh perusahaan Pizza Hut, dan Internet Banking pertama kali diaplikasikan 
oleh First Virtual. Pada masa ini, masyarakat di Indonesia mulai menikmati 
penggunaan Internet secara komersial. Setahun kemudian, Compuserve, 
America Online, dan Prodigy mulai memberikan layanan akses ke Internet 
bagi masyarakat umum.

2)	 Pemanfaatan waktu. Melalui Intranet, pegawai organisasi dapat 
memperoleh akses informasi kapanpun sehingga terjadi efisiensi waktu. 
Organisasi juga dapat memberikan informasi setiap saat secara aktual.

3)	 Komunikasi. Adanya Intranet dapat memudahkan komunikasi 
antarbagian dari suatu organisasi, baik secara horizontal atau vertikal.

4)	 Operasi dan manajemen. Intranet dapat digunakan untuk mendukung 
operasi dan keputusan dalam bisnis, baik secara internal maupun 
antarorganisasi.

5)	 Kerangka perubahan budaya kerja. Melalui Intranet, pegawai-
pegawai organisasi dapat terhubung dan bekerja sama dalam dunia 
maya sehingga memungkinkan munculnya pemikiran atau ide untuk 
pengembangan organisasi.
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Gambar 1.6 Web site
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C.	 Istilah-Istilah dalam Internet
Beberapa istilah yang berhubungan dengan Internet dan penggunaanya 

akan dijelaskan berikut ini untuk membantu pengguna Internet dalam 
memahami dunia Internet. 

1)	 Web

Web, berarti jaringan yang dapat menampilkan data-data dan informasi 
lain melalui Internet. Web merupakan bagian dari protokol bahasa http yang 
paling populer.

2)	 WWW (world wide web)

WWW merupakan kumpulan penyedia web untuk dipakai secara massal 
di seluruh dunia. Di dalam WWW, semua dokumen, menu, indeks, dan lain-
lain ditampilkan kepada para pengguna Internet sebagai objek dalam format 
HTML yang dapat dilihat dengan menggunakan Web Browser.

3)	 Web Site 

Web site merupakan sebuah alamat di WWW yang menyediakan informasi 
tertentu. Contohnya: www.yahoo.com, www.google.com, dan www.detik.com. 
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4)	 Web Page 

Web page merupakan bagian dari web site yang merupakan lembaran-
lembaran halaman sebuah web site.

Gambar 1.7 Web page
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5)	 Homepage 

Homepage adalah halaman muka sebuah web site, berisi link-link ke halaman 
yang lain dalam web site yang sama atau web site lainnya. Jika dianalogikan, 
homepage sama dengan daftar isi sebuah buku yang memuat outline buku.

Gambar 1.8 Homepage
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6)	 Browser

Browser adalah aplikasi di Internet 
yang dipakai untuk menjelajah dunia 
Internet. Contohnya: Internet Explorer, 
Mozilla Firefox, Netscape Navigator, dan 
sebagainya.

Gambar 1.9 Logo browser
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7)	 Download

Download adalah pengambilan data atau informasi dari sebuah web site 
untuk ditampilkan atau disimpan di komputer pengguna.

8)	 Upload

Upload merupakan pengiriman data dan informasi dari komputer pengguna 
ke suatu web site.

9)	 E-mail

E-mail adalah surat elektronik yang dapat dikirim dan diterima melalui 
Internet.

Gambar 1.10 E-mail
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13)	 Client

Client adalah komputer pengakses Internet, biasanya dipakai oleh 
pengguna.

14)	 Server

Server adalah komputer penyedia data dan informasi yang akan diakses 
oleh client.

15)	 Modem (Modulator Demodulator)

Modem merupakan alat yang diperlukan oleh sebuah komputer untuk 
menghubungkan dengan komputer lain melalui jaringan Internet. Modem 

10)	 URL (Universal Resource Locator)

URL adalah sistem penamaan alamat situs web. Oleh karena itu, URL 
sering pula dinamakan Internet address (alamat Internet). Setiap protokol 
bahasa mempunyai sistem penulisan alamat yang berbeda-beda. Alamat 
sebuah web site di Internet dapat dijelajah melalui URL.

11)	 HTTP (Hyper Text Transfer Protocol)

HTTP merupakan salah satu protokol bahasa yang digunakan untuk 
berkomunikasi antarserver komputer dalam Internet. Dapat pula dikatakan 
bahwa HTTP merupakan bagian dari URL yang mengidentifikasi lokasi web 
site.

12)	 Hub

Hub merupakan alat yang berfungsi sebagai pusat suatu jaringan. 
Koneksi jaringan didistribusikan melalui hub.

Gambar 1.11 Hub untuk jaringan Internet
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dapat mengubah data serial yang dimiliki oleh komputer menjadi sinyal audio 
yang dimiliki oleh kabel telepon, atau dari sinyal audio menjadi data serial.

16)	 HTML (Hypertext Mark up Language)

HTML merupakan standar format untuk dokumen hypertext. 

17)	 Hypertext

Hypertext merupakan serangkaian kata pada dokumen html yang 
mempunyai hubungan (link) dengan dokumen html lain.

18)	 Hyperlink

Hyperlink ini merupakan fasilitas untuk mereferensikan atau 
menghubungkan sebuah kata, kalimat, simbol, gambar dengan alamat-
alamat di Internet. Sebuah link teks biasanya ditandai dengan teks yang 
bergaris bawah dan berwarna biru, seperti Klik di sini. Namun, tanda utama 
dari sebuah link (link teks atau link gambar) adalah berubahnya kursor mouse 

menjadi tanda  jika diletakkan di atas link tersebut. Jika sebuah link diklik, 
maka program browser akan membuka dokumen atau file yang ditunjuk oleh 
link tersebut. 

19)	 Protokol 

Protokol adalah sejumlah aturan yang menentukan bagaimana dua atau 
lebih komputer saling berkomunikasi.

20)	 Alamat IP

Alamat IP merupakan identitas komputer dalam jaringan yang 
terdiri dari empat bagian (mulai angka 1 sampai 255). Contohnya adalah 
101.09.45.015.

21)	 ISP (Internet Service Provider)

ISP merupakan perusahaan atau lembaga penyedia jasa layanan 
Internet, seperti Wasantara, Indosatnet, Telkomnet, dan sebagainya.

22)	 Search Engine

Search engine merupakan aplikasi pencari data, informasi, alamat web 
site lain melalui input kata kunci dan fitur lainnya
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23)	 Mailing List

Mailing list merupakan suatu forum atau kelompok diskusi di Internet 
yang dapat saling bertukar informasi antarsesama anggota.

24)	 Chatting

Chatting adalah ngobrol di internet, baik melalui tulisan, suara, maupun 
video seperti berbicara bertatapan muka.

Kegiatanmu

Carilah informasi dari berbagai sumber untuk menemukan istilah-istilah 
lain yang berhubungan dengan Internet dan pengertiannya. Tukarkan 
hasil kerjamu dengan temanmu yang lain, kemudian tuliskan istilah 
yang belum ada di hasil kerjamu untuk menambah perbendaharaan 
istilah.

Gambar 1.12 Search engine
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D.	 Keunggulan dan Kelemahan Internet
Di masa sekarang ini, sudah banyak orang yang menggunakan 

Internet untuk berbagai keperluan. Penggunaan Internet memiliki beberapa 
keuntungan, di antaranya adalah:

1)	 Proses komunikasi akan menjadi lebih lancar karena dapat saling 
bertukar pesan melalui e-mail atau teleconference yang digunakan 
sebagai sarana pertemuan atau rapat.
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2)	 Adanya Internet lebih memudahkan untuk melindungi data karena kamu 
dapat menyimpan data di e-mail dengan aman, tanpa dapat diakses oleh 
orang lain jika tidak diketahui user id dan password e-mail yang kamu 
buat.

3)	 Data yang didistribusikan melalui Internet akan lebih cepat 
terdistribusikan.

Alasan yang mendasari orang-orang untuk menggunakan Internet adalah 
keunggulan-keunggulan yang dimilikinya, di samping ada juga kelemahan 
penggunaan Internet. Berikut ini adalah keunggulan dan kelemahan dari 
Internet.

1.	 Keunggulan Internet
Keunggulan-keunggulan yang dimiliki oleh Internet adalah sebagai 

berikut:

a)	 Jangkauan Internet bersifat umum, artinya tidak mengenal tempat, waktu, 
dan jalur birokrasi. Setiap orang di seluruh dunia ini dapat mengakses 
Internet secara bebas untuk mencari dan menyebarkan informasi, 
membuat promosi produk barang dan jasa, atau berkomunikasi dengan 
rekannya.

b)	 Akses Internet tidak dibatasi oleh waktu, artinya setiap waktu kamu dapat 
mengakses Internet karena Internet selalu online selama 24 jam dalam 
sehari.

c)	 Efektivitas dan efisiensi Internet dalam menyelesaikan pekerjaan 
menjadi daya tarik orang-orang untuk menggunakan Internet. Internet 
dapat membantu mencari informasi yang dibutuhkan dengan cepat.

d)	 Komunikasi melalui Internet dengan pengguna lain yang berada di tempat 
yang jauh menjadi lebih interaktif dan fleksibel. Fasilitas chatting dan 
teleconference memungkinkan pengguna Internet untuk berkomunikasi 
dengan tulisan dan berbicara sambil bertatap muka, seolah-olah lawan 
bicara berada di hadapannya.

2.	 Kelemahan Internet
Selain memiliki keunggulan, Internet juga memiliki kelemahan. Beberapa 

kelemahan Internet adalah sebagai berikut:
a)	 Adanya penyebaran virus komputer melalui Internet. Ancaman virus 

komputer yang disebarkan melalui Internet menjadi masalah yang serius 
bagi komputer pengguna.

b)	 Banyaknya pengguna yang mengakses Internet dalam waktu bersamaan 
akan memperlambat akses Internet.
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E.	 Ukuran Kecepatan Akses Internet
Dalam pemakaiannya, Internet memiliki kecepatan akses yang berbeda-

beda, bergantung kepada provider atau saluran yang digunakan. Kecepatan 
akses Internet dapat diukur dari lebar pita (bandwidth) yang merupakan ukuran 
dari besarnya kapasitas untuk pemindahan atau transfer data. Semakin besar 
bandwidth yang dimiliki, maka kecepatan aksesnya semakin besar.

Satuan kecepatan akses Internet adalah Kbps (kilobits per second) atau 
Mbps (megabits per second). 1 kilobits sama dengan 1.000 bits dan 1 megabits 
sama dengan 1.000.000 bits. Misalnya, kecepatan akses Internet suatu 
komputer adalah 56 Kbps. Artinya, komputer tersebut dapat mendownload 
data sebesar 56 Kb dalam waktu 1 detik.

Pada kenyataannya, kecepatan akses Internet dipengaruhi oleh faktor-
faktor lain. Faktor yang mempengaruhi kecepatan akses Internet di antaranya 
adalah:

1)	 Kecepatan komputer pelanggan. Makin cepat kecepatan komputer 
pelanggan, maka makin cepat kecepatan akses Internet.

2)	 Kepadatan lalu lintas Internet sepanjang rute yang dilalui. Makin padat 
lalu lintas Internet yang dilalui, maka makin lambat kecepatan akses 
yang diperoleh.

3)	 Besar bandwidth yang disewa ISP ke Backbone Internet. Makin besar 
bandwidth yang dimiliki, maka makin besar kecepatan akses yang 
diterima.

Membandingkan kecepatan akses Internet berdasarkan bandwidth 
yang dimiliki
Misalnya, komputer A memiliki bandwidth 10 Mbps, sedangkan komputer 
B memiliki bandwidth 20 Mbps. Kedua komputer menggunakan 
provider yang sama. Ketika kamu akan menerima atau mengirim 
e-mail, asumsikan besarnya e-mail yang diterima atau dikirim adalah 4 
Kb, berarti secara teori, untuk bandwidth 10 Mbps (10.000 Kbps) dapat 
mengirim atau menerima 2.500 e-mail dalam 1 detik. Sedangkan, untuk 
bandwidth 20 Mb (20.000 Kbps) dapat mengirim atau menerima 5.000 
e-mail dalam 1 detik. Dengan demikian, makin banyak e-mail yang 
dapat dikirim atau diterima, maka arus transportasi data akan makin 
lancar. Artinya, kecepatan akses akan makin besar.

Contoh
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4)	 Jumlah pengguna yang mengakses server secara bersamaan. Makin 
banyak pengguna yang mengakses server secara bersamaan, maka 
kecepatan akses makin menurun.

5)	 Kemampuan dan kecepatan server dimana pelanggan mengakses. 
Makin cepat server tersebut, maka kecepatan akses makin besar.

Berikut ini adalah kecepatan akses Internet berdasarkan saluran yang 
digunakannya.

1.	 Kecepatan Akses Internet dengan Dial Up melalui Jalur PSTN
Apakah di rumahmu sudah terpasang saluran telepon? Jika sudah dan 

kamu juga memiliki komputer, maka kamu dapat terkoneksi dengan Internet. 
Cara menghubungkan komputer ke Internet menggunakan kabel telepon 
biasa atau lebih sering disebut dengan dial up. Dial up melalui jalur PSTN 
(Public Switched Telephone Network) adalah cara menghubungkan komputer 
ke ISP (Internet Service Provider) melalui jaringan telepon reguler (PSTN), 
contohnya adalah ”Telkomnet Instan” dari ISP Telkom.

Dial up merupakan cara mengakses Internet dengan menghubungkan 
komputer ke Internet melalui saluran telepon rumah. Untuk melakukan 
sambungan dial up membutuhkan alat bantu yang disebut modem. Pada 
umumnya, komputer yang digunakan untuk dial up merupakan komputer 
tunggal. Kecepatan akses Internet menggunakan dial up mencapai 56 kbps. 
Tetapi, jika akses dilakukan pada siang hari, kecepatannya akan berkurang 
karena saluran telepon sangat sibuk.

2.	 Kecepatan Akses Internet dengan ADSL
ADSL (Asymetric Digital Subscriber Line) adalah suatu teknologi 

modem yang bekerja pada frekuensi antara 34 kHz sampai 1104 kHz. Inilah 
penyebab utama perbedaan kecepatan transfer data antara modem ADSL 
dengan modem konvensional (yang bekerja pada frekuensi di bawah 4 
kHz). Keuntungan ADSL adalah memberikan kemampuan akses Internet 
berkecepatan tinggi dan suara/fax secara simultan (di sisi pelanggan dengan 
menggunakan splitter untuk memisahkan saluran telepon dan saluran 
modem).

Bandwidth maksimum yang didapat apabila kita menggunakan akses 
Internet menggunakan ADSL adalah:

a.	 Untuk line rate 384 Kbps, bandwidth maksimum yang didapatkan 
mendekati 337 Kbps. 

b.	 Untuk line rate 384 Kbps, throughput rata-rata (kecepatan download) 
yang bisa didapatkan sekitar 40 Kbps. 

c.	 Untuk line rate 512 Kbps, bandwidth maksimum yang didapatkan 
mendekati 450 kbps. 
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d.	 Untuk line rate 512 Kbps, throughput rata-rata (kecepatan download) 
yang bisa didapatkan sekitar 52 Kbps.

3.	 Kecepatan Akses Internet dengan GPRS
Kebutuhan industri akan komunikasi yang mobile menyebabkan GPRS 

menjadi salah satu teknologi komunikasi data yang banyak digunakan saat 
ini. GPRS adalah kepanjangan dari General Packet Radio Service, yaitu 
komunikasi data dan suara yang dilakukan dengan menggunakan gelombang 
radio. GPRS memiliki kemampuan untuk mengkomunikasikan data dan suara 
pada saat alat komunikasi bergerak (mobile).

Sistem GPRS dapat digunakan untuk transfer data (dalam bentuk paket 
data) yang berkaitan dengan e-mail, data gambar (MMS), dan penelusuran 
(browsing) Internet. Layanan GPRS dipasang pada jenis ponsel tipe GSM 
dan IS-136, walaupun jaringan GPRS saat ini terpisah dari GSM.

Dalam teorinya, GPRS menjanjikan kecepatan mulai dari 56 kbps 
sampai 115 kbps sehingga memungkinkan akses Internet, pengiriman data 
multimedia ke komputer atau notebook. 

4.	 Kecepatan Akses Internet dengan 3G
3G (dibaca: triji) adalah singkatan dari third-generation technology. 

Istilah ini umumnya digunakan mengacu kepada perkembangan teknologi 
telepon nirkabel (wireless).

3G sebagai sebuah solusi nirkabel yang memberikan kecepatan akses 
sebagai berikut: 

a.	 Sebesar 144 Kbps untuk kondisi bergerak cepat (mobile). 
b.	 Sebesar 384 Kbps untuk kondisi berjalan (pedestrian). 
c.	 Sebesar 2 Mbps untuk kondisi statik di suatu tempat. 

5.	 Kecepatan Akses Internet dengan WiFi
Teknologi jaringan tanpa kabel yang dikenal dengan Wirelless Fidelity 

(WiFi) menggunakan frekuensi tinggi berada pada spektrum 2,4 GHz. WiFi 
(Wireless Fidelity) adalah koneksi tanpa kabel seperti handphone dengan 
mempergunakan teknologi radio sehingga pemakainya dapat mentransfer 
data dengan cepat dan aman. WiFi tidak hanya dapat digunakan untuk 
mengakses Internet, WiFi juga dapat digunakan untuk membuat jaringan 
tanpa kabel di perusahaan. Teknologi WiFi memberikan kebebasan kepada 
pemakainya untuk mengakses Internet atau mentransfer data dari ruang 
rapat, kamar hotel, kampus, dan cafe-cafe yang bertanda “WiFi Hot Spot”. 
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6.	 Kecepatan Akses Internet dengan Wireless Broadband
Wireless broadband memungkinkan akses internet broadband ke 

berbagai perangkat, termasuk handphone, komputer, notebook, dan PDA. 
Dari segi mobilitas, wireless broadband juga dinilai lebih efisien ketimbang 
WiFi yang sekarang menjadi standar Internet nirkabel. Jangkauan WiFi masih 
terbatas kira-kira sampai 100 meter, sementara wireless broadband diklaim 
dapat diakses sampai jarak 1 kilometer dari stasiun pemancarnya.

Akses wireless broadband juga disebut masih bisa diterima di dalam 
kendaraan berkecepatan 60 kilometer per jam. Wireless broadband 
dikembangkan Samsung bersama dengan Electronics and Technology 
Research Institute (ETRI) dan telah mendapat sertifikat dari Wimax Forum. 
Teknologi ini mampu mengirim data dengan kecepatan hingga 50 Mbps. 
Kecepatan transfer data mampu mengungguli kecepatan transfer data 
berplatform HSDPA yang memiliki kemampuan mengirim data hingga 14 
Mbps.

7.	 Kecepatan Akses Internet dengan LAN (Local Area Network)
Salah satu cara untuk terhubung ke Internet adalah dengan menghubungkan 

komputer ke jaringan komputer yang terhubung ke Internet. Cara ini banyak 
digunakan di perusahan, kampus-kampus, dan warnet (warung Internet). 
Sebuah komputer yang dijadikan server (komputer layanan) di hubungkan ke 
Internet. Komputer lain di jaringan tersebut kemudian dihubungkan ke server 
tersebut. Biasanya komputer yang berfungsi sebagai server dihubungkan 
dengan sebuah Internet Service Provider (ISP) melalui kabel telepon atau 
melalui antena. Sedangkan, untuk menghubungkan komputer ke komputer 
server dilakukan dengan menggunakan kartu LAN (LAN Card) dan kabel 
koaksial (UTP). Kebanyakan, LAN mempunyai kecepatan transfer data 10, 
100, atau 1000 Mbps. 

8.	 Kecepatan Akses Internet dengan TV Kabel
Jaringan TV kabel untuk menghubungkan komputer ke Internet telah 

banyak digunakan. Televisi kabel dinilai cocok terutama untuk pengguna 
Internet dari kalangan keluarga (rumah tangga). Kelebihan mengakses 
Internet dengan menggunakan jaringan TV kabel dapat mengakses Internet 
setiap saat dan bebas dari gangguan telepon sibuk.

Jaringan TV kabel ini dapat dipakai untuk koneksi ke Internet dengan 
kecepatan maksimum 27 Mbps downstream (kecepatan download ke 
pengguna) dan 2,5 Mbps upstream (kecepatan upload dari pengguna). Agar 
dapat menggunakan modem kabel, komputer harus dilengkapi dengan kartu 
ethernet (ethernet card).
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Kegiatanmu

Carilah informasi dari berbagai sumber untuk menemukan kecepatan 
akses Internet berdasarkan saluran yang digunakan. Kemudian, 
diskusikan bersama temanmu, saluran mana yang memiliki kecepatan 
akses paling besar.

Mengukur Kecepatan Akses Internet
Pada dasarnya, kecepatan akses dari Internet yang kita peroleh 

besarnya tergantung dari jenis ISP (Internet Service Provider) yang kita 
gunakan. Saat ini di Indonesia pada khususnya sudah banyak sekali 
instansi atau badan atau perusahaan yang bertindak sebagai ISP. 
Di antaranya adalah Speedy, Telkomnet instant, Indosat Broadband, 
fastnet, dan masih banyak lagi. 

Masing-masing ISP biasanya sudah mengatur berapa besar kecepatan 
akses Internet yang diperoleh oleh masing-masing kostumernya. Ada 
beberapa cara yang dapat kamu gunakan untuk mengukur kecepatan 
akses Internet yang kita peroleh, yakni antara lain dengan mengunjungi 
situs-situs Internet yang menyediakan layanan untuk mengukur kecepatan 
akses Internet. Situs-situs yang dapat kamu gunakan untuk mengukur 
kecepatan akses Internet, antara lain seperti: www.speedtest.net, http://
www.sijiwae.net/speedtest/, http://www.mystarone.com/speedtest/meter.
php, dan sebagainya.

Tahukah Kamu

Mengukur kecepatan akses Internet menggunakan situs www.
speedtest.net pada Sabtu, 27 Juni 2009 pukul 08.00 di daerah 
Jakarta
1.	 Kunjungi situs: www.speedtest.net.
2.	 Pilih server: Jakarta (Indonesia).

Contoh
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Gambar 1.13 Memilih server

Gambar 1.14 Testing download
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3.	 Situs akan melakukan testing download secara otomatis.
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Gambar 1.15 Testing upload

Gambar 1.16 Hasil tes kecepatan akses Internet
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4.	 Setelah itu, situs akan melakukan testing upload.

5.	 Situs akan menampilkan hasil tes.

6.	 Berdasarkan hasil tes, dapat disimpulkan bahwa:
a.	 Kecepatan download pada saat itu adalah 0,18 Mbps atau 

180 Kbps.
b.	 Kecepatan upload pada saat itu adalah 0,09 Mbps atau 90 

Kbps.



24 Satelit TIK untuk SMP/MTs Kelas 9

Latihan

1.	 Apa yang dimaksud dengan Internet?
2.	 Apa yang dimaksud dengan Intranet?
3.	 Apa perbedaan antara Internet dengan Intranet?
4.	 Jelaskan pengertian world wide web!
5.	 Jelaskan istilah-istilah berikut ini:

a.	 web				 
b.	 browser			 
c.	 HTML
d.  	 protokol
e.  	 search engine
f.	 HTTP
g.	 URL
h.	 Internet Service Provider
i.	 IP adress
j.	 hyperlink

6.	 Bagaimanakah sejarah perkembangan Internet? Jelaskan secara 
singkat!

7.	 Apa saja keunggulan yang dimiliki oleh Internet?
8.	 Apa saja kelemahan yang dimiliki oleh Internet?
9.	 Jelaskan pengertian satuan kecepatan akses Internet. Bagai-

manakah cara mengukur kecepatan akses Internet? Faktor apa 
saja yang mempengaruhinya?

10.	 Berikan contoh perbedaan kecepatan akses Internet berdasar-kan 
saluran yang digunakan!

1.	 Internet adalah singkatan dari Interconnection Network yang secara 
harfiah berarti hubungan antarjaringan komputer network).

2.	 Intranet adalah sebuah kumpulan jaringan komputer lokal yang 
menggunakan perangkat lunak Internet dan protokol TCP/IP atau 
HTTP.

Kilasan Materi
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3.	 Untuk mendapatkan akses Internet, sebuah komputer harus 
menggunakan jasa perusahaan penyedia layanan Internet atau 
Internet Service Provider (ISP).

4.	 Web adalah sekumpulan komputer yang terhubung melalui kabel 
atau tanpa kabel.

5.	 Keunggulan Internet adalah jangkauannya bersifat umum, 
aksesnya tidak terbatas oleh waktu, lebih efektif dan efisien, dan 
komunikasi menjadi lebih interaktif.

6.	 Kelemahan Internet adalah adanya penyebaran virus komputer, 
akses melambat jika banyak penggunanya, dan penggunaan yang 
terlalu lama akan menghabiskan biaya yang besar.

7.	 Satuan kecepatan akses Internet disebut kbps (kilobits per 
second) atau mbps (megabits per second).

8.	 Kecepatan akses Internet dengan dial up connection dapat 
mencapai 56 kbps, sedangkan dengan WAP (Wireless Application 
Protocol) dapat mencapai 9,6 kbps.

Refleksi

Kamu telah mempelajari dasar-dasar Internet. Manfaat apa yang kamu 
dapatkan dengan mempelajari materi tersebut? Apakah kamu dapat 
menerapkannya dalam kehidupan sehari-hari? Coba ambil salah satu 
materi untuk diterapkan dalam kehidupan sehari-hari.

Refleksi
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Internet sudah digunakan sejak ....
a.	 1960					   

b.	 1970					   

c.	 1980

d.	 1990

2.	 Internet merupakan singkatan dari ....
a.	 International Network

b.	 Integration Network

c.	 Internal Network

d.	 Interconnection Network

3.	  Pengertian Internet secara umum (menurut bahasa) adalah ....
a.	 kumpulan jaringan komputer yang terhubung dan bekerja sebagai 

suatu sistem

b.	 kumpulan jaringan komputer yang tidak saling terhubung, tetapi 
dapat bekerja sebagai suatu sistem

c.	 kumpulan jaringan komputer dari seluruh dunia yang bekerja sebagai 
suatu sistem dalam jaringan

d.	 suatu jaringan komputer terbesar di dunia karena menghubungkan 
seluruh jaringan komputer yang ada di dunia ini

4.	 Berikut ini adalah penjelasan yang berhubungan dengan Intranet, 
kecuali ....
a.	 kumpulan jaringan komputer lokal yang menggunakan perangkat 

lunak Internet dan protokol TCP/IP atau HTTP

b.	 merupakan jaringan Internet yang hanya dimiliki oleh kelompok 
atau perusahaan tertentu dan tidak dapat diakses oleh orang lain

Soal-Soal Evaluasi
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c.	 tidak dapat terkoneksi ke Internet sehingga tidak dapat bertukar 
informasi dan data dengan jaringan Intranet lainnya

d.	 memiliki semua fasilitas yang dimiliki oleh Internet

5.	 Penggunaan sistem DNS (Domain Name Service) pada Internet mulai 
dikembangkan pada ....
a.	 1982

b.	 1984

c.	 1992

d.	 1994

6.	 Jaringan yang dapat menampilkan data-data dan informasi lain melalui 
Internet disebut ....
a.	 world wide web

b.	 web site

c.	 web page

d.	 web

7.	 Pengertian dari download adalah ....
a.	 pengiriman data dan informasi dari komputer pengguna ke suatu 

web site

b.	 pengambilan data atau informasi dari sebuah web site untuk 
ditampilkan atau disimpan di komputer pengguna

c.	 aplikasi di internet yang dipakai untuk menjelajah dunia Internet

d.	 surat elektronik yang dapat dikirim dan diterima melalui Internet

8.	 Suatu forum atau kelompok diskusi di Internet yang dapat saling bertukar 
informasi antarsesama anggota disebut ....
a.	 mailing list

b.	 chatting

c.	 search engine

d.	 Universal Resource Locator
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9.	 Berikut ini adalah keunggulan Internet, kecuali ....
a.	 jangkauannya bersifat umum, tidak mengenal tempat, waktu, dan 

jalur birokrasi

b.	 aksesnya tidak dibatasi oleh waktu karena selalu online selama 24 
jam dalam sehari

c.	 adanya penyebaran virus komputer melalui Internet

d.	 komunikasi dengan pengguna lain yang berada di tempat yang jauh 
menjadi lebih interaktif dan fleksibe

10.	 Satuan kecepatan akses Internet adalah ....
a.	 kilobits

b.	 meter per second

c.	 megabits per meter

d.	 kilobits per second

B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan pengertian Internet dan Intranet dengan kata-katamu sendiri! 

2.	 Perbedaan apa saja yang ada di antara intranet dan internet? Jelaskan!

3.	 Bagaimanakah sejarah perkembangan Internet di dunia ini? 

4.	 Faktor-faktor apa saja yang mempengaruhi perkembangan Internet dari 
generasi ke generasi?

5.	 Ceritakanlah apa yang kamu ketahui tentang istilah berikut ini.
a.	 world wide web			 
b.	 web site					   
c.	 e-mail
d.	 mailing list
e.	 upload
f.	 web page
g.	 home page
h.	 browsing
i.	 ARPANet
j.  	 chatting
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6.	 Apa saja keunggulan dan kelemahan Internet yang dapat kamu 
rasakan?

7.	 Bagaimanakah cara mengukur kecepatan akses Internet? 

8.	 Faktor-faktor apa saja yang mempengaruhi kecepatan akses Internet?

9.	 Tuliskan alamat situs yang menyediakan fasilitas untuk mengukur 
kecepatan akses internet!

10.	 Tuliskan berbagai jenis kecepatan akses internet berdasarkan saluran 
yang digunakan!

C.	 Tuliskan istilah yang berhubungan dengan Internet pada kotak-kotak 
berikut ini berdasarkan jawaban atas pertanyaan yang sesuai.

Pertanyaan Mendatar
1.  	 Alat untuk menghubungkan antarkomputer melalui jaringan Internet

2.  	 Jaringan komputer global

4.  	 Jaringan

7.  	 Lembaga penyedia jasa layanan Internet

8. 	 Penyedia data dan informasi yang akan diakses oleh client

Pertanyaan Menurun
1.	 Forum atau kelompok diskusi di Internet

3.  	 Standar format untuk dokumen hypertext

5.  	 Protokol bahasa http yang paling populer

6.  	 Aplikasi untuk menjelajah dunia Internet
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Di sebuah laboratorium komputer terdapat beberapa buah komputer yang 
saling berhubungan satu sama lain membentuk suatu jaringan komputer. Jaringan 
komputer tersebut terhubung ke jaringan Internet. Untuk membuat koneksi ke 
Internet diperlukan perangkat keras tertentu. Apakah yang dimaksud dengan 
jaringan komputer? Bagaimanakah cara membuat koneksi komputer ke jaringan 
Internet? Perangkat keras apa saja yang diperlukan untuk membuat sambungan 
ke jaringan Internet? Ayo temukan jawaban dari pertanyaan-pertanyaan tersebut 
dengan mempelajari bab ini.

Setelah mempelajari bab ini, diharapkan kamu dapat mendeskripsikan 
dasar-dasar sistem jaringan, mengidentifikasi perangkat keras yang digunakan 
dalam akses ke jaringan Internet, membuat pengaturan koneksi komputer ke 
Internet, dan melakukan berbagai cara untuk memperoleh sambungan Internet.

Gambar 2.1 Jaringan komputer di laboratorium komputer
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dasar-dasar jenisnya

untuk

perangkat

pengaturan

memperagakan

Peta Konsep

Kata Kunci
Jaringan komputer, Local Area Network, Metropolitan Area Network, 
Wide Area Network, Interconnection Network, repeater, bridge, router, 
gateway, leased line, wireless, VSAT
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A.	 Jaringan Komputer
Jaringan komputer adalah sekumpulan komputer individu (personal 

computer) yang dihubung-hubungkan dengan menggunakan protokol 
Transmission Control Protocol/Internet Protocol (TCP/IP). Berdasarkan 
kriterianya, jaringan komputer dibagi menjadi empat kelompok, yaitu jaringan 
komputer lokal, jaringan komputer metropolitan, jaringan komputer skala luas, 
dan interjaringan. Berikut ini adalah penjelasan tentang kelompok jaringan 
tersebut.

1.	 Jaringan Komputer Lokal (Local Area Network atau LAN)
Local Area Network (LAN) merupakan jaringan milik pribadi di dalam 

sebuah gedung atau kampus yang berukuran sampai beberapa kilometer. 
Jarak yang dapat dijangkau oleh LAN kurang lebih 10 km. LAN sering 
digunakan untuk menghubungkan komputer-komputer pribadi dan workstation 
dalam kantor, sekolah, atau pabrik-pabrik untuk memakai resource secara 
bersama (misalnya, printer atau scanner) dan saling bertukar informasi. LAN 
dapat dibedakan dari jenis jaringan lainnya berdasarkan tiga karakteristik, 
yaitu ukuran, teknologi transmisi, dan topologinya.

Gambar 2.2 Jaringan LAN
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Keuntungan dari jaringan LAN adalah sebagai berikut:
a.	 Pertukaran file dapat ilakukan dengan mudah (file sharin ).
b.	 Pemakaian printer dapat dilakukan oleh semua client (printer sharing).
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c.	 File-file data dapat disimpan pada server sehingga data dapat diakses 
dari semua client menurut otorisasi sekuritas dari semua karyawan yang 
dapat dibuat berdasarkan struktur organisasi perusahaan sehingga 
keamanan data terjamin.

d.	 File data yang keluar atau masuk dari dan ke server dapat dikontrol.
e.	 Proses backup data menjadi lebih mudah dan cepat.
f.	 Resiko kehilangan data oleh virus komputer menjadi sangat kecil 

sekali.
g.	 Komunikasi antarkaryawan dapat dilakukan dengan menggunakan 

e-mail dan chat.

2.	 Jaringan Komputer Metropolitan (Metropolitan Area Network 
atau MAN)
Metropolitan Area Network (MAN) merupakan jaringan dengan area 

lebih luas dari LAN, dapat terdiri dari dua atau lebih LAN yang dihubungkan 
bersama-sama dalam batas-batas tertentu, misalnya dalam suatu kawasan 
metropolitan atau satu kota. Jarak maksimum yang dapat dijangkau oleh 
MAN adalah 80 km. MAN dapat mencakup kantor-kantor perusahaan yang 
berdekatan dan dapat dimanfaatkan untuk keperluan pribadi (swasta) atau 
umum. MAN biasanya mampu menunjang data dan suara, bahkan dapat 
berhubungan dengan jaringan televisi kabel. MAN hanya memiliki sebuah 
atau dua buah kabel dan tidak mempunyai elemen switching yang berfungsi 
untuk mengatur paket melalui beberapa output kabel.

Keuntungan jaringan MAN adalah:
a.	 Dapat berhubungan dengan jaringan televisi kabel.
b.	 Jangkauan lebih luas dari LAN.
c.	 Lebih irit kabel jaringan, karena tidak terlalu membutuhkan banyak kabel 

jaringan.

Ko ta 
Bandung

Gambar 2.3 Jaringan MAN
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Gambar 2.4 Jaringan WAN
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3.	 Jaringan Komputer Skala Luas (Wide Area Network atau 

WAN)
Wide Area Network (WAN) adalah jaringan yang mempunyai jangkauan 

area sangat luas, misalnya antarpulau, negara, benua, bahkan ke luar 
angkasa. Contoh WAN yang sangat terkenal adalah Internet. Tetapi, WAN 
dapat juga menjadi network pribadi. Sebagai contoh, suatu perusahaan 
yang memiliki kantor-kantor di berbagai negara dapat memiliki WAN yang 
menghubungkan kantor-kantor tersebut melalui hubungan telepon, satelit, 
dan teknologi-teknologi lainnya. Biasanya, WAN terdiri dari banyak LAN yang 
diinterkoneksikan.

Keuntungan jaringan WAN adalah sebagai berikut:
a.	 Server kantor pusat dapat berfungsi sebagai bank data dari kantor 

cabang.
b.	 Komunikasi antarkantor dapat menggunakan e-mail dan chat.
c.	 Dokumen atau file yang biasanya dikirimkan melalui faksimile ataupun 

paket pos, dapat dikirim melalui e-mail dan transfer file dengan biaya 
yang relatif murah dan dalam jangka waktu yang sangat cepat.

d.	 Pooling dan updating data antarkantor dapat dilakukan setiap hari pada 
waktu yang ditentukan.

Ko ta SURABAYA

Ko ta SEMARANG Ko ta JAKARTA
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4.	 Interjaringan (Interconnection Network atau Internet)
Internet merupakan sekumpulan jaringan komputer yang terhubung. 

Pada umumnya, untuk membangun sebuah jaringan Internet membutuhkan 
peralatan jaringan, seperti repeater (penguat sinyal), bridge (penghubung 
antarjaringan), router (pengatur lalu lintas dalam jaringan), dan gateway.

Komputer yang terkoneksi ke Internet merupakan bagian jaringan. 
Komputer terhubung ke Internet dengan menggunakan modem yang 
terkoneksi ke sebuah Internet Service Provider (ISP). Kemudian, ISP 
akan terkoneksi ke dalam sebuah jaringan yang lebih besar, dan demikian 
seterusnya. Jadi, Internet merupakan jaringan yang berisi jaringan.

Jika pengguna yang ingin terkoneksi ke Internet menggunakan ISP, 
maka ISP harus menyediakan tempat atau terminal yang digunakan untuk 
mengakses jaringan yang disebut Point of Presence (PO P).

Kegiatanmu

Sebelum melakukan kegiatan ini, perhatikanlah aspek keselamatan 
kerjamu. G unakanlah alas kaki yang bersih (misalnya sandal). Ketika 
kamu berada di dalam laboratorium komputer sekolah. Selain itu, 
ketika kamu mengamati sistem jaringan komputer, diusahakan tidak 
memegang bagian yang mengandung aliran listrik. Kamu cukup 
mengamatinya saja.

Coba kamu cari bentuk nyata dari jaringan LAN, MAN, dan WAN yang 
ada di sekitarmu! Misalnya, jaringan LAN pada komputer-komputer 
yang ada di laboratorium komputer sekolahmu. Kemudian, amati sistem 
jaringan tersebut dan gambarkan pada selembar kertas. Mintalah 
informasi kepada petugas/teknisi yang menangani sistem jaringan 
tersebut tentang cara pemasangan dan sistem kerjanya.

B.	 Perangkat Keras Jaringan berdasarkan Jenis Hubungannya
Membangun sebuah jaringan memerlukan seperangkat alat yang terdiri 

dari perangkat keras (hardware) dan perangkat lunak (software). Keduanya 
harus bersama-sama melengkapi komputer. Perangkat keras yang diperlukan 
tergantung pada jenis hubungan yang akan dibangun. Berikut ini adalah 
perangkat keras jaringan berdasarkan jenis hubungan atau sambungannya.
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Gambar 2.5 Skema dial up connection
Sumber: Koleksi penerbit

Perangkat keras yang diperlukan untuk menghubungkan komputer dan 
Internet dengan hubungan dial up adalah sebagai berikut.

a.	 Unit Komputer
Unit komputer yang dibutuhkan terdiri dari monitor, sistem unit CPU, dan 

perangkat tambahan, seperti keyboard, web cam, dan mouse.

Gambar 2.6 Unit komputer
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b.	 Modem (Modulator Demodulator)
Modem adalah sebuah perangkat yang berfungsi untuk mengubah 

data analog menjadi data digital pada saat komputer mengambil data, atau 
mengubah data digital menjadi data analog pada saat komputer mengirimkan 
data.

Terdapat dua jenis modem menurut penempatannya, yaitu modem eksternal 
dan model internal. Modem eksternal adalah modem yang ditempatkan di luar 
komputer dan dapat dipindah-pindah dari satu komputer ke komputer lain. 
Sedangkan, modem internal adalah modem yang sudah terpasang di dalam 
komputer (terpasang langsung ke motherboard komputer).

1.	 Hubungan Dial Up
Hubungan yang paling sederhana sebuah komputer ke jaringan Internet 

adalah dengan memanfaatkan jalur telepon yang terdapat di kantor atau di 
rumah. Jenis hubungan ini sering disebut dial up connection.
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Melalui modem, sebuah komputer dapat terhubung ke Internet sehingga 
siap untuk mengakses dan diakses dunia Internet.

c.	 Jaringan Telepon
Jaringan telepon ini sering dikenal dengan nama PSTN (Public Switch 

Telephone Network). Selain itu, diperlukan jasa perusahaan penyedia 
jaringan (ISP= Internet Service Provider) karena kita tidak dapat membuat 
jaringan sendiri, melainkan ada perusahaan penyedianya. ISP merupakan 
sebuah perusahaan yang menjadi penyedia layanan akses Internet. Agar 
dapat terhubung ke Internet, kita harus mendaftarkan menjadi pelanggan 
sebuah ISP, seperti Indosatnet, Indonet, Telkomnet, dan sebagainya. Pada 
saat mendaftarkan ke ISP, maka ISP akan memberikan sebuah user name 
dan password yang akan digunakan agar dapat mengakses jaringan Internet 
melalui ISP.

2.	 Hubungan Leased Line
Jika diartikan secara selintas, leased line adalah jalur (telepon) yang 

digantikan fungsinya menjadi jalur Internet. Hubungan ini menggantikan 
fungsi jalur telepon menjadi jalur Internet sehingga kita dapat mengakses 
Internet selama 24 jam sehari secara permanen tanpa harus melakukan 
dial up untuk koneksi ke jaringan maupun melakukan disconnect untuk 
memutuskan hubungan dengan Internet.

Gambar 2.8 Skema hubungan leased line
Sumber: Koleksi penerbit

Gambar 2.7 Modem (a) eksternal  (b) internal
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Gambar 2.9 Router
Sumber: Koleksi penerbit

Pada jenis hubungan ini diperlukan perangkat lain yang dinamakan router. 
Router adalah jenis khusus dari komputer yang secara dasar mempunyai 
komponen yang sama dengan komputer, seperti CPU, memory, sistem BUS, 
dan berbagai perantara input atau output. Namun, router didesain untuk 
fungsi khusus yang tidak ada di dalam komputer, seperti menghubungkan dan 
menentukan jalur terbaik untuk pengiriman data dalam jaringan. Seperti juga 
komputer, router memerlukan sistem operasi untuk menjalankan program 
aplikasi. Router menggunakan Internetwork Operating System (IO S) untuk 
menjalankan file konfigur si. File ini berisi instruksi dan parameter yang 
mengontrol alur lalu lintas data melalui router.

3.	 Hubungan Wireless (Tanpa Kabel atau Nirkabel)
Hubungan wireless sama dengan hubungan leased line. Perbedaannya 

terletak pada media yang digunakan. Jika leased line menggunakan kabel 
telepon, maka wireless menggunakan gelombang radio untuk mengirimkan 
dan menerima datanya.

Pada umumnya, frekuensi gelombang yang digunakan di Indonesia 
berada pada rentang 2,4 G hz (2.400.000.000 Hz) dan 5,6 G hz (5.600.000.000 
Hz). Artinya, dalam setiap detiknya pemancar gelombang tersebut akan 
memancarkan 2.400.000.000 sampai 5.600.000.000 gelombang.

Gambar 2.10 Skema hubungan wireless
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Alat pemancar dan penerima gelombang berfungsi untuk menerima 
gelombang data dari jaringan Internet, kemudian diteruskan ke komputer kita 
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b)	 Pemakaian hubungan wireless sebaiknya digunakan jika hubungan 
melalui kabel sudah tidak memungkinkan. Jika masih dimungkinkan 
hubungan melalui kabel, hubungan tanpa kabel jangan dijadikan 
pilihan.

Di beberapa tempat belanja atau tempat wisata, telah ada sarana untuk 
akses Internet secara wireless yang biasa disebut hot spot. Konsumen yang 
membawa komputer (notebook) dengan fasilitas Internetnya dapat langsung 
akses Internet di sekitar tempat itu dalam radius sekitar 20 meter.

Kemajuan teknologi saat ini sudah memungkinkan sebuah perusahaan 
penyedia jasa komunikasi via telepon genggam dapat pula menyediakan jasa 
akses Internet dengan menyediakan kartu khusus (Internet card) yang dapat 
dihubungkan dengan komputer kita. Dengan begitu, kita dapat mengakses 
Internet langsung dari komputer kita selama jaringan telepon selular masih 
tersedia.

Beberapa jenis produk telepon genggam (handphone) sudah dilengkapi 
dengan fasilitas Internet sehingga kamu dapat mengakses Internet secara 
langsung dari HP.

4.	 Hubungan VSAT
VSAT (Very Small Aperture Terminal) memungkinkan terjadinya 

komunikasi data melalui satelit. Data dari komputer di tempat A dikirim ke 
satelit melalui sebuah pemancar, kemudian satelit akan meneruskan data 
tersebut ke komputer di tempat B melalui sebuah pemancar penerima.

Gambar 2.11 Antena wireless
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Hal yang harus diperhatikan untuk 
menggunakan hubungan wireless adalah:
a)	 Hubungan ini rentan terhadap cuaca 

sehingga perubahan cuaca di sekitarnya 
akan banyak berpengaruh terhadap lalu 
lintas data. Ketika cuaca cerah, lalu lintas 
data akan baik. Namun, jika cuaca hujan 
atau banyak petir, lalu lintas data akan 
sangat buruk.

melalui router. Selain itu, alat pemancar ini juga berfungsi untuk memancarkan 
gelombang data dari komputer kita menuju jaringan Internet melalui router. 
O leh karena itu, keberadaan alat pemancar ini sangat penting dalam sistem 
hubungan wireless. Tanpa alat pemancar ini, komputermu tidak dapat 
melakukan sambungan Internet dengan sistem hubungan wireless.
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Gambar 2.12 Skema hubungan VSAT

Gambar 2.13 Hub station VSAT
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Jangkauan hubungan VSAT sangat luas karena gelombang dikirimkan 
terlebih dahulu ke satelit di ruang angkasa, kemudian dikirim lagi ke bumi. 
Hubungan VSAT cocok dipakai untuk komunikasi antarkepulauan, seperti 
di Indonesia. Untuk mencapai daerah-daerah terpencil yang memerlukan 
akses Internet, maka VSAT sangat memungkinkan. Namun hubungan seperti 
ini sangat mahal karena harus memiliki akses ke satelit. O leh karena itu, 
biasanya hubungan seperti ini dipakai untuk kepentingan antarnegara atau 
untuk kepentingan komunikasi yang sangat rahasia. 

Perangkat keras yang digunakan dalam hubungan VSAT adalah sebagai 
berikut.

a.	 Hub Station

VSAT negara A VSAT negara B

Hub station mengontrol seluruh operasi 
jaringan komunikasi. Pada Hub station 
terdapat sebuah server Network Management 
System (NMS) yang memberikan akses 
pada operator jaringan untuk memonitor 
dan mengontrol jaringan komunikasi melalui 
integrasi perangkat keras dan komponen-
komponen perangkat lunak. O perator dapat 
memonitor, memodifikasi, dan mendownload 
informasi konfigurasi individual ke masing-
masing VSAT.

b.	 Remote Station
Sebuah remote station VSAT memiliki komponen-komponen sebagai 

berikut.



42 Satelit TIK untuk SMP/MTs Kelas 9

1)	 Outdoor unit
Outdor unit dari sebuah remote station VSAT terdiri dari:

a)	 Antena

2)	 Up/Down converter
Perangkat ini dikemas dalam satu kemasan, tetapi memiliki dua fungsi 

yang berbeda, yaitu sebagai up converter dan sebagai down converter. Up 
converter berfungsi untuk mengkonversi sinyal intermediate frequency (IF) 

	 Antena berfungsi untuk memancarkan 
dan menerima gelombang radio 
RF. Antena yang dipakai dalam 
komunikasi VSAT adalah sebuah 
solid dish antenna yang memiliki 
bentuk parabola.

b)	 RFT Gambar 2.14 Antena VSAT

Su
m

be
r:

 fo
ru

m
.il

ko
m

-u
ns

ri.
in

fo

	 RFT dipasang pada frame antena dan dihubungkan secara internal 
ke feedhorn. RFT terdiri dari LNA (Low Noise Amplifier ) yang 
berfungsi memberikan penguatan terhadap sinyal yang datang 
dari satelit melalui antena dengan noise yang cukup rendah dan 
bandwidth yang lebar (500 MHz), dan SSPA (Solid State Power 
Amplifie ) yang berfungsi untuk memperkuat daya sehingga sinyal 
dapat dipancarkan pada jarak yang jauh.

Gambar 2.15 Solid State Power Amplifier
Sumber: www.balanced.com

Gambar 2.16 Low Noise Amplifiers
Sumber: www.radiometer-physics.de

Gambar 2.17 Up/down converter 
Sumber: www.wv-comm.com

atau sinyal frekuensi menengah (70 MHz) 
menjadi sinyal RF Up link (5,925 – 6,425 
G Hz). Sedangkan, down converter berfungsi 
untuk mengkonversi sinyal RF Down link (3,7 
MHz – 4,2 MHz) menjadi sinyal Intermediate 
Frequency.
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3)	 Indoor unit
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Gambar 2.18 Modem VSAT 
Sumber: www.signion.com

Gambar 2.19 Satelit geostasioner

Yang merupakan indoor unit 
adalah modem VSAT, yaitu perangkat 
yang berfungsi sebagai modulator dan 
demodulator. Modulasi adalah proses 
penumpangan sinyal informasi kedalam 
sinyal IF. Sedangkan, demodulasi adalah 
proses memisahkan sinyal informasi 
digital dari sinyal IF dan meneruskannya 
ke perangkat teresterial yang ada.

c.	 Satelit Geostasioner
Satelit geostasioner merupakan segmen angkasa pendukung layanan 

VSAT. O rbit ideal untuk satelit komunikasi adalah geostasioner, atau yang 
relatif statis terhadap bumi. Satelit yang digunakan untuk komunikasi hampir 
selalu berada pada orbit geostasioner secara eksklusif, berlokasi sekitar 
36.000 km diatas permukaan bumi. Satelit ini disebut satelit geostasioner, 
karena satelit tersebut selalu berada di tempat yang sama sejalan dengan 
perputaran bumi pada sumbunya.

Fungsi utama satelit dikerjakan oleh transponder. Ada beberapa 
transponder atau repeater dalam badan satelit. Transponder ini memiliki 
fungsi-fungsi sebagai berikut:

1)	 Penerima sinyal. Transponder menerima sinyal yang di uplink oleh VSAT 
atau Hub.

2)	 Translasi frekuensi. Frekuensi dari sinyal yang diterima ditranslasikan ke 
frekuensi yang berbeda, dikenal sebagai frekuensi downlink.

3)	 Penguatan.
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Gambar 2.20 Jendela Control Panel
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Kegiatanmu

Carilah informasi dari berbagai sumber tentang fungsi dan perangkat 
keras yang digunakan untuk mengakses Internet, selain yang telah 
dibahas pada buku ini.

C.	 Pengaturan Koneksi Komputer ke Internet
Agar dapat digunakan untuk mengakses Internet, komputermu harus 

dilengkapi dengan modem, baik modem internal, maupun modem eksternal. 
Selain itu, kamu juga harus melakukan pengaturan pada komputermu. 
Bagaimanakah cara membuat pengaturan agar komputer dapat menjalin 
koneksi dengan Internet? Ayo ikuti langkah-langkah berikut ini agar kamu 
dapat meningkatkan keterampilan teknis dalam membuat pengaturan koneksi 
komputer dengan Internet melalui dial up connection.

1)	 Dari tombol Start, pilih Control Panel.
2)	 Pilih Network Connection pada jendela Control Panel.
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3)	 Pilih Create New Connection.

Gambar 2.21 Membuat koneksi baru
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4)	 Klik Next pada New Connection Wizard.

Gambar 2.22 New Connection Wizard
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5)	 Pilih Connect to the Internet untuk memilih jenis koneksi jaringan, kemudian 
klik Next.

Keterangan:
a)	 Connect to the internet
	 Untuk membuat koneksi internet sehingga kita dapat  melakukan 

browsing ke web dan membaca e-mail.
b)	 Connect to the network at my workplace
	 Untuk membuat koneksi ke jaringan bisnis (menggunakan dial up atau 

VPN) sehingga kita dapat bekerja dari rumah atau tempat lain.
c)	 Set up home or small office networ
	 Untuk membuat koneksi ke jaringan dari sebuah rumah atau kantor yang 

ada atau membuat koneksi baru.
d)	 Set up an advanced connection
	 Untuk membuat koneksi langsung ke komputer lain dengan menggunakan 

port serial, paralel, atau infrared. Bisa juga untuk membuat pengaturan 
agar komputer lain dapat membuat koneksi ke komputer kita.

Gambar 2.23 Memilih jenis koneksi jaringan
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Keterangan:
a)	 Choose from a list of Internet Service Providers (ISPs)
	 Untuk membuat koneksi ke internet melalui daftar Internet Service 

Provider (ISP) yang tersedia.
b)	 Set Up My Connection Manually
	 Untuk membuat koneksi ke internet dengan cara manual, yaitu melalui 

pengaturan untuk membuat dial up connection.
c)	 Use the CD I got from an ISP
	 Untuk membuat koneksi ke internet menggunakan CD yang didapatkan 

dari ISP tertentu.

6)	 Pilih Set up my connection manually untuk membuat pengaturan koneksi 
secara manual, kemudian klik Next.

Gambar 2.24 Memilih pengaturan koneksi secara manual
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7)	 Pilih Connect using a dial-up modem untuk memilih jenis koneksi dial up, 
kemudian klik Next.

Gambar 2.25 Memilih jenis koneksi dial up
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Keterangan:
a)	 Connect using a dial up modem
	 Untuk membuat koneksi ke internet menggunakan modem dan sluran 

telepon ISDN.
b)	 Connect using a broadband connection that requires a user name and 

password
	 Untuk membuat koneksi ke internet dengan kecepatan tinggi 

menggunakan cable modem atau DSL.
c)	 Connect using a broadband connection that is always on 
	 Untuk membuat koneksi ke internet menggunakan broadband connection 

dan selalu aktif setiap saat sehingga kita tidak perlu sign in.
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9)	 Isikan nomor telepon yang akan diakses, misalnya untuk Telkomnet 
Instan adalah 080989999. Kemudian, klik Next.

8)	 Isi nama koneksi dengan nama mudah diingat. Misalnya, Dial Up 
Connection. Kemudian, klik Next.

Gambar 2.27 Menuliskan nomor telepon yang akan diakses

Gambar 2.26 Menuliskan nama koneksi
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11)	 Klik Finish untuk mengakhiri pengaturan.

Gambar 2.29 Mengakhiri pengaturan
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10)	 Isikan User name: telkomnet@instant, Password: telkom, dan Confirm

Password: telkom untuk membuat account. Kemudian, klik Next.

Gambar 2.28 Mengisi informasi account
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Gambar 2.30 Ikon Dial Up Connection
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12)	 Untuk meyakinkan bahwa pengaturan telah berhasil, buka kembali 
jendela Control Panel, kemudian pilih Network Connection. Jika ada 
ikon Dial Up Connection, maka pengaturan telah berhasil.

Kegiatanmu

Sekarang, coba kamu buat pengaturan koneksi ke Internet pada 
komputermu dengan mempraktikkan langkah-langkah yang telah 
dijelaskan pada buku ini. Jika kamu merasa bingung, mintalah 
bimbingan dari gurumu.

D.	 Sambungan Internet dengan Dial Up
Kamu telah belajar melakukan pengaturan untuk membuat koneksi 

komputer ke Internet. Apakah kamu dapat memahaminya? Sekarang, kamu 
akan belajar mempraktikkan cara membuat sambungan ke Internet melalui 
dial up connection. Ayo perhatikan contoh berikut ini, kemudian coba kamu 
praktikkan untuk meningkatkan keterampilan teknismu dalam membuat 
sambungan internet dengan dial up.
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Membuat sambungan internet dengan dial up.
1)	 Klik tombol Start.
2)	 Pilih Connect To, kemudian pilih Dial Up Connection.

Contoh

Gambar 2.31 Membuat koneksi Internet dengan Dial Up
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3)	 Setelah muncul kotak dialog 
Connect Dial Up Connection, 
ketikkan Password yang sudah 
disetting pada pengaturan, 
yaitu telkom.

4)	 Tekan tombol Dial.

Gambar 2.32 Memasukkan password
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5)	 Saluran telepon akan membuat koneksi ke Internet dengan 
menghubungi nomor 080989999.

6)	 Jika password yang dimasukkan benar, maka komputer akan 
langsung terhubung ke Internet sehingga dapat digunakan untuk 
mengakses Internet.

7)	 Jika gagal terhubung ke Internet, ulangi langkah-langkah tersebut 
sampai berhasil terhubung ke Internet.

Gambar 2.33 Mengkoneksikan ke Internet

Gambar 2.34 Komputer telah terhubung ke Internet
Sumber: Koleksi penerbit
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Kegiatanmu

Sekarang, coba kamu praktikkan cara membuat koneksi ke Internet 
dengan menggunakan dial up connection.
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Jaringan Komputer
Jaringan komputer adalah sebuah sistem yang terdiri atas 

komputer dan perangkat jaringan lainnya yang bekerja bersama-sama 
untuk mencapai suatu tujuan yang sama. Tujuan dari jaringan komputer 
adalah:

1)	 Membagi sumber daya, misalnya berbagi pemakaian printer, CPU, 
memory, atau harddisk. 

2)	 Sarana komunikasi, contohnya surat elektronik, instant messaging, 
dan chatting.

3)	 Akses informasi, contohnya web browsing.

Agar dapat mencapai tujuan yang sama, setiap bagian dari jaringan 
komputer meminta dan memberikan layanan (service). Pihak yang 
meminta layanan disebut klien (client) dan yang memberikan layanan 
disebut pelayan (server). Arsitektur ini disebut dengan sistem client-
server dan digunakan pada hampir seluruh aplikasi jaringan komputer.

Berdasarkan skalanya, jaringan komputer dibedakan menjadi:
1)	 Personal Area Network (PAN).
2)	 Campus Area Network (CAN).
3)	 Local Area Network (LAN).
4)	 Metropolitant Area Network (MAN).
5)	 Wide Area Network (WAN).
6)	G  lobal Area Network (G AN).

Pada dasarnya, setiap jaringan komputer ada yang berfungsi 
sebagai client dan juga server. Tetapi, ada juga jaringan yang memiliki 
komputer yang khusus didedikasikan sebagai server, sedangkan yang 
lainnya sebagai client. Ada juga yang tidak memiliki komputer yang 
khusus berfungsi sebagai server saja. O leh karena itu, berdasarkan 
fungsinya, jaringan komputer dibedakan menjadi dua jenis, yaitu 
sebagai berikut.

1)	 Client-server 
Client-server adalah jaringan komputer dengan komputer yang 

didedikasikan khusus sebagai server. Sebuah service/layanan dapat 
diberikan oleh sebuah komputer atau lebih. Contohnya adalah domain 
www.detik.com yang dilayani oleh banyak komputer web server. 
Atau dapat juga banyak service/layanan yang diberikan oleh satu 
komputer. Contohnya adalah server jtk.polban.ac.id yang merupakan 

Tahukah Kamu
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satu komputer dengan multiservice, yaitu mail server, web server, file
server, database server, dan sebagainya.

2)	 Peer to peer 
Peer to peer adalah jaringan komputer dimana setiap host dapat 

menjadi server dan juga menjadi client secara bersamaan. Contohnya, 
dalam file sharing antarkomputer di jaringan Windows Network 
Neighbourhood ada lima komputer (misalnya, diberi nama A, B, C, D 
dan E) yang memberi hak akses terhadap file yang dimilikinya. Pada 
satu saat, A mengakses file share dari B bernama data_nilai.xls dan 
juga memberi akses file soal_uas.doc kepada C. Saat A mengakses file
dari B, A berfungsi sebagai client. Sedangkan, saat A memberi akses 
file kepada C, A berfungsi sebagai server. Kedua fungsi itu dilakukan 
oleh A secara bersamaan. Jaringan yang seperti ini dinamakan peer to 
peer.

Berdasarkan topologinya, jaringan komputer dapat dibedakan 
menjadi:

1)	 Topologi bus
Karakteristik topologi bus adalah sebagai berikut:

a)	 Node-node dihubungkan secara serial sepanjang kabel, dan 
pada kedua ujung kabel ditutup dengan terminator.

b)	 Sangat sederhana dalam instalasi.
c)	 Sangat ekonomis dalam biaya.
d)	 Paket-paket data saling bersimpangan pada suatu kabel.
e)	 Tidak diperlukan hub, yang banyak diperlukan adalah 

T-connector pada setiap ethernet card. 
f)	 Problem yang sering terjadi adalah jika salah satu node rusak, 

maka jaringan keseluruhan dapat down sehingga seluruh 
node tidak bisa berkomunikasi dalam jaringan tersebut.

Gambar 2.35 Topologi bus
Sumber: www.erealmedia.com
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2)	 Topologi bintang (star)
	 Karakteristik topologi bintang adalah sebagai berikut:

a)	 Setiap node berkomunikasi langsung dengan konsentrator 
(HUB).

b)	 Bila setiap paket data yang masuk ke konsentrator (HUB), 
kemudian di broadcast ke seluruh node yang terhubung 
sangat banyak (misalnya memakai hub 32 port), maka kinerja 
jaringan akan semakin turun.

c)	 Sangat mudah dikembangkan.
d)	 Jika salah satu ethernet card rusak, atau salah satu kabel 

pada terminal putus, maka satu kabel pada terminal putus, 
maka keseluruhhan jaringan masih tetap bisa berkomunikasi 
atau tidak terjadi down pada jaringan keseluruhan tersebut.

e)	 Tipe kabel yang digunakan biasanya jenis UTP.

Gambar 2.36 Topologi bintang
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3)	 Topologi cincin (ring)
	 Karaktersitik topologi cincin adalah:

a)	 Node-node dihubungkan secara serial di sepanjang kabel, 
dengan bentuk jaringan seperti lingkaran.

b)	 Sangat sederhana dalam layout seperti jenis topologi bus.
c)	 Paket-paket data dapat mengalir dalam satu arah (ke kiri atau 

ke kanan).
d)	 Problem yang dihadapi sama dengan topologi bus, yaitu 

jika salah satu node rusak, maka seluruh node tidak bisa 
berkomunikasi dalam jaringan tersebut.



Bab 2 | Perangkat Jaringan dan Koneksi Internet 57

e)	 Tipe kabel yang digunakan biasanya kabel atau patch cable 
(IBM tipe 6).

Gambar 2.37 Topologi cincin

Gambar 2.38 Topologi mesh
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4)	 Topologi mesh
	 Karakteristik topologi mesh adalah:

a)	 Topologi mesh memiliki hubungan yang berlebihan antara 
peralatan-peralatan yang ada.

b)	 Susunannya pada setiap peralatan ada di dalam jaringan 
saling terhubung satu sama lain.

c)	 Jika jumlah peralatan yang terhubung sangat banyak, tentunya 
ini akan sangat sulit sekali untuk dikendalikan dibandingkan 
hanya sedikit saja peralatan yang terhubung.
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Latihan

1.	 Jelaskan apa yang dimaksud dengan jaringan komputer! Jelaskan 
dengan kata-katamu sendiri!

2.	 Jelaskan jenis-jenis jaringan komputer berdasarkan kriterianya! Jenis 
jaringan apakah yang dapat kamu lihat di sekolah atau di rumahmu?

3.	 Apa keuntungan dari jaringan komputer lokal (Local Area Network)? 
Apakah kamu dapat merasakan keuntungan dari jenis jaringan 
tersebut? Berikan penjelasan!

5)	 Topologi pohon (tree)
Topologi pohon merupakan bentuk yang lebih luas dari topologi 

bintang. Seperti halnya topologi bintang, perangkat yang ada pada 
topologi pohon juga terhubung kepada sebuah pusat pengendali 
(central HUB) yang berfungsi mengatur lalu lintas di dalam jaringan. 
Meskipun demikian, tidak semua perangkat pada topologi pohon 
terhubung secara langsung ke central HUB, tetapi sebagian lainnya 
terhubung melalui secondary HUB.

Gambar 2.39 Topologi pohon
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Sumber: Wikipedia dengan perubahan seperlunya
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4.	 Tuliskan perangkat keras yang dibutuhkan untuk membuat 
sambungan dial up connection! Jelaskan fungsi dari masing-
masing perangkat keras tersebut!

5.	 Jelaskan jenis-jenis sambungan atau hubungan komputer dengan 
Internet! Apa kelebihan dan kekurangan dari tiap-tiap jenis 
hubungan tersebut?

6.	 Jelaskan fungsi dari perangkat keras berikut ini:
a. 	 modem
b. 	 router
c. 	 wireless

7.	 Bagaimanakah cara membuat pengaturan agar komputer dapat 
menjalin koneksi dengan Internet? Jelaskan dengan singkat 
langkah-langkahnya!

8.	 Bagaimanakah cara membuat sambungan komputer ke Internet 
melalui dial up connection? Apa saja syarat-syarat yang harus 
dipenuhi agar suatu komputer dapat membuat sambungan ke 
Internet melalui dial up connection?

9.	 Apa yang dimaksud dengan client dan server? Jelaskan perbedaan 
keduanya!

10.	 Jelaskan jenis-jenis jaringan komputer berikut ini:
	 a.	 Local Area Network (LAN).
	 b.	 Metropolitant Area Network (MAN).
	 c.	 Wide Area Network (WAN).
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1.	 Jaringan komputer adalah sekumpulan komputer individu (personal 
computer) yang dihubung-hubungkan dengan menggunakan 
protokol Transmission Control Protocol/Internet Protocol (TCP/
IP).

2.	 Local Area Network (LAN) merupakan jaringan milik pribadi di 
dalam sebuah gedung atau kampus yang berukuran sampai 10 
km.

3.	 Metropolitan Area Network (MAN) terdiri dari dua atau lebih jaringan 
LAN yang dihubungkan bersama-sama dalam batas maksimum 
adalah 80 km.

4.	 Wide Area Network (WAN) adalah jaringan yang mempunyai 
jangkaun area sangat luas, misalnya antarpulau, negara, benua, 
bahkan ke luar angkasa.

5.	 Internet merupakan sekumpulan jaringan komputer yang 
terhubung. 

6.	 Untuk membuat sambungan Internet dengan dial up connection 
diperlukan unit komputer, modem, dan jaringan telepon.

7.	 Untuk membangun sebuah jaringan Internet membutuhkan 
peralatan jaringan, seperti repeater (penguat sinyal), bridge 
(penghubung antarjaringan), router (pengatur lalu lintas dalam 
jaringan), dan gateway.

8.	 Untuk membuat sambungan Internet dengan leased line diperlukan 
alat tambahan berupa router.

9.	 Untuk membuat sambungan Internet dengan hubungan wireless 
diperlukan alat tambahan berupa antena wireless.

Kilasan Materi

Refleksi

Kamu telah mempelajari perangkat jaringan dan koneksi Internet. 
Manfaat apa yang kamu dapatkan dengan mempelajari materi tersebut? 
Apakah kamu dapat menerapkannya dalam kehidupan sehari-hari? 
Coba ambil salah satu materi untuk diterapkan dalam kehidupan sehari-
hari.

Refleksi
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Sekumpulan komputer individu yang dihubung-hubungkan dengan 
menggunakan protokol Transmission Control Protocol/Internet Protocol 
(TCP/IP) disebut ....
a.	 Internet
b.	 Intranet
c.	 jaringan komputer
d.	 personal computer

2.	 Jaringan yang mempunyai jangkauan area sangat luas, misalnya 
antarpulau, negara, benua, bahkan ke luar angkasa adalah ....
a.	 jaringan LAN
b.	 jaringan MAN
c.	 jaringan WAN
d.	 interjaringan

3.	 Jarak maksimum yang dapat dijangkau oleh jaringan MAN adalah ....
a.	 10 km
b.	 20 km
c.	 40 km
d.	 80 km

4.	 Berikut ini adalah keuntungan jaringan LAN, kecuali ....
a.	 pemakaian printer dapat dilakukan oleh semua client (printer sharing)
b.	 server kantor pusat dapat berfungsi sebagai bank data dari kantor 

cabang
c.	 proses backup data menjadi lebih mudah dan cepat
d.	 resiko kehilangan data oleh virus komputer menjadi sangat kecil 

sekali

Soal-Soal Evaluasi
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5.		G  ambar di bawah ini adalah ....

a. 	 skema jaringan LAN
b. 	 skema jaringan MAN
c. 	 skema jaringan WAN
d. 	 skema interjaringan

6.	 Berikut ini adalah perangkat keras yang dibutuhkan untuk membuat 
sambungan Internet dengan dial up connection, kecuali ....
a.	 unit komputer
b.	 modem
c.	 jaringan telepon
d.	 router

7.	 Fungsi dari perangkat router adalah ....
a.	 mengatur lalu lintas komunikasi data 
b.	 mengubah data analog menjadi data digital
c.	 menerima gelombang data dari jaringan Internet
d.	 memancarkan gelombang data dari komputer

8.	 Perhatikan gambar berikut ini!
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G ambar di atas adalah ....
a.	 skema dial up connection
b.	 skema hubungan leased line
c.	 skema hubungan wireless
d.	 skema hubungan VSAT

9.	 Perangkat yang berfungsi untuk menerima gelombang data dari jaringan 
Internet dan memancarkan gelombang data dari komputer adalah ....

a.									       

b.	

c.	

d.	

10.	 User name yang digunakan untuk membuat pengaturan sambungan 
dengan dial up connection adalah ....
a.	 telkom@net
b.	 telkom@instant
c.	 telkomnet@instant
d.	 telkom@net.instant
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B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan apa yang kamu ketahui tentang gambar-gambar berikut ini!

a.

b.	

c.	

d.	

Ko ta 
Bandung
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2.	 Jelaskan jenis-jenis sambungan komputer dengan Internet! Tuliskan 
perangkat keras yang dibutuhkan untuk membuat sambungan tersebut!

3.	 Jelaskan fungsi dari perangkat keras berikut ini:

a.									       

b.	

c.

4.	 Bagaimanakah cara membuat pengaturan agar komputer dapat menjalin 
koneksi dengan Internet? Jelaskan dengan singkat!

5.	 Bagaimanakah cara membuat sambungan ke Internet melalui dial up 
connection?

6.	 Bagaimanakah cara yang tepat untuk membuat hubungan wireless 
agar berjalan dengan baik? Jelaskan faktor-faktor yang harus 
diperhatikannya!

7.	 Apa saja keuntungan dari jaringan komputer lokal (LAN)?

8.	 Berikan salah satu contoh jaringan MAN yang ada di daerahmu!

9.	 Jelaskan jenis jaringan komputer berdasarkan fungsinya!

10.	G  ambarkan topologi jaringan komputer yang kamu ketahui!

C.	 Ikutilah petunjuk berikut ini.
Susunlah perangkat berikut ini sehingga dapat digunakan untuk membuat 
koneksi Internet dengan jenis hubungan sebagai berikut:
1.	 Hubungan dial up.
2.	 Hubungan leased line.
3.	 Hubungan wireless.
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Catatan:	semua perangkat tidak harus digunakan, tergantung jenis hubungan 
yang akan dibuat.
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Internet merupakan singkatan dari ....
a.	 International Network
b.	 Interconnection Network
c.	 Integration Network
d.	 Internal Network

2.	 Pengertian Internet secara umum (menurut bahasa) adalah ....
a.	 kumpulan jaringan komputer yang tidak saling terhubung, tetapi 

dapat bekerja sebagai suatu sistem
b.	 kumpulan jaringan komputer dari seluruh dunia yang bekerja 

sebagai suatu sistem dalam jaringan
c.	 suatu jaringan komputer terbesar di dunia karena menghubungkan 

seluruh jaringan komputer yang ada di dunia ini
d.	 kumpulan jaringan komputer yang terhubung dan bekerja sebagai 

suatu sistem

3.	 Internet sudah digunakan sejak ....
a.	 1990
b.	 1980
c.	 1970
d.	 1960

4.	 Berikut ini adalah penjelasan yang berhubungan dengan Intranet, kecuali 
....
a.	 tidak dapat terkoneksi ke Internet sehingga tidak dapat bertukar 

informasi dan data dengan jaringan Intranet lainnya
b.	 kumpulan jaringan komputer lokal yang menggunakan perangkat 

lunak Internet dan protokol TCP/IP atau HTTP
c.	 merupakan jaringan Internet yang hanya dimiliki oleh kelompok 

atau perusahaan tertentu dan tidak dapat diakses oleh orang lain
d.	 memiliki semua fasilitas yang dimiliki oleh Internet

Uji Kompetensi Semester 1
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5.	 Jaringan yang dapat menampilkan data-data dan informasi lain melalui 
Internet disebut ....
a.	 world wide web
b.	 web
c.	 web site
d.	 web page

6.	 Pengertian dari download adalah ....
a.	 pengambilan data atau informasi dari sebuah web site untuk 

ditampilkan atau disimpan di komputer pengguna
b.	 pengiriman data dan informasi dari komputer pengguna ke suatu 

web site
c.	 aplikasi di intenet yang dipakai untuk menjelajah dunia Internet
d.	 surat elektronik yang dapat dikirim dan diterima melalui Internet

7.	 Penggunaan sistem DNS (Domain Name Service) pada Internet mulai 
dikembangkan pada ....
a.	 1992
b.	 1994
c.	 1982
d.	 1984

8.	 Berikut ini adalah keunggulan Internet, kecuali ....
a.	 jangkauannya bersifat umum, tidak mengenal tempat, waktu, dan 

jalur birokrasi
b.	 adanya penyebaran virus komputer melalui Internet
c.	 aksesnya tidak dibatasi oleh waktu karena selalu online selama 24 

jam dalam sehari
d.	 komunikasi dengan pengguna lain yang berada di tempat yang jauh 

menjadi lebih interaktif dan fleksibe

9.	 Suatu forum atau kelompok diskusi di Internet yang dapat saling bertukar 
informasi antarsesama anggota disebut ....
a.	 chatting
b.	 search engine
c.	 mailing list
d.	 Universal Resource Locator



Uji Kompetensi Semester 1 69

10.	 Satuan kecepatan akses internet adalah ....
a.	 kilobits
b.	 kilobits per second
c.	 meter per second
d.	 megabits per meter

11.	 Sekumpulan komputer individu yang dihubung-hubungkan dengan 
menggunakan protokol Transmission Control Protocol/Internet Protocol 
(TCP/IP) disebut ....
a.	 jaringan komputer
b.	 personal computer
c.	 Internet
d.	 Intranet

12.	 Jarak maksimum yang dapat dijangkau oleh jaringan MAN adalah ....
a.	 80 km						      c.	 10 km
b.	 40 km						      d.	 5 km

13.	 Jaringan yang mempunyai jangkauan area sangat luas, misalnya 
antarpulau, negara, benua, bahkan ke luar angkasa adalah ....
a.	 jaringan LAN
b.	 jaringan MAN
c.	 jaringan WAN
d.	 interjaringan

14.	 Berikut ini adalah keuntungan jaringan LAN, kecuali ....
a.	 pemakaian printer dapat dilakukan oleh semua client (printer 

sharing)
b.	 proses backup data menjadi lebih mudah dan cepat
c.	 resiko kehilangan data oleh virus komputer menjadi sangat kecil 

sekali 
d.	 server kantor pusat dapat berfungsi sebagai bank data dari kantor 

cabang

5.		 Gambar di samping adalah ....
a. 	 skema jaringan LAN
b. 	 skema jaringan MAN
c. 	 skema jaringan WAN
d. 	 skema interjaringan
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16.	 Fungsi dari perangkat router adalah ....
a.	 mengubah data analog menjadi data digital
b.	 mengatur lalu lintas komunikasi data 
c.	 menerima gelombang data dari jaringan Internet
d.	 memancarkan gelombang data dari komputer

17.	 Perhatikan gambar berikut ini!

Gambar di atas adalah ....
a.	 skema dial up connection
b.	 skema hubungan leased line
c.	 skema hubungan wireless
d.	 skema hubungan VSAT

18.	 Berikut ini adalah perangkat keras yang dibutuhkan untuk membuat 
sambungan Internet dengan dial up connection, kecuali ....
a.	 unit komputer
b.	 modem
c.	 jaringan telepon
d.	 router

19.	 Perangkat yang berfungsi untuk menerima gelombang data dari jaringan 
Internet dan memancarkan gelombang data dari komputer adalah ....

a.									       

b.	

c.	

d.	
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20.	 User name yang digunakan untuk membuat pengaturan sambungan 
dengan dial up connection adalah ....
a.	 telkom@net
b.	 telkom@instant
c.	 telkomnet@instant
d.	 telkom@net.instant

B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan jenis-jenis sambungan komputer dengan Internet! Tuliskan 

perangkat keras yang dibutuhkan untuk membuat sambungan tersebut!
2.	 Jelaskan fungsi dari perangkat keras berikut ini:

a.									       

b.	

c.

3.	 Bagaimanakah cara membuat sambungan ke Internet melalui dial up 
connection?

4.	 Jelaskan pengertian Internet dan Intranet! Apa perbedaannya?
5.	 Ceritakanlah apa yang kamu ketahui tentang istilah berikut ini:

a.	 world wide web		
b.	 web site			 
c.	 e-mail
d.   	 mailing list
e.  	 chatting

6.	 Apa saja keunggulan dan kelemahan Internet yang dapat kamu 
rasakan?

7.	 Jelaskan apa yang dimaksud dengan jaringan komputer! Tuliskan jenis-
jenis jaringan komputer berdasarkan kriterianya!
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8.	 Apa keuntungan dari jaringan komputer lokal (Local Area Network)?
9.	 Tuliskan perangkat keras yang dibutuhkan untuk membuat sambungan 

dial up connection! Jelaskan fungsi dari masing-masing perangkat keras 
tersebut!

10.	 Bagaimanakah cara membuat pengaturan agar komputer dapat menjalin 
koneksi dengan Internet? Jelaskan dengan singkat!



Bab 3 | Akses Internet 73

Internet menyediakan berbagai fasilitas yang dapat dimanfaatkan untuk 
berbagai keperluan, seperti mencari informasi, berkomunikasi, dan sebagainya. 
Kamu dapat menikmati fasilitas tersebut dengan cara mengakses Internet. 
Untuk mengakses Internet diperlukan perangkat keras dan perangkat lunak 
tertentu. Pada bab sebelumnya, kamu telah mempelajari perangkat keras 
yang diperlukan untuk mengakses Internet. Bagaimana dengan perangkat 
lunaknya? Perangkat lunak apa saja yang dapat digunakan untuk mengakses 
Internet? Bagaimana cara mengakses halaman web? Apa yang dimaksud 
dengan search engine pada Internet? Fasilitas apa saja yang ada di Internet? 
Ayo temukan jawabannya dengan mempelajari bab ini.

Setelah mempelajari bab ini, diharapkan kamu dapat mengidentifikasi
perangkat lunak yang digunakan untuk mengakses internet, mendemonstrasi-
kan akses internet sesuai dengan prosedur, mengidentifikasi search engine 
yang ada di Internet, dan mengidentifikasi beberapa layanan informasi yang 
ada di Internet.

Gambar 3.1 Mengakses Internet di laboratorium komputer sekolah
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membutuhkan jenisnya

caranya

menggunakan

dapat digunakan 
untuk

untuk 
menemukan

menemukan

Peta Konsep

Kata Kunci
Browser, download manager, Mozilla Firefox, bookmark, address, 
search engine, e-mail, mailling list, chatting, file transfer protokol, telnet,
teleconference

Akses 
Internet

Perangkat lunak untuk 
mengakses Internet

Mengakses 
halaman web

Internet 
Explorer

Mozilla 
Firefox

Mesin pencari 
(search engine)

Layanan Internet
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A.	 Perangkat Lunak untuk Mengakses Internet
Pada dasarnya, Internet berisikan berbagai macam informasi yang 

disajikan dalam suatu website. Untuk dapat mengakses website tersebut, 
kamu membutuhkan browser (perangkat lunak yang digunakan untuk 
mengakses Internet). Ada beberapa browser yang dapat digunakan untuk 
mengakses Internet, di antaranya adalah Internet Explorer, Mozilla Firefox, 
Opera, Google Chrome, dan Netscape Navigator. Browser yang paling banyak 
digunakan saat ini adalah Internet Explorer dan Mozilla Firefox. Berikut ini 
adalah penjelasan tentang browser tersebut.

1. 	 Internet Explorer
Internet Explorer merupakan browser bawaan dari sistem operasi 

Windows. Saat ini, Internet exploler sudah mengeluarkan berbagai versi. 
Versi yang terakhir saat ini adalah Internet Explorer versi 8. Hasil survey 
yang dilakukan oleh perusahaan WebSideStory sebagai penganalisa web, 
menunjukkan bahwa pengguna Internet Explorer saat ini mencapai 93,7%. 
Oleh karena itu, Internet Explorer dinyatakan sebagai browser yang paling 
banyak digunakan oleh para pengakses Internet.

Gambar 3.2 Tampilan Google pada Internet Explorer
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Internet Explorer banyak digunakan oleh para pengakses Internet untuk 
melakukan browsing karena memiliki kelebihan-kelebihan seperti berikut:

1)	 Internet Explorer tidak memerlukan memori komputer yang terlalu 
besar sehingga tidak menghambat alur kerja program lain yang sedang 
berjalan secara bersamaan dengan program Internet Explorer.

2)	 Jika komputer menggunakan sistem operasi Windows, Internet 
Explorer sudah secara otomatis terinstal. Oleh karena itu, tidak perlu 
menginstalnya terlebih dahulu.

3)	 Internet Explorer sudah terintegrasi dengan Microsoft Outlook ataupun 
Outlook Express sehingga lebih memudahkan untuk mengirim dan 
membaca e-mail.

Selain memiliki kelebihan, Internet Explorer juga memiliki beberapa 
kekurangan, di antaranya adalah:

1)	 Ukuran aplikasinya besar, dapat mencapai 80 Mb.
2)	 Belum terintegrasi dengan berbagai perangkat lunak download manager, 

seperti Internet Download Manager, Flash Got, Free Download Manager, 
dan lain sebagainya.

3)	 Fitur-fiturnya masih s dikit jika dibandingkan dengan Mozilla Firefox.
4)	 Kecepatan dalam melakukan browsing masih lebih lambat jika 

dibandingkan dengan Mozilla Firefox.
5)	 Hanya dapat digunakan pada komputer yang menggunakan sistem 

operasi Windows, sedangkan pada sistem operasi Linux dan Mac tidak 
bisa menggunakannya.

2. 	 Mozilla Firefox
Mozilla Firefox (aslinya bernama Phoenix dan kemudian untuk sesaat 

dikenal sebagai Mozilla Firebird) adalah penjelajah web antarplatform gratis yang 
dikembangkan oleh Yayasan Mozilla dan ratusan sukarelawan. Mozilla Firefox 
sekarang telah sampai ke versi 3.0.8.

Kelebihan dari Mozilla Firefox adalah:
1)	 Ukuran aplikasi yang relatif lebih kecil, yaitu sekitar 7,3 Mb.
2)	 Mendukung berbagai jenis jalan pintas untuk aksi, baik yang berupa 

tombol pintas, misalnya Ctrl + T untuk membuka tab baru, maupun 
gerakan mouse pintas (mouse gesture), misalnya menekan tombol kanan 
mouse sambil menggeser mouse ke kiri menuju halaman sebelumnya.

3)	 Memiliki fitur organisasi bookmark yang mampu mengorganisasi 
beberapa tab sekaligus.

4)	 Fiturnya lebih banyak dari Internet Explorer.
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Gambar 3.3 Tampilan Google pada Mozilla Firefox
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Kegiatanmu

Carilah informasi dari berbagai sumber tentang perangkat lunak 
yang dapat digunakan untuk mengakses Internet! Menurutmu, 
apa kekurangan dan kelebihan dari perangkat lunak tersebut jika 
dibandingkan dengan perangkat lunak yang lainnya? Diskusikanlah 
bersama teman sekelompokmu. Kemudian, presentasikan hasilnya 
di depan teman-temanmu yang lain sehingga dapat saling bertukar 
informasi.

5.	 Tampilan browser dapat dikostumisasi menggunakan skin.
6.	 Tampilan halaman yang lebih luas dan area toolbar lebih ringkas.
7.	 Kecepatan aksesnya lebih cepat daripada Internet Explorer.

Mozilla Firefox juga memiliki beberapa kekurangan, di antaranya adalah:
1)	 Tidak terintegrasi dengan Microsoft Outlook ataupun Outlook Express.
2)	 Memakan banyak memori komputer sehingga sering mengganggu proses 

dari program lain yang berjalan bersamaan dengan Mozilla Firefox.
3)	 Harus diinstal terlebih dahulu, tidak otomatis seperti halnya Internet 

Explorer yang terinstal bersama dengan sistem operasi Windows.
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B.	 Mengakses Halaman Web
Jika komputermu telah terhubung ke Internet, kamu dapat mengakses 

halaman web tertentu. Bagaimanakah cara mengakses halaman web? Ayo 
perhatikan contoh berikut ini, kemudian coba kamu ikuti langkah-langkahnya 
untuk meningkatkan keterampilan teknismu dalam mengakses halaman 
web.

Mengakses halaman web
1)	 Buatlah sambungan dengan Internet, misalnya dengan dial up 

connection.
2)	 Aktifkan program aplikasi (browser) yang akan dipakai, misalnya 

Internet Explorer. Carilah ikon atau shortcut Internet Explorer pada 
desktop atau taskbar untuk mengaktifkannya.

Contoh

Gambar 3.4 Ikon dan shortcut Internet Explorer
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3)	 Tuliskan alamat http://www.yahoo.com pada Address, kemudian 
klik tombol  (Go) atau tekan Enter.

Gambar 3.5 Menuliskan alamat web
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Gambar 3.6 Tampilan Yahoo
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4)	 Setelah itu akan muncul tampilan alamat yang dituju, situs Yahoo.

Kegiatanmu

Tuliskan alamat-alamat berikut ini pada Address, kemudian tekan Enter.
a.	 www.ilmukomputer.com
b.	 www.kompas.com
c.	 www.republika.com  
d.	 www.detik.com
e.	 www.depdiknas.go.id
f.	 www.depag.go.id
g.	 www.astaga.com
h.	 www.boleh.com

Dalam mengakses halaman web, kamu perlu mengenal komponen atau 
ikon pada browser dan fungsinya. Berikut ini adalah komponen yang ada 
pada Internet Explorer.
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No. Ikon Nama Fungsi

1.
 

Back Menuju ke halaman yang 
sebelumnya diakses

2.
 

Forward
Mengembalikan penjelajahan 
sebelum fungsi “Back” 
digunakan

3.
 

Stop Menghentikan proses loading 
sebuah web site

4.
 

Refresh Melakukan loading kembali dari 
awal

5.
 

Home Untuk kembali ke home page 
yang pertama (tampilan awal)

6. Search
Menampilkan jendela pencarian 
yang berguna untuk membantu 
proses pencarian di Internet

7.
 

Favorites
Menampilkan jendela favourite 
yang berisi alamat situs-situs. 
Analoginya seperti buku telepon

8.
 

History 
Menampilkan jendela yang 
berisi daftar halaman yang telah 
diakses

9.  Mail Membaca e-mail, mengirim 
e-mail, dan membaca berita

10.
 

Print Mencetak halaman web yang 
sedang ditampilkan

11.
 

Word Editing Mengubah tampilan web 
menjadi format Microsoft Word

12.
 

Go To Menuju web site sesuai dengan 
alamat yang telah ditulis

13.
 

Address Space untuk menuliskan alamat 
web site

Tabel 3.1 Komponen pada Internet Explorer dan Fungsinya
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Kegiatanmu

Amatilah tampilan jendela Internet Explorer. Coba kamu temukan 
komponen-komponen yang ada pada jendela Internet Explorer, 
kemudian kamu gunakan komponen-komponen tersebut untuk 
mengetahui fungsinya. Catat hasil kegiatanmu, kemudian diskusikan 
dengan teman sekelompokmu.

C.	 Mengenal Mesin Pencari (Search Engine)
Mesin pencari (search engine) merupakan situs tertentu yang dirancang 

khusus untuk menemukan alamat web site atau artikel berdasarkan kata kunci 
yang diinginkan oleh pencari informasi. Sekarang, sudah banyak situs yang 
menyediakan mesin pencari (search engine) untuk memberikan pelayanan 
yang memuaskan bagi para pengunjung situs tersebut. Berikut ini adalah 
beberapa jenis mesin pencari (search engine) yang tersedia di Internet.

1.	 Mesin Pencari Google
Google merupakan mesin pencari yang sangat terkenal dan banyak 

digunakan oleh banyak orang. Alamat web site Google adalah http://www.
google.com untuk layanan dalam bahasa Inggris atau http://www.google.
co.id untuk layanan dalam bahasa Indonesia.

Gambar 3.7 Mesin pencari Google
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4.	 Mesin Pencari Yahoo
Mesin pencari Yahoo dapat diakses di alamat http://www.yahoo.com 

untuk layanan dalam bahasa Inggris dan http://www.yahoo.co.id untuk 
layanan dalam bahasa Indonesia.

2.	 Mesin Pencari Altavista
Altavista merupakan salah satu mesin pencari terbesar yang mampu 

menampilkan informasi dari basis data situs lain. Mesin pencari Altavista 
dapat diakses pada alamat http://www.altavista.com.

Gambar 3.8 Mesin pencari Altavista
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Gambar 3.9 Mesin pencari Excite
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3.	 Mesin Pencari Excite
Mesin pencari Excite dapat diakses di alamat http://www.excite.

com. Excite merupakan salah satu mesin pencari yang mampu 
menampilkan informasi berupa web, gambar, berita, audio, dan video.
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5.	 Mesin Pencari Scirus
Scirus adalah mesin pencari khusus untuk ilmu pengetahuan. Scirus 

menambahkan sidebar yang menyaring hasil-hasil pencarian untuk akurasi 
maksimal. Scirus memberikan rekomendasi pencarian, kemampuan untuk 
melakukan pencarian di situs lain yang berhubungan dengan kata kunci, dan 
kemampuan untuk menyimpan, email, atau melakukan export situs. Fitur lain 
yang sangat berguna adalah pencarian file berdasarkan tipe, seperti HTML, 
PDF, Word, PS, PPT, dan TeX. Alamat situsnya adalah http://scirus.com.

Gambar 3.10 Mesin pencari Yahoo

Gambar 3.11 Mesin pencari Scirus
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6.	 Mesin Pencari FinQoo
FinQoo adalah sebuah mesin pencari META tag. Walaupun mirip dengan 

Yahoo dan Google, FinQoo menambahkan tipe pencarian ini ke dalam mesin 
pencari yang lebih baru. Salah satu fitur yang dimiliki oleh FinQoo adalah 
“Quick View” untuk menampilkan situs hasil pencarian dalam halaman yang 
sama. Alamat situsnya adalah http://finqoo.co . 

7.	 Mesin Pencari Alltheweb
Alltheweb dapat digunakan untuk mencari informasi di situs-situs 

internet. Selain itu, Alltheweb juga dilengkapi dengan kemampuan mencari 
informasi berupa gambar video, MP3, dan file FTP. Alamatnya adalah http://
www.alltheweb.com. 

Dalam proses penyimpanan ke dalam database, search engine ini 
mampu melakukan pengideksan terhadap satu halaman penuh, berbeda 
dengan Google yang hanya mampu mengindeks sebesar 110 Kb pertama 
dari halaman sebuah situs. Meskipun demikian, Alltheweb tidak mampu 
mencari file-file PDF dan tidak pula menyediakan fasilitas sebuah situs

Gambar 3.12 Mesin pencari FinQoo
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Gambar 3.13 Mesin pencari Alltheweb
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Kegiatanmu

Carilah informasi dari berbagai sumber tentang mesin pencari (search 
engine) lain yang ada di Internet! Temukan alamat situs mesin pencari 
(search engine) tersebut, kemudian coba kamu akses bersama 
temanmu! Apa kelebihan dan kekurangan search engine yang kamu 
temukan tersebut? Menurutmu, mesin pencari (search engine) manakah 
yang lebih mudah untuk digunakan dan hasilnya lebih memuaskan? 
Diskusikanlah bersama teman sekelompokmu!

D.	 Layanan Internet
Internet menghubungkan kita dengan dunia melalui komputer. Kamu 

dapat mengakses informasi yang ada di Internet dan kamu pun dapat diakses 
oleh seluruh komunitas di Internet. Banyak kemudahan yang dapat diperoleh 
dari Internet melalui berbagai fasilitas yang terdapat di dalamnya. Fasilitas-
fasilitas yang ada di Internet adalah sebagai berikut.
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1.	 E-mail (Surat Elektronik)
Secara manual, kamu mengirim surat kepada orang lain melalui Kantor 

Pos dengan menyertakan ongkos dalam bentuk perangko. Pengirimannya 
memerlukan waktu yang cukup lama, apalagi daerah yang dituju letaknya 
jauh. Jika waktu pengirimannya ingin lebih cepat, ongkos yang dikeluarkan 
harus lebih besar.

Fasilitas e-mail adalah fasilitas untuk mengirim dan menerima pesan. 
Jika dianalogikan, e-mail memiliki fungsi yang sama dengan pengiriman surat 
melalui Kantor Pos. Tetapi, terdapat beberapa perbedaan antara mengirim 
surat melalui e-mail dengan mengirim surat melalui Kantor Pos, di antaranya 
adalah sebagai berikut:

a)	 Jumlah lembar kertas surat yang akan dikirimkan tidak terbatas karena 
diukur dengan ukuran ruang dalam penyimpan (bytes). Kamu dapat 
mengirim ratusan bahkan ribuan lembar surat melalui e-mail. Coba kamu 
bayangkan jika harus mengirim surat ribuan lembar melalui Kantor Pos. 
Berapa banyak uang yang harus dikeluarkan untuk membayar biaya 
pengirimannya. Oleh karena itu, mengirim surat melalui e-mail akan 
lebih praktis dan efisien

b)	 Pengiriman pesan atau surat melalui e-mail dapat dilakukan ke banyak 
orang sekaligus.

c)	 Pengiriman pesan atau surat melaui e-mail akan mempercepat waktu 
pengiriman. Jika harus menempuh perjalanan ratusan kilometer 
antarpulau, maka pengiriman melalui e-mail akan lebih efektif dan 
efisien

d)	 Pengiriman melalui e-mail tidak dipengaruhi keadaan cuaca. Selama 
jaringannya masih baik, pesan akan sampai dengan semestinya.

Gambar 3.14 Mengirim surat melalui kantor pos
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2.	 Mailing List (Milis)
Beberapa orang yang memiliki hobi atau profesi yang sama dapat 

berkumpul membentuk sebuah kelompok yang dinamakan mailing list. Jika 
diartikan, mailing list merupakan kumpulan atau daftar (list) orang-orang 
yang memiliki kegemaran atau profesi yang sama. Misalnya, beberapa orang 
siswa yang gemar olahraga dapat membuat milis ”Siswa Olahraga”, siswa 
yang gemar komputer dapat membuat milis ”Siswa Komputer, guru-guru 
dapat membuat milis ”Guru”, dan sebagainya.

Pesan yang sampai kepada seorang anggota milis akan disebarkan 
secara otomatis kepada anggota milis lainnya. Demikian pula pesan yang 
dikirim oleh seorang milis akan disebarkan secara otomatis ke anggota 
milis yang lainnya. Oleh karena itu, untuk membangun kebersamaan dan 
kerjasama sangat baik jika difasilitasi dengan milis.

Apa itu Mailing List?
Mailing list adalah group diskusi yang ada di Internet, dimana 

setiap orang dapat berlangganan dan berpartisipasi di dalamnya. 
Kamu dapat membaca mail orang lain dan kemudian mengirimkan 
balasannya. Secara sederhana, mailing list adalah sebuah daftar alamat 
e-mail orang-orang yang mempunyai kesukaan atau kepentingan yang 
sama. 

Jika seseorang mengirimkan e-mail ke salah satu anggotanya, 
maka akan dikirimkan ke semua orang yang terdapat di dalam daftar. 
Selain itu, setiap kali kita atau orang lain membalas sebuah e-mail, 
e-mail tersebut akan didistribusikan ke setiap mail box masing-masing 
orang yang ada di dalam daftar. Semua proses ini diatur oleh sebuah 
program yang dinamakan Mailing List Manager (MLM’S) atau Mail 
Servers.

Beberapa tips dalam menggunakan mailing list adalah: 
1.	 Subscribe satu atau dua mailing list terlebih dahulu, kemudian 

lihat banyaknya e-mail yang kamu terima, setelah itu baru kamu 
subscribe mailing list yang lain.

2.	 Simpan dan baca instruksi-instruksi yang diberikan setelah kamu 
subscribe ke salah satu mailing list.

3.	 Matikan (unsubscribe) mailing list yang kamu ikuti pada saat 
berlibur, dan subscribe kembali setelah selesai berlibur. Jika tidak, 
maka akan banyak menimbulkan beratus-ratus e-mail masuk 
setiap harinya dan menumpuk pada mailbox. 

Tahukah Kamu
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3.	 Chatting
Kata dasar chatting adalah chat, artinya berbincang atau ngobrol. Dalam 

fasilitas chatting, kamu dapat berkomunikasi langsung secara tertulis dengan 
orang lain yang sama-sama sedang online di Internet.

Chatting merupakan sarana yang murah bagi para pengakses untuk 
berkomunikasi secara tekstual. Jadi, pengguna Internet dapat berkomunikasi 
melalui tulisan. Kemudian, rekan pengguna yang lain akan membalas dalam 
bentuk tertulis pula. Memang ada sedikit kekakuan dibandingkan percakapan 
langsung lewat telepon. Namun, bagi pengguna yang sudah biasa, chatting 
menjadi kegiatan yang mengasyikkan.

Gambar 3.16 Chatting dengan tambahan fasilitas Web Cam
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Perkembangan teknologi komputer dan jaringan telah melahirkan 
kemampuan chatting yang disertai suara (sound). Komunikasi lisan melaui 
chatting sama dengan komunikasi melalui pesawat telepon. Bagi para 
pengguna yang telah melengkapi perangkat komputernya dengan fasilitas 
Web Cam, mereka dapat melakukan chatting dengan melihat wajah rekan 
yang diajak bercakap-cakap.

Gambar 3.15 Menggunakan fasilitas chatting
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4.	 File Transfer Protocol (FTP)
Melalui Internet, kamu juga dapat mengirimkan berkas (file) yang berisi 

tulisan, gambar, animasi, musik, atau game kepada temanmu. Ini dapat 
dilakukan karena Internet menyediakan fasilitas layanan berupa File Transfer 
Protocol (FTP). Fasilitas FTP ini memungkinkan pengguna untuk menyalin file
secara elektronik dari satu komputer ke komputer lainnya di dalam Internet. 
Layanan FTP paling banyak digunakan untuk lalu lintas file, khususnya bagi 
perusahaan dan organisasi atau perseorangan, yang akan mengirimkan 
surat lamaran kerja atau mengirimkan file kepada rekan-rekannya

5.	 Telnet
Fasilitas Telnet memungkinkan kamu untuk mengakses sebuah komputer 

dalam jaringan Internet seperti layaknya kamu bekerja pada komputer kamu 
sendiri. Misalnya, seseorang yang berada di Bandung akan memperbaiki 
naskah yang ada di sebuah komputer di Kalimantan. Maka, ia tidak perlu pergi 
ke Kalimantan, atau ia tidak perlu meminta dikirim filenya. Dengan fasilitas 
Telnet, ia dapat mengakses komputer yang ada di Kalimantan tersebut dan 
langsung memperbaiki naskah yang dimaksud. Orang yang akan mengakses 
harus memiliki alamat IP, user ID, dan password dari komputer rekannya 
agar dapat mengakses secara langsung. Melalui fasilitas Telnet, pengakses 
dapat secara langsung bertukar file yang berisi tulisan, gambar, film, lagu, 
atau game.

6.	 Teleconference (Konferensi Jarak Jauh)
Aplikasi chatting terus dikembangkan sampai tercipta voice chat, yang 

kemudian menjadi teleconference. Caranya adalah dengan menambahkan 
sound card, termasuk VoIP blaster untuk mengompres suara sehingga 
kualitasnya dapat dipertahankan. Ditambah dengan layanan multimedia 
Internet, para ahli dapat mengembangkan suatu layanan teleconference yang 
lebih sempurna. Tujuannya adalah agar para pengakses yang mengunakan 

Gambar 3.17 Teleconference
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Internet dapat melakukan percakapan jarak 
jauh dengan saling memandang satu sama 
lain.

Seorang pejabat negara dapat melakukan 
pertemuan tanpa harus menghadirkan para 
pesertanya di suatu tempat. Peserta dapat 
tetap berada di tempatnya masing-masing, 
namun mereka semua bertemu dalam sebuah 
konferensi jarak jauh, dimana mereka   dapat 
melihat satu sama lainnya, seperti layaknya 
berhadapan langsung secara fisik
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Kegiatanmu

Apakah kamu pernah menggunakan fasilitas yang ada di Internet atau 
melihat orang lain yang menggunakan fasilitas yang ada di Internet? 
Coba kamu cari informasi tentang fasilitas lain yang ada di Internet, 
kemudian diskusikan dengan teman sebangkumu tentang fasilitas apa 
yang dapat dimanfaatkan!

Program Aplikasi untuk Chatting
Dalam dunia Internet, kita dapat saling berkomunikasi dengan 

orang-orang di seluruh dunia dengan menggunakan fasilitas chatting. 
Kegiatan chatting dapat dilakukan dengan berbagai aplikasi, di 
antaranya adalah mIRC, Microsoft Comic, dan Netmeeting. Pada 
dasarnya, chatting merupakan sarana untuk berkenalan dengan 
pengakses Internet yang lainnya di seluruh dunia. Selain itu, kita dapat 
saling bertukar informasi atau pengalaman.

Program aplikasi chatting yang populer saat ini adalah mIRC. Kita 
dapat memperoleh program aplikasi ini secara gratis di situs http://www.
mIRC.co.uk atau di http://www.mIRC.com.

Tahukah Kamu

Latihan

1.	 Apa yang dimaksud dengan browser? Jelaskan dengan kata-
katamu sendiri!

2.	 Tuliskan jenis-jenis browser, kemudian jelaskan kelebihan dan 
kekurangannya!

3.	 Bagaimanakah cara mengakses halaman web? Jelaskan dengan 
kata-katamu sendiri!

4.	 Jelaskan fungsi komponen pada Internet Explorer berikut ini:
a.	 Back				  
b.	 Refresh				  
c.   	 Favorites 
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d.   	 Adress
e.	 History

5.	 Jelaskan pengertian dari mesin pencari (search engine)!

6.	 Tuliskan alamat dari mesin pencari berikut ini:
a.	 Altavista			
b.	 Excite 			 
c.  	 Google
	d.  	 Yahoo

7.	 Berikan penjelasan tentang mesin pencari Altavista! Apa kelebihan 
dan kekurangannya?

8.	 Fasilitas apa saja yang terdapat di Internet? Berikan penjelasan 
singkat tentang fasilitas-fasilitas tersebut!

9.	 Bagaimanakah perbedaan antara mengirim surat melalui e-mail 
dengan mengirim surat melalui Kantor Pos?

10.	 Jelaskan perkembangan fasilitas chatting di Internet! Manfaat apa 
yang dapat dirasakan dengan adanya perkembangan tersebut?

1.	 Browser adalah perangkat lunak yang digunakan untuk mengakses 
Internet.

2.	 Browser yang dapat digunakan untuk mengakses Internet, di 
antaranya adalah Internet Explorer, Mozilla Firefox, Opera, Google 
Chrome, dan Netscape Navigator.

3.	 Internet Explorer merupakan browser bawaan dari sistem operasi 
Windows yang banyak digunakan oleh para pengakses internet.

4.	 Kelebihan Internet Explorer adalah tidak memerlukan memori 
komputer yang terlalu besar, sudah terinstall secara otomatis dalam 
sistem operasi Windows, dan sudah terintegrasi dengan Microsoft 
Outlook ataupun Outlook Express sehingga lebih memudahkan 
untuk mengirim dan membaca e-mail.

5.	 Mozilla Firefox adalah penjelajah web antarplatform gratis yang 
dikembangkan oleh Yayasan Mozilla dan ratusan sukarelawan.

6.	 Kelebihan dari Mozilla Firefox adalah ukuran aplikasi yang relatif 
lebih kecil (sekitar 4,5 Mb), mendukung berbagai jenis shortcut 

Kilasan Materi
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Refleksi

Kamu telah mempelajari cara melakukan akses Internet dan fasilitas 
yang ada di Internet. Manfaat apa yang kamu dapatkan dengan 
mempelajari materi tersebut? Apakah kamu dapat menerapkannya 
dalam kehidupan sehari-hari? Coba ambil salah satu materi untuk 
diterapkan dalam kehidupan sehari-hari.

Refleksi

untuk aksi, memiliki fitur organisasi bookmark, dan fiturnya lebih 
banyak dari Internet Explorer.

7.	 Mesin pencari (search engine) merupakan situs tertentu yang 
dirancang khusus untuk menemukan alamat web site atau artikel 
berdasarkan kata kunci yang diinginkan.

8.	 Alamat web site mesin pencari Google adalah http://www.google.
com atau http://www.google.co.id.

9.	 Mesin pencari Yahoo dapat diakses di alamat http://www.yahoo.
com atau http://www.yahoo.co.id.

10.	 Mesin pencari Excite dapat diakses di alamat http://www.excite.
com.

11.	 Mesin pencari Altavista dapat diakses pada alamat http://www.
altavista.com.

12.	 Fasilitas-fasilitas yang ada di Internet adalah e-mail, mailing list, 
chatting, file transfer protocol, telnet, dan teleconference.
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Perangkat lunak yang digunakan untuk mengakses Internet disebut ....
a.	 cacher
b.	 browser
c.	 web site
d.	 spyware

2.	 Keunggulan Internet Explorer di antaranya adalah ....
a.	 tidak memerlukan memori komputer yang terlalu besar
b.	 ukuran aplikasi yang relatif lebih kecil
c.	 memiliki fitur organisasi bookmark yang mampu mengorganisasi 

beberapa tab sekaligus
d.	 fiturnya lebih banya

3.	 Berikut ini adalah kelemahan Mozilla Firefox, kecuali ....
a.	 tidak terintegrasi dengan Microsoft Outlook ataupun Outlook 

Express
b.	 memakan banyak memori komputer
c.	 harus diinstall terlebih dahulu ke komputer
d.	 menggunakan komponen ActiveX yang sering membahaya-kan

4.	 Ikon  pada jendela Internet Explorer berfungsi untuk ....
a.	 mengembalikan penjelajahan sebelum fungsi “Back” digunakan
b.	 menghentikan proses loading sebuah web site
c.	 melakukan loading kembali dari awal
d.	 untuk kembali ke home page yang pertama (tampilan awal)

5.	 Ikon pada jendela Internet Explorer yang berfungsi untuk menampilkan 
jendela yang berisi daftar halaman yang telah diakses adalah ....
a.	 						      c.	

b.	 							      d.	

Soal-Soal Evaluasi
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6.	 Komponen “Stop” pada Internet Explorer berfungsi untuk ....
a.	 menghentikan akses Internet
b.	 menghentikan akses pada sebuah web site
c.	 menghentikan proses download sebuah web site
d.	 menghentikan proses loading sebuah web site

7.	 Situs tertentu yang dirancang khusus untuk menemukan alamat web 
site atau artikel berdasarkan kata kunci yang diinginkan oleh pencari 
informasi disebut ....
a.	 mailing list
b.	 e-mail
c.	 search engine
d.	 file transfer protoco

8.	 Fasilitas Internet yang fungsinya sama dengan pengiriman surat melalui 
Kantor Pos adalah ....
a.	 chatting
b.	 telnet
c.	 e-mail
d.	 mailing list

9.	 Fasilitas File Transfer Protocol berfungsi untuk ....
a.	 mengirimkan berkas (file) yang berisi tulisan, gambar, animasi, 

musik, atau game dalam Internet
b.	 mengakses sebuah komputer dalam jaringan Internet seperti 

layaknya bekerja pada komputer sendiri
c.	 berkomunikasi langsung secara tertulis dengan orang lain yang 

sama-sama sedang online di Internet
d.	 mengirim dan menerima pesan melalui Internet

10.	 Berikut ini adalah program aplikasi yang dapat digunakan untuk chatting, 
kecuali ....
a.	 mIRC
b.	 Microsoft Comic
c.	 Netmeeting
d.	 Microsoft Word
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B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan pengertian browser, kemudian tuliskan jenis-jenis browser 

tersebut!
2.	 Bagaimanakah cara mengakses halaman web? Jelaskan langkah-

langkahnya secara singkat!
3.	 Jelaskan fungsi ikon pada jendela Internet Explorer berikut ini:

a.	

b.	

c.	

d.	

e.	

f.	

4.	 Apa yang dimaksud dengan search engine? Jelaskan!
5.	 Fasilitas apa saja yang terdapat di Internet? Berikan penjelasan singkat 

tentang fasilitas-fasilitas tersebut!
6.	 Tuliskan jenis-jenis search engine dan alamat situsnya!
7.	 Jelaskan kelebihan dan kekurangan dari Internet Explorer!
8.	 Jelaskan kelebihan dan kekurangan dari Mozilla Firefox!
9.	 Bagaimanakah perbedaan antara mengirim surat melalui e-mail dengan 

mengirim surat melalui kantor pos?
10.	 Apa manfaat adanya milis? Jelaskan!



96 Satelit TIK untuk SMP/MTs Kelas 9

C.	 Pasangkanlah!

Berkomunikasi langsung 
secara tertulis dengan orang 
lain yang sama-sama sedang 
online di Internet

 Percakapan jarak jauh 
dengan saling memandang 
satu sama lain

 Untuk kembali ke home page 
yang pertama (tampilan awal)

Browser bawaan dari sistem 
operasi Windows
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Mengirim surat kepada orang 
lain melalui kantor pos

Menampilkan jendela yang 
berisi daftar halaman yang 
telah diakses

Salah satu mesin pencari 
terbesar yang mampu 
menampilkan informasi dari 
basis data situs lain

Melakukan loading kembali 
dari awal
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Mesin pencari yang sangat 
terkenal dan digunakan oleh 
banyak orang

Menuju ke halaman yang 
sebelumnya diakses

Menampilkan jendela 
pencarian yang berguna untuk 
membantu proses pencarian 
di Internet

Menampilkan jendela favourite 
yang berisi alamat situs-situs. 
Analoginya seperti buku 
telepon
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Aneka informasi dapat diakses melalui Internet setelah perangkat 
keras dan perangkat lunaknya tersedia. Melalui web browser, misalnya 
Internet Explorer, kamu dapat mencari informasi, seperti mencari sumber 
bahan belajar, berita olahraga, kesehatan, hiburan, dan sebagainya. Selain 
mencari informasi, kamu juga dapat mengirimkan informasi kepada orang 
lain atau menyimpan informasi agar dapat diakses oleh orang lain melalui 
Internet. Misalnya, kamu akan menyimpan data pribadimu pada sebuah 
situs pendidikan. Bagaimanakah cara mengakses beberapa situs untuk 
mendapatkan informasi yang bermanfaat? Bagaimanakah cara menyimpan 
halaman web? Bagaimanakah cara mendownload informasi dari Internet? 
Ayo temukan jawabannya dengan mempelajari bab ini.

Setelah mempelajari bab ini, diharapkan kamu dapat mengakses beberapa 
situs untuk memperoleh informasi yang bermanfaat, menyimpan halaman web, 
dan mendownload informasi yang bermanfaat dari Internet.

Gambar 4.1 Informasi yang ada di Internet
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browsing

download

search engine

hasilnya 
disimpan

e-mail

Peta Konsep

Kata Kunci
Browsing, cache, download, offline browsing, online, search engine,
sign out, login

Menjelajahi 
Internet

Memperlancar 
browsing

Menyimpan 
Halaman Web

Membuat alamat 
e-mail pribadi

Login ke alamat 
e-mail pribadi

Menulis dan 
mengirim e-mail

Menggunakan 
search engine 
Google

Menggunakan 
fasilitas e-mail
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A.	 Memperlancar Browsing
Terkadang muncul masalah ketika mengakses Internet, misalnya waktu 

yang relatif lebih lama atau bahkan kegagalan dalam mengakses atau 
mendownload data. Untuk itu, kamu harus mengetahui cara-cara yang tepat 
dalam mengakses Internet agar semuanya berjalan dengan lancar. Berikut ini 
adalah beberapa cara yang dapat dilakukan untuk memperlancar pencarian 
atau akses Internet.

1.	 Hindari Jam Sibuk
Jika mungkin, jangan melakukan browsing pada jam-jam sibuk (biasanya 

jam kerja antara pukul 09.00-17.00) agar browsermu tidak ‘terjebak kemacetan’ 
lalu lintas di dunia maya. Pada jam-jam itulah banyak orang yang mengakses 
Internet.

2.	 Tambahkan Cache Browser
Pada waktu kamu mengunjungi suatu situs, Internet Explorer 

menempatkan kode HTML dan grafik dari situs tersebut pada cache. 
Cache membantu Internet Explorer bekerja lebih cepat pada saat kamu 
mengklik tombol Back. Agar proses browsing menjadi cepat, kamu perlu 
mengalokasikan jumlah space pada harddisk yang memadai untuk cache. 
Caranya adalah sebagai berikut:

1)		 Pilih menu Tools pada Internet Explorer.
2)		 Pilih Internet Options.

Gambar 4.2 Menampilkan Internet Options
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3)	 Pilih tab General. Pada kotak dialog Internet Options.
4)	 Pada bagian Temporary Internet Files, klik Settings.
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5)	 Di bawah Amount of disk space to use, geser tombol ke arah 
kanan. Alokasikan sekitar 5 % dari space (ruang) pada harddisk 
untuk cache. 

6)	 Tekan OK untuk mengakhiri.

Gambar 4.3 Memilih settings untuk Temporary Internet Files

Gambar 4.4 Mengatur space harddisk untuk cache
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Gambar 4.5 Tab Advanced pada kotak dialog Internet Option
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3.	 Tidak Menampilkan Animasi dan Multimedia
Animasi mungkin membuat browsing menyenangkan, tetapi memperberat 

kerja browser. Untuk menonaktifkan animasi, ayo ikuti langkah-langkah 
berikut ini:

1)	 Pilih menu Tools pada Internet Explorer.
2)	 Pilih Internet Options.
3)	 Pilih tab Advanced.

4)	 Geser layar ke bawah (scroll down) sehingga sampai di bagian Multimedia.
5)	 Hapus tanda cek pada opsi Play animations in web pages dengan 

mengklik kotaknya, lalu klik OK.
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Gambar 4.6 Menonaktifkan animasi pada halaman web
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Kini browser hanya akan mengambil frame pertama dari setiap animasi 
GIF, jadi gambar yang tampil tidak bergerak.

Demikian juga untuk menonaktifkan suara dan video, kosongkan tanda 
cek pada kotak di depan Play Sounds in web pages dan Play Video in web 
pages. Bahkan jika perlu, kamu pun dapat mencegah ditampilkannya gambar 
(bila kamu hanya membutuhkan teksnya saja) dengan mengosongkan tanda 
cek di depan Show Pictures. 

4.	 Hentikan Proses Download
Jika browser terlalu lama mengakses suatu halaman web dan belum 

selesai juga, klik tombol Stop. Kamu dapat membaca sebagian isi halaman 
yang sempat ditampilkan. Jika sesuai dengan yang kamu cari, boleh 
dilanjutkan. Klik tombol Refresh agar Internet Explorer mengulangi proses 
download. Terkadang, rute yang digunakan browser macet. Dengan 
mengulang proses download, browser dapat menemukan jalur baru yang 
agak kosong di Internet.
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5.	 Membuka Jendela Baru
Selama menunggu proses download, kamu boleh melanjutkan kegiatan 

browsing yang lain dengan membuka jendela browser yang baru. Caranya, 
tekan Ctrl + N atau klik menu File → New → Window.

Membuka jendela baru pada saat browsing

Misalnya, kamu sedang membuka situs Departemen Pendidikan 
Nasional (http://www.depdiknas.go.id). Jika kamu akan membuka 
jendela baru, lakukanlah langkah-langkah berikut ini: 

1)	 Klik menu File.
2)	 Klik submenu New.
3)	 Kemudian, pilih Window.

Contoh
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Gambar 4.7 Membuka jendela baru pada saat browsing

4)	 Jendela Internet Explorer yang baru akan muncul.
5)	 Kamu dapat mengunjungi situs lain dengan menggunakan jendela 

Internet Explorer yang baru, misalnya situs Departemen Keuangan 
Republik Indonesia yang alamatnya adalah http://www.depkeu.
go.id.
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6)	 Ketikkan alamat tersebut pada kolom Address, kemudian klik 
tombol Go.
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Gambar 4.8 Mengunjungi situs lain menggunakan jendela baru

7)	 Dengan demikian, kamu dapat mengunjungi beberapa situs dalam 
waktu yang bersamaan dengan menggunakan jendela Internet 
Explorer yang baru.

6.	 Gunakan Tombol Klik Kanan Mouse
Dengan menekan tombol klik kanan mouse pada halaman web yang 

ditampilkan oleh browser, maka akan muncul pop-up menu yang isinya 
tergantung dari posisi pointer mouse. Penggunaan klik kanan ini banyak 
manfaatnya dan sangat membantu kegiatan browsing. Jika pointer mouse 
menunjuk sebuah link, kemudian kamu klik kanan link tersebut, maka akan 
muncul menu-menu sebagai berikut:

1)	 Open : untuk membuka halaman yang ditunjuk oleh link.
2)	 Open in New Window : untuk membuka halaman yang ditunjuk oleh 

link pada jendela baru.
3)	 Save Target As : untuk menyimpan file ya g ditunjuk oleh link.
4)	 Print Target : untuk mencetak h alaman web yang ditunjuk oleh link.
5)	 Copy Shortcut : untuk mengkopi alamat URL dari link yang dimaksud. 
6)	 Jika pointer mouse berada di atas sebuah gambar (image), maka akan 

muncul menu Save Picture As atau Save Background As untuk 
menyimpan file gambar itu ke harddisk.
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Gambar 4.9 Menu klik kanan pada sebuah link
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7.	 Menyimpan Situs Favorit
Jika kamu menemukan sebuah situs atau halaman web yang menarik 

dan berencana untuk mengunjunginya kembali pada suatu waktu, sebaiknya 
kamu memasukkannya ke dalam daftar favorit. Caranya adalah sebagai 
berikut:

1)	 Dalam keadaan halaman web terbuka, klik menu Favorites.
2)	 Pilih Add to Favorites sehingga muncul jendela pop-up.

Gambar 4.10 Menambahkan alamat web ke menu Favorites
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Nama halaman web itu akan tersimpan dalam menu Favorites sebagai 
shortcut (jalan pintas) untuk membuka halaman web itu. Untuk mengaksesnya, 
kamu tidak perlu lagi menulis alamat URL-nya. Kamu tinggal mengklik saja 
menu Favorites, lalu pilih nama situs tersebut.

Gambar 4.12 Membuka situs dari menu Favorites
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8.	 Offline Browsing
Offline browsing adalah sebuah cara untuk menghemat penggunaan 

waktu online. Dengan offline browsing, kamu dapat menyimpan sebuah 
dokumen web (lengkap dengan link dan isinya) ketika sedang online 
(terhubung ke Internet) agar dapat dibuka kembali kapan saja meskipun 
dalam keadaan offlin  (tidak terkoneksi dengan Internet).

Gambar 4.11 Mengganti nama web pada jendela pop-up
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3)	 Kamu boleh mengubah nama webnya pada jendela pop-up, kemudian 

tekan Enter atau klik OK untuk menyimpannya.
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Kegiatanmu

Lakukanlah kegiatan berikut ini dengan menggunakan petunjuk yang 
telah kamu pelajari! Setelah melakukan kegiatan ini, kamu dapat 
meningkatkan keterampilan teknismu dalam memperlancar browsing.
1.	 Menambahkan cache browser.
2.	 Melakukan pengaturan agar halaman web tidak menampilkan 

animasi, gambar, dan video.
3.	 Membuka jendela baru pada saat browsing.
4.	 Menyimpan alamat situs favorit pada saat browsing.

B.	 Menyimpan Halaman Web
Keinginan untuk segera menyimpan halaman yang terpampang di 

monitor sering terjadi, karena dirasakan sangat penting. Oleh karena itu, 
sebaiknya kamu segera menyimpan halaman web yang terpampang tersebut. 
Ayo perhatikan contoh berikut ini, kemudian coba kamu praktikkan untuk 
meningkatkan keterampilan teknismu dalam menyimpan halaman web.

Menyimpan halam web
1)	 Munculkan sebuah halaman web, misalnya: http://www.ilmukomputer.

com
2)	 Klik Menu File, kemudian Save As.

Contoh

Gambar 4.13 Menyimpan halaman web
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Halaman web yang telah disimpan di komputermu, sewaktu-waktu dapat 
dibuka kembali tanpa harus melakukan koneksi ke Internet (offline browsing). 
Kamu dapat membacanya dengan lebih tenang, tanpa merasa khawatir 
terlalu lama melakukan koneksi ke Internet.

3)	 Setelah muncul kotak dialog Save Web Page, tuliskan nama 
file (lebih baik nama file dan tipenya tidak berubah), kemudian 
tempatkan pada folder yang dikehendaki.

4)	 Tekan tombol Save.

Gambar 4.14 Memberi nama file halaman web dan menempatkan dalam folde
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Kegiatanmu

Kunjungilah situs: www.depdiknas.go.id, kemudian simpan halaman 
web tersebut dalam komputermu. Setelah selesai menyimpannya, 
tutup koneksi dengan Internetnya. Coba kamu buka kembali halaman 
web tersebut, kemudian baca halaman web tersebut. Informasi apa 
yang kamu dapatkan dari halaman web tersebut? Menurutmu, apa 
keuntungannya jika kita menyimpan suatu halaman web sebelum 
membacanya? Diskusikanlah bersama temanmu.
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Gambar 4.15 Menuliskan kata kunci pada search engine Google
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C.	 Menggunakan Search Engine Google
Mencari data atau informasi di Internet memerlukan bantuan perangkat 

lunak pencari yang disebut mesin pencari atau search engine. Beberapa 
situs telah menyediakan mesin pencari, namun yang paling banyak diminati 
adalah mesin pencari Google dengan nama situs www.google.com untuk 
versi bahasa Inggrid atau www.google.co.id untuk versi bahasa Indonesia. 

Dalam perkembangannya, situs ini telah mengalami perubahan tampilan 
maupun sarana di dalamnya. Langkah-langkah mencari data atau informasi 
melalui mesin pencari Google adalah sebagai berikut:

1)	 Tuliskan alamat http://www.google.co.id pada Address Internet Explorer.
2)	 Setelah muncul halaman web Google, tuliskan kata kunci artikel atau 

informasi yang akan dicari pada kolom yang tersedia. Jika kata kuncinya 
lebih dari satu kata, maka gunakan tanda petik dua (”...”). Misalnya, 
kamu akan mencari artikel tentang laboratorium komputer. Ketikkan 
”laboratorium komputer” pada kolom yang tersedia, kemudian tekan 
tombol Telusuri dengan Google.

3)	 Halaman web akan menunjukkan hasil pencarian.
4)	 Klik salah satu hasil pencarian untuk membacanya dan kemudian 

menyimpan atau mencetaknya.

Gambar 4.16 Hasil pencarian dengan search engine Google
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Gambar 4.17 Artikel hasil pencarian yang ditampilkan
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5)	 Halaman web akan menunjukkan artikel yang merupakan link dari hasil 

pencarian yang diklik.

6)	 Lakukan salah satu kegiatan berikut ini:
a)	 Simpan artikel dengan memilih menu File → Save As.
b)	 Cetak artikel dengan mengklik ikon .

7)	 Klik ikon  untuk menampilkan hasil pencarian yang lainnya, 
kemudian lakukan kembali Langkah 6).

Dalam menggunakan search engine Google, kamu dapat melakukan 
penelusuran lanjutan. Dengan penelusuran lanjutan ini, kamu dapat mencari 
informasi yang lebih spesifik. Langkah-langkah mencari data atau informasi 
dengan penelusuran lanjutan adalah sebagai berikut:

1)	 Tuliskan alamat http://www.google.co.id pada Address Internet 
Explorer.

2)	 Setelah muncul halaman web Google, klik Penelusuran Lanjutan.

Gambar 4.18 Penelusuran lanjutan pada search engine Google
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Gambar 4.19 Kolom isian penelusuran lanjutan
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3)	 Tuliskan dan pilih hal-hal yang dinginkan pada kolom-kolom yang tersedia, 
Misalnya, kamu akan mencari artikel tentang ”laboratorium komputer”. 
Ketikkan laboratorium komputer pada kolom yang ditunjukkan pada 
gambar berikut. Kemudian, tekan tombol Telusuri dengan Google.

Kegiatanmu

Ayo lakukan kegiatan ini untuk meningkatkan keterampilan teknismu 
dalam menggunakan search engine Google. Carilah informasi yang 
bertemakan:

a.	 pengertian Internet
b.	 manfaat Internet
c.	 jaringan komputer
d.	 buku sekolah elektronik
e.	 sistem pendidikan nasional

Pilih salah satu artikel hasil pencarian untuk dibaca, kemudian cetak 
halaman tersebut, masing-masing 1 artikel untuk setiap tema.

Berlombalah dengan teman-temanmu untuk mendapatkan informasi 
yang terbaru, menarik, dan bermanfaat dengan menggunakan search 
engine Google.
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Gambar 4.20 Membuka fasilitas e-mail pada Yahoo
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D.	 Menggunakan Fasilitas E-mail

Salah satu fasilitas yang ada di internet adalah e-mail. Dengan 
menggunakan e-mail, kamu dapat mengirimkan pesan, surat, atau gambar 
dalam bentuk digital kepada orang lain yang juga memiliki alamat e-mail 
pribadi. Kamu dapat berwirausaha dengan memanfaatkan fasilitas e-mail ini, 
misalnya menyediakan jasa pengiriman surat melalui e-mail.

Kamu dapat berkirim surat dengan temanmu melalui fasilitas e-mail. 
Tetapi, kamu harus memiliki alamat e-mail pribadi terlebih dahulu pada situs 
tertentu, misalnya pada Yahoo. Bagaimanakah cara membuat alamat e-mail 
pribadi pada situs Yahoo? Bagaimanakah cara menggunakan e-mail yang 
telah kita buat? Ayo cermati uraian berikut ini agar kamu memahaminya.

1. 	 Membuat Alamat E-mail Pribadi
Ayo ikuti langkah-langkah berikut ini untuk membuat alamat e-mail 

pribadi pada situs Yahoo.

1)	 Bukalah situs http://www.yahoo.co.id. 
2)	 Klik pada pilihan Mail.
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3)	 Jika kamu belum memiliki ID Yahoo, maka kamu harus memilih Daftar.

Gambar 4.21 Mendaftar untuk mendapatkan ID Yahoo
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4)	 Isilah form pendaftaran yang muncul, kemudian buat ID Yahoo, alamat 
e-mail, dan sandi (password) yang dinginkan. Misalnya, alamat e-mail 
yang akan dibuat adalah akfen_cr7@yahoo.co.id.

5)	 Setelah semua data diisi dengan benar, klik Buat Akun Saya.
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Gambar 4.22 Form pendaftaran untuk membuat alamat e-mail di Yahoo
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6)	 Jika pendaftaran telah sukses, maka akan muncul tampilan seperti berikut 
ini. Untuk masuk ke alamat e-mail yang telah dibuat, tekan Lanjutkan.

Akfen

Laki-laki

16

Indonesia

41271

akfen_cr7

• • • • • • • • •

• • • • • • • • •

akfen_efendi@yahoo.co.id

einstein

z12se6

Siapa nama belakang guru favorit Anda?

Maret 1986

Efendi
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Gambar 4.23 Pemberitahuan bahwa pendaftaran telah sukses

Gambar 4.24 Tampilan e-mail di Yahoo
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7)	 Kamu sudah dapat menggunakan alamat e-mail pribadimu.
8)	 Untuk keluar dari e-mail, klik Sign Out. 

9)	 Tampilan akan kembali ke halaman web Yahoo.
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2. 	 Login ke Alamat E-mail Pribadi
Jika kamu telah mempunyai alamat e-mail pribadi, kamu dapat 

langsung login tanpa harus mendaftar dahulu. Ayo perhatikan contoh berikut 
ini, kemudian coba kamu ikuti langkah-langkahnya untuk meningkatkan 
keterampilan teknismu.

Login ke alamat e-mail pribadi di Yahoo indonesia
1)	 Bukalah situs http://www.yahoo.co.id. 
2)	 Klik pada pilihan Mail.
3)	 Masukkan ID Yahoo dan Sandi yang kamu miliki.
	 Misalnya:
	 ID Yahoo	 :	 akfen_cr7
	 Sandi	 :	 kalijati2

Contoh

Gambar 4.25 Login ke alamat e-mail pribadi
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3. 	 Membuka E-mail yang Masuk 
Bagaimanakah jika ada e-mail yang masuk ke e-mailmu? Cara membuka 

e-mail yang masuk adalah sebagai berikut:

1)	 Login terlebih dahulu ke alamat e-mailmu.
2)	 Klik pada pilihan Kotak Masuk, maka daftar e-mail masuk akan 

ditampilkan.
3)	 Pilih salah satu e-mail masuk untuk dibaca.

Gambar 4.26 Membuka e-mail masuk

Gambar 4.27 E-mail masuk yang ditampilkan

Su
m

be
r:

 K
ol

ek
si

 p
en

er
bi

t
Su

m
be

r:
 K

ol
ek

si
 p

en
er

bi
t

4)	 E-mail masuk yang diklik akan ditampilkan.
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3. 	 Menulis dan Mengirimkan E-mail
Bagaimanakah cara untuk menulis dan mengirimkan e-mail ke orang lain? 

Ayo ikuti langkah-langkah untuk menulis dan mengirimkan e-mail dalam contoh 
berikut ini.

Menulis dan mengirimkan e-mail
1)	 Login terlebih dahulu ke alamat e-mailmu.
2)	 Klik pada pilihan Tulis.

Contoh

Gambar 4.28 Memilih untuk menulis e-mail
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3)	 Tuliskan alamat e-mail yang akan dituju, kemudian tuliskan 
pesannya pada tempat yang tersedia. Selain itu, kamu juga dapat 
melampirkan file yang kapasitas maksimalnya 10 Mb

	 Misalnya:
	 Alamat yang dituju	 :	 silfi_ramayanti@yahoo.co.i
	 Judul surat		  :	 selamat ulang tahun
	 Isi pesan			  :	 (lihat gambar 4.29)
4)	 Jika sudah selesai, tekan Kirim.

Gambar 4.29 Menuliskan dan mengirimkan e-mail
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Tahukah Kamu

Apa itu E-mail?

	 Surat elektronik atau pos elektronik dalam bahasa Inggris disebut 
e-mail. Pengertian e-mail adalah sarana kirim mengirim surat melalui 
jalur Internet.

	 Dengan surat biasa, umumnya pengirim perlu membayar biaya 
per pengiriman (dengan membeli perangko). Tetapi, surat elektronik 
umumnya mengeluarkan biaya hanya untuk membayar sambungan 
Internet, kecuali e-mail ke telepon genggam, kadang pembayarannya 
ditagih per pengiriman.

	 E-mail sudah mulai dipakai pada 1960-an. Pada saat itu, Internet 
belum terbentuk, yang ada hanyalah kumpulan ‘mainframe’ yang 
terbentuk sebagai jaringan.

	 Mulai 1980-an, e-mail sudah dapat dinikmati oleh khalayak umum. 
Hal ini mengakibatkan banyak perusahaan pos di berbagai negara yang 
penghasilannya menurun karena masyarakat sudah tidak memakai 
jasa pos lagi.

	 Agar dapat menggunakan e-mail, maka seseorang harus 
mempunyai alamat e-mail terlebih dahulu. Anatomi alamat e-mail 
adalah sebagai berikut:

akfen_cr7@yahoo.co.id
Keterangan:
akfen_cr7@yahoo.co.id adalah alamat e-mailnya.
akfen_cr7	 :	nama kotak surat (mailbox) atau nama pengguna 

(username) yang ingin dituju dalam mailserver.
yahoo.co.id	:	nama mailserver tempat pengguna yang dituju, 

rinciannya: 
yahoo	:	nama domain, biasanya menunjukkan nama 

perusahaan/organisasi/perorangan.
co	 :	second level domain, menunjukkan bahwa 

domain ini termasuk kategori coorporate (co). 
id	 :	top level domain, menunjukkan bahwa domain ini 

terdaftar di otoritas domain Indonesia (id). 

	 Untuk mengirim e-mail, kita memerlukan suatu program mail-client. 
E-mail yang dikirim akan melalui poin-poin sebelum sampai di tujuan. 
Untuk lebih jelasnya, perhatikan urutan perjalanan e-mail berikut ini. 
Contoh yang dipakai adalah layanan SMTP dan POP3.
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Menulis e-mail → e-mail client (di komputer pengirim) → SMTP server 
penyedia e-mail pengirim → Internet → POP3 server penyedia e-mail 
penerima → e-mail client (di komputer penerima) → e-mail dibaca 
penerima

	 Terlihat surat elektronik yang terkirim hanya melalui 5 poin (selain 
komputer pengirim dan penerima). Sebenarnya lebih dari itu, sebab 
setelah surat elektronik meninggalkan POP3 server akan melalui 
banyak server-server lainnya. Tidak tertutup kemungkinan e-mail yang 
kita kirim disadap orang lain. Oleh karena itu, jika e-mail yang kita 
kirim mengandung isi yang sensitif, sebaiknya kita melakukan tindakan 
pencegahan dengan cara mengacak (enkrip) data dalam e-mail tersebut 
(contohnya menggunakan PGP, sertifikat digital, dan lain-lain

	 Dalam menggunakan e-mail harus mematuhi etika-etika tertentu. 
Etika dalam menggunakan e-mail sama dengan etika dalam menulis 
surat biasa. Ada e-mail yang isinya formal, dan ada juga yang informal. 
Beberapa etika penting dalam menggunakan e-mail adalah:
1.	 Jangan mengirim e-mail dengan lampiran (attachment) yang terlalu 

besar (lebih dari 512 kB). Tidak semua orang mempunyai akses 
Internet yang cepat, dan ada kemungkinan lampiran tersebut 
melebihi kapasitas surat elektronik penerima, sehingga akan 
ditolak mailserver penerima. Selain itu, perhatikan juga bahwa 
beberapa penyedia e-mail juga menerapkan batasan tentang 
jumlah, jenis, dan ukuran surat elektronik yang dapat diterima (dan 
dikirim) penggunanya.

2.	 Jangan mengirim lanjut (forward) surat elektronik tanpa berpikir 
kegunaan bagi orang yang dituju.

3.	 Selalu isi kolom subjek, jangan dibiarkan kosong.
4.	 Dalam mengutip tulisan orang lain, selalu usahakan mengutip 

seperlunya, jangan mau gampangnya mengutip seluruh tulisan 
orang itu.

5.	 Dalam menjawab e-mail orang lain, kutip bagian yang kita tanggapi 
saja. Selain lebih jelas, juga tidak memakan waktu/jatah akses 
penerima.

6.	 Jangan menggunakan huruf kapital karena dapat menimbulkan 
kesan anda “berteriak”. 

7.	 Gunakan kata-kata dengan santun. Adakalanya sesuatu yang 
ditulis akan terkesan berbeda dengan apa yang dimaksudkan. 

 	 Sumber: http://id.wikipedia.org/wiki/Surat_elektronik (dengan perubahan)
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Latihan

1.	 Bagaimanakah cara memperlancar browsing pada Internet? 
2.	 Bagaimanakah cara mengalokasikan jumlah space pada harddisk 

yang memadai untuk cache?
3.	 Bagaimanakah cara menyimpan situs favorit?
4.	 Apa yang dimaksud dengan offline browsing? Jelaskan dengan 

kata-katamu sendiri!
5.	 Bagaimanakah cara menyimpan suatu halaman web agar dapat 

dibuka kembali dengan offline browsin ?
6.	 Jelaskan dengan singkat cara menggunakan search engine 

Google!
7.	 Bagaimanakah cara membuat alamat e-mail pribadi?
8.	 Bagaimanakah cara login ke alamat e-mail pribadi?
9.	 Bagaimanakah cara menulis dan mengirimkan e-mail ke alamat 

e-mail orang lain?
10.	 Bagaimanakah cara membaca e-mail yang masuk ke alamat e-mail 

kita?

Kegiatanmu

Ayo lakukan kegiatan berikut ini untuk meningkatkan keterampilan 
teknismu dalam menggunakan fasilitas e-mail.
1.	 Buatlah alamat e-mail pribadimu di Yahoo. Catat ID Yahoo dan 

sandi yang kamu buat.
2.	 Kumpulkan ID Yahoo teman-temanmu agar dapat saling berkirim 

e-mail.
3.	 Login ke alamat e-mailmu tersebut.
4.	 Kirimlah e-mail ke beberapa alamat e-mail temanmu.
5.	 Jika ada e-mail yang masuk, cobalah untuk membukanya.
6.	 Keluarlah dari alamat e-mailmu dengan melakukan sign out.
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Refleksi

Kamu telah mempelajari cara menjelajahi Internet. Manfaat apa yang 
kamu dapatkan dengan mempelajari materi tersebut? Apakah kamu 
dapat menerapkannya dalam kehidupan sehari-hari? Coba ambil salah 
satu materi untuk diterapkan dalam kehidupan sehari-hari.

Refleksi

1.	 Beberapa cara yang dapat dilakukan untuk memperlancar 
pencarian atau akses Internet adalah menghindari jam sibuk, 
menambahkan cache browser, tidak menampilkan animasi dan 
multimedia, menghentikan proses download, membuka jendela 
baru, menggunakan fungsi klik kanan, dan menyimpan situs 
favorit.

2.	 Jika menemukan sebuah situs atau halaman web yang menarik 
dan berencana untuk mengunjunginya kembali pada suatu waktu, 
sebaiknya disimpan ke dalam daftar favorit.

3.	 Jika browser terlalu lama mengakses suatu halaman web dan 
belum selesai juga, klik tombol Stop.

4.	 Offlinebrowsing adalah sebuah cara untuk menghemat penggunaan 
waktu online.

5.	 Halaman web yang telah tersimpan di harddisk komputer, sewaktu-
waktu dapat dibuka kembali tanpa harus melakukan koneksi ke 
Internet.

6.	 Mencari data atau informasi di Internet memerlukan bantuan 
perangkat lunak pencari yang disebut mesin pencari atau search 
engine.

7.	 Agar dapat menggunakan fasilitas e-mail, kita harus memiliki 
alamat e-mail pribadi pada sistus tertentu.

8.	 Jika telah mempunyai alamat e-mail pribadi, kita dapat langsung 
login tanpa harus mendaftar dahulu.

Kilasan Materi
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Berikut ini adalah beberapa cara memperlancar browsing, kecuali ....
a.	 tambahkan cache browser
b.	 tidak menampilkan animasi dan multimedia
c.	 melakukannya pada jam kerja
d.	 menghentikan proses download

2.	 Menu klik kanan yang berfungsi untuk membuka halaman yang ditunjuk 
oleh link pada jendela baru adalah ....
a.	 Open
b.	 Open in New Windows
c.	 Save Target As
d.	 Copy Shortcut

3.	 Shortcut untuk membuka jendela Internet Explorer yang baru adalah ....
a.	 Ctrl + Alt + N
b.	 Ctrl + Shift + N
c.	 Alt + Shift + N
d.	 Ctrl + N

4.	 Cara untuk menyimpan situs favorit adalah ....
a.	 Favorites → Add to Favorites
b.	 Tools → Add to Favorites
c.	 File → Save As
d.	 Tools → Favorites → Add to Favorites

5.	 Salah satu cara yang dapat digunakan untuk menghemat atau mengurangi 
penggunaan waktu online adalah ....
a.	 chatting
b.	 browsing
c.	 offline browsin
d.	 shut down

Soal-Soal Evaluasi
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6.	 Langkah-langkah untuk menyimpan halaman web adalah ....
a.	 Edit → Save As
b.	 File → Save As
c.	 Tools → Save As
d.	 Favorites → Add to Favorites

7.	 Jika kata kunci yang akan dimasukkan ke dalam mesin pencari Google 
terdiri dari dua kata atau lebih, maka harus menggunakan ....
a.	 tanda ( ... )
b.	 tanda { ... }
c.	 tanda ‘ ... ‘
d.	 tanda “ ... “

8.	 Ikon pada jendela Internet Explorer yang digunakan untuk mencetak 
halaman web yang sedang diakses adalah ....

a.	

b.	

c.	  

d.	

9.	 Perhatikan gambar berikut ini!

A

B

D

C
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Bagian yang menunjukkan alamat e-mail yang dituju adalah ....
a.	 A
b.	 B
c.	 C
d.	 D

10.	 Berikut ini adalah hal-hal yang dapat dilakukan ketika menulis dan 
mengirim surat melalui e-mail, kecuali ....
a.	 mengirimkan surat ke banyak orang dalam satu waktu
b.	 menambahkan perangko surat
c.	 melampirkan file tambaha
d.	 menuliskan isi surat

B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Bagaimanakah cara memperlancar browsing pada Internet? 
2.	 Bagaimanakah cara menyimpan suatu halaman web agar dapat dibuka 

kembali dengan offline browsin ?
3.	 Jelaskan dengan singkat cara menggunakan search engine Google!
4.	 Bagaimanakah cara membuat alamat e-mail pribadi? 
5.	 Jelaskan cara login ke alamat e-mail pribadi?
6.	 Bagaimanakah cara menulis dan mengirimkan surat melalui e-mail?
7.	 Bagaimanakah cara menyimpan situs favorit agar dapat dibuka kembali 

pada suatu waktu?
8.	 Jelaskan rincian dari alamat e-mail berikut ini:

a.	 yusuf_firdaus@yahoo.co.i
b.	 irmayanti@yahoo.co.id

9.	 Jelaskan menu-menu yang muncul pd saat melakukan klik kanan 
terhadap sebuah link!

10.	 Apa keuntungan melakukan offline browsin ?

C.	 Ayo praktikkan
1.	 Lakukan login ke alamat e-mailmu.
2.	 Tulis e-mail yang isinya adalah cerita pengalamanmu sewaktu liburan 

semester ganjil.
3.	 Lampirkan foto-foto pada saat liburan.
4.	 Kirimkan e-mail tersebut ke alamat e-mail beberapa temanmu dalam 

sekali kirim.
5.	 Setelah selesai, lakukan sign out.



128 Satelit TIK untuk SMP/MTs Kelas 9

Petunjuk:
Untuk mengirimkan e-mail ke beberapa orang dalam sekali kirim, gunakan 
kolom Cc seperti yang diperlihatkan berikut ini.

Kolom Cc

Dalam menuliskan alamat e-mail temanmu di kolom Cc, gunakan pemisah 
berupa tanda titik koma (;). Perhatikan contoh berikut ini:

Kepada	:	silfi_ramayanti@ ahoo.co.id
       Cc	 :	akfen_cr7@yahoo.co.id; agus_zakaria@yahoo.co.id; lulu_sufyan@

yahoo.com; 

Pada contoh tersebut, si pengirim mengirimkan sebuah e-mail yang sama 
kepada 4 orang temannya dalam sekali kirim.
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Microsoft PowerPoint adalah program komputer yang merupakan bagian 
dari Microsoft Office. Microsoft PowerPoint dapat digunakan untuk mengatur 
dan menyajikan informasi dalam bentuk slide yang dapat ditampilkan pada 
layar proyektor. Oleh karena itu, sudah banyak orang yang menggunakan 
Microsoft PowerPoint untuk membuat sebuah presentasi. 

Salah satu versi dari Microsoft PowerPoint adalah Microsoft PowerPoint 
2003. Komponen apa saja yang ada pada Microsoft PowerPoint 2003? 
Bagaimanakah cara membuat presentasi pada Microsoft PowerPoint 2003? 
Ayo temukan jawaban dari pertanyaan tersebut dengan mempelajari bab ini. 

Setelah mempelajari bab ini, diharapkan kamu dapat mengidentifikasi
komponen yang ada pada Microsoft PowerPoint 2003 dan membuat 
presentasi dengan menggunakan Microsoft PowerPoint 2003.

Gambar 5.1 Membuat presentasi dengan Microsoft PowerPoint 2003
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pengenalan

pengenalan perintah

operasi  
dasar

komponen

Peta Konsep

Kata Kunci
Presentasi, slide, slide layout, background, design template, animasi, 
slide show, transisi, tombol aksi

Program 
Presentasi 
Microsoft 
PowerPoint 
2003

Mengenal
Microsoft 
PowerPoint 2003

Membuat slide 
presentasi

Tampilan Jendela
Microsoft 
PowerPoint 2003

•	 Mengaktifkan
•	 Menyimpan 

hasil kerja
•	 Menutup 

program

•	 Membuat file
baru

•	 Memasukkan 
teks dan Word 
Art

•	 Menambahkan 
background 
dan design 
template

•	 Menambahkan 
animasi dan 
efek suara

•	 Menyisipkan 
gambar, 
Clip Art, dan 
AutoShapes

•	 Mengatur 
transisi 
antarslide

•	 Menambahkan 
tombol aksi 
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A.	 Mengenal Microsoft PowerPoint 2003
Microsoft PowerPoint 2003 merupakan program aplikasi yang akan 

mem-bantu penyusunan sebuah presentasi yang efektif, menarik, dan 
profesional. Microsoft PowerPoint 2003 akan membuat sebuah gagasan 
menjadi lebih menarik dan jelas tujuannya jika dipresentasikan. Agar dapat 
menggunakan Microsoft PowerPoint 2003, kamu harus dapat mengaktifkan 
dan menutup Microsoft PowerPoint 2003, mengenal komponen, ikon, dan 
menu pada Microsoft PowerPoint 2003, serta menyimpan hasil kerja pada 
Microsoft PowerPoint 2003. Ayo cermati uraiannya berikut ini.

1.	 Mengaktifkan Microsoft PowerPoint 2003
Langkah pertama dalam menggunakan Microsoft PowerPoint 2003 

adalah mengaktifkannya. Untuk mengaktifkan Microsoft PowerPoint 2003, 
ikutilah langkah-langkah berikut ini:

1)	 Klik tombol Start.
2)	 Pilih All Programs, kemudian pilih Microsoft Offic .
3)	 Pilih Microsoft Office PowerPoint 2003.

Gambar 5.2 Mengaktifkan Microsoft PowerPoint 2003
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4)	 Jendela Microsoft PowerPoint 2003 akan ditampilkan dan siap diguna-
kan.
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Kegiatanmu

Coba kamu aktifkan Microsoft PowerPoint 2003 dengan cara seperti 
yang telah diuraikan di atas. Kemudian, carilah cara lain untuk 
mengaktifkan Microsoft PowerPoint 2003.

2.	 Tampilan Jendela Microsoft PowerPoint 2003
Setelah kamu mengaktifkan Microsoft PowerPoint 2003, maka akan 

muncul tampilan jendela Microsoft PowerPoint 2003 pada layar monitor. 
Berikut ini adalah tampilan jendela Microsoft PowerPoint beserta penjelasan 
komponen-komponennya.

komponen

Tombol 
Close

Standard 
menu 

Drawing 
menu 

Menu bar

Formatting 
menu

Outline 
slides

Slide show

Normal 
view

Slide sorter 
view

Gambar 5.3 Tampilan jendela Microsoft PowerPoint 2003
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Penjelasan tentang komponen-komponen yang ada pada jendela 
Microsoft PowerPoint 2003 adalah sebagai berikut:

a)	 Title bar: merupakan judul dari dokumen yang sedang dikerjakan.
b)	 Menu bar: daftar menu yang masing-masing terdiri dari beberapa perintah.
c)	 Standard menu: ikon dan menu untuk menangani file, menyisipkan objek 

gambar atau grafik
d)	 Formatting menu: ikon dan menu yang berhubungan dengan pengaturan 

huruf atau tulisan.
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Gambar 5.4 Menyimpan hasil kerja
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e)	 Slide sorter view: menampilkan keseluruhan slide di layar kerja dalam 

bentuk ukuran kecil.
f)	 Slide show: menampilkan tayangan sebuah slide.
g)	 Drawing menu: ikon dan menu yang terdiri dari item yang berhubungan 

dengan pembuatan ataupun pengaturan gambar.

3.	 Menyimpan Hasil Kerja
Agar pekerjaan yang telah dibuat pada Microsoft PowerPoint 2003 

tidak hilang, kamu harus menyimpannya. Untuk menyimpan hasil kerja pada 
Microsoft PowerPoint 2003, langkah-langkahnya adalah sebagai berikut:

1)	 Setelah selesai mengoperasikan Microsoft PowerPoint 2003, pilih menu 
File.

2)	 Pilih Save sehingga muncul kotak dialog Save As.
3)	 Tentukan tempat (folder) yang akan digunakan untuk menyimpan file

tersebut pada opsi Save in, misalnya pada My Documents.
4)	 Ketikkan nama file pada File name, misalnya Presentation2, kemudian 

klik Save.
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4.	 Menutup Microsoft PowerPoint 2003
Untuk menutup program aplikasi Microsoft PowerPoint 2003, langkah-

langkahnya adalah sebagai berikut:

1)	 Simpan hasil kerja.
2)	 Pilih menu File, kemudian pilih Exit.

Cara lainnya yang dapat dilakukan untuk menutup Microsoft PowerPoint 
2003 adalah dengan menekan tombol Close pada pojok kanan atas layar 
monitor.

Kegiatanmu

Aktifkan Microsoft PowerPoint 2003, kemudian simpan dokumen 
tersebut dengan nama “Blank Presentation”. Setelah itu, tutup kembali 
Microsoft PowerPoint 2003 tersebut.

B.	 Membuat Slide Presentasi
Dengan menggunakan Microsoft PowerPoint 2003, kamu dapat membuat 

slide untuk presentasi. Jika kamu sudah mampu membuat slide presentasi, 
kamu dapat berwirausaha dengan cara menjual jasa untuk membuatkan slide 
presentasi bagi orang-orang yang akan melakukan presentasi.

Untuk membuat slide-slide yang akan ditampilkan dalam presentasi, 
kamu harus membuat perencanaan sesuai dengan materi presentasi yang 
akan disajikan terlebih dahulu. Buatlah garis besar materi dengan kalimat 
yang singkat, padat, dan berisi. Susunannya dimulai dengan kalimat pembuka, 
latar belakang, permasalahan, pembahasan, dan penutup yang berupa 
kesimpulan/saran. Setelah semuanya terencana dengan baik, barulah kamu 
dapat merancang hal yang akan diungkapkan dalam presentasi tersebut ke 
dalam slide-slide dengan menambahkan feature-feature dan animasi tertentu 
sedemikian rupa sehingga dalam penyajiannya menarik.

1.	 Membuat File Baru
Langkah awal untuk membuat slide setelah program Microsoft PowerPoint 

2003 aktif adalah membuat file baru. Ada tiga cara untuk membuat file baru, 
yaitu sebagai berikut:
1)  Klik menu File → New.

2)  Klik ikon  pada toolbar Standard.

3)  Tekan Ctrl + N pada keyboard.



Bab 5 | Program Presentasi Microsoft PowerPoint 2003 (Pengayaan) 135

Kamu dapat memilih salah satu dari ketiga cara tersebut untuk membuat 
file baru pada Microsoft PowerPoint 2003

Setelah itu, pilih bentuk slide layout sesuai dengan rancangan presentasi 
yang diinginkan, seperti bentuk layout untuk teks saja (text layouts), gabungan 
teks dengan gambar, grafik atau bentuk lainnya (text and content layouts) sesuai 
kebutuhan. Jika ingin leluasa dalam berkreasi, pilihlah content layouts berupa 
lembaran slide kosong. Setelah ini kamu siap memasukan teks, gambar, grafik 
atau bentuk feature lainnya ke dalam slide dengan layout tersebut.

Gambar 5.5 Slide layout
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2.	 Memasukkan Teks dan Word Art
Berikut ini adalah cara-cara untuk memasukkan teks dan Word Art ke 

dalam lembar presentasi (slide).

a.	 Memasukkan Teks 
Jika slide layout yang dipilih telah memiliki kotak untuk diisi teks, kamu 

cukup mengklik tulisan “Click to add title” atau “Click to add subtitle” pada 
kotak tersebut, kemudian mengetikkan teksnya.

Jika slide layout kosong, kamu dapat memasukkan teks dengan meng-
gunakan text box dengan cara sebagai berikut:
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1)	 Pilih menu Insert pada toolbar menu, kemudian pilih Text box. Atau klik 
ikon  yang ada pada Drawing Toolbar.

2)	 Ketikkan teksnya pada text box tersebut.

Kamu dapat mengatur format dari teks yang diketikkan sesuai dengan 
tampilan yang diinginkan, misalnya memilih jenis huruf, ukuran huruf, efek 
pencetakkan, dan warna sesuai dengan fasilitas yang diinstall ke komputer.

b.	 Memasukkan Word Art
Kamu dapat memasukan huruf/kata/kalimat dengan menggunakan 

program bantu Word Art. Dengan Word Art, huruf/kata/kalimat dapat dirancang 
dalam tampilan seni yang menarik. Ayo perhatikan dan ikuti langkah-langkah 
pada contoh berikut ini.

Menyisipkan Word Art ke dalam slide
1)	 Klik menu Insert.
2)	 Klik Picture.
3)	 Klik Word Art.

Contoh

Gambar 5.6 Pilihan jenis-jenis Word Art
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4)	 Pilih salah satu jenis Word Art, kemudian ketik teks yang ingin 
ditampilkan.
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Gambar 5.7 Memasukkan teks dengan Word Art

Gambar 5.8 Tampilan Word Art pada slide
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5)	 Klik OK
	 Menampilkan Word Art pada slide.

Apabila kamu menginginkan bentuk animasi kalimat yang ditampil-
kan kata demi kata atau huruf demi huruf, pemasukan kalimat tersebut 
ke dalam slide jangan menggunakan Word Art karena oleh Microsoft 
PowerPoint 2003 akan dibaca sebagai objek gambar.
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Gambar 5.9 
Pengaturan background slide
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3.	 Menambahkan Background dan Design Template
Bagaimanakah cara menambahkan background dan design template? 

Ayo cermati uraiannya berikut ini.

a.	 Menambahkan Background
Untuk menambahkan background warna pada slide, lakukan perintah 

berikut:

Menambahkan background untuk slide
1)	 Aktifkan menu Format.
2)	 Pilih Background, kemudian pilih Fill Effect.

Contoh

Gambar 5.10 Memilih Fill Effect untuk background

1)	 Aktifkan menu Format.
2)	 Pilih Background, kemudian pilih warna 

sesuai selera.
3)	 Pilih salah satu dari pilihan berikut: Apply 

(untuk slide tersebut saja), Apply all (untuk 
seluruh slide yang ada pada presentasi 
tersebut).
Selain warna biasa, dapat pula 

ditambahkan efek khusus seperti gradient, 
texture, patern, dan picture untuk background. 
Ayo perhatikan contoh berikut ini.
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3)	 Pilih tab Texture, kemudian pilih salah satu jenis tekstur dan tekan 
OK.

Gambar 5.11 Pilihan fill e fect untuk background

Gambar 5.12 Pilihan untuk menambahkan background
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4)	 Setelah itu, muncul pilihan seperti berikut ini.
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Gambar 5.14 Design template pada slide design
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b.	 Menambahkan Design Template
Design template adalah background yang telah disediakan oleh Microsoft 

PowerPoint 2003. Kamu dapat memilihnya sesuai dengan selera. Caranya 
adalah sebagai berikut:

1)	 Klik menu Format.
2)	 Klik Slide design.
3)	 Pilih Design Template, kemudian pilih design yang diinginkan.

5)	 Klik Apply untuk menambahkan background pada slide yang 
sedang dibuka atau Apply to All untuk menambahkan ke semua 
slide.

Gambar 5.13 Slide yang diberi background
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Gambar 5.15 Slide yang diberi design template
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Berikut ini adalah contoh slide yang sudah diberi design template.

Kegiatanmu

Ayo lakukan kegiatan berikut ini untuk meningkatkan daya saing 
dengan teman-temanmu dalam membuat suatu tampilan slide yang 
menarik.
Buatlah slide seperti gambar berikut ini.

Tuliskan langkah-langkah yang kamu lakukan untuk membuat slide 
seperti itu. Kemudian, coba kamu tambahkan atau ubah tampilan 
slide tersebut sehingga terlihat semakin menarik dan baik untuk suatu 
presentasi. Ayo, buatlah tampilan slide yang lebih menarik daripada 
temanmu.
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4.	 Menambahkan Animasi dan Efek Suara
Untuk menambahkan animasi dan suara, caranya adalah sebagai berikut:

1)	 Aktifkan menu Slide Show.
2)	 Pilih Custom Animation.
3)	 Klik teks yang akan dibuatkan animasinya.
4)	 Pilih bentuk animasi dan efek suara yang diinginkan.

Gambar 5.16 Menambahkan animasi

Gambar 5.17 Menyisipkan gambar, Clip Art, atau AutoShapes pada slide
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5.	 Menyisipkan Gambar, Clip Art, dan AutoShapes
Perintah untuk memasukan gambar, Clip Art, dan AutoShapes pada 

dasarnya sama seperti memasukan Word Art, yaitu dengan cara mengaktifkan 
menu Insert, kemudian pilih Picture. Selanjutnya, pilih objek yang diinginkan, 
apakah gambar, Clip Art, atau AutoShapes.
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Gambar 5.18 Pengaturan slide transition
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6.	 Mengatur Transisi Antarslide
Proses tampilnya dari satu slide ke slide berikutnya dapat diatur secara 

otomatis dalam jangka waktu tertentu atau dapat pula diatur sampai saat 
mengklik tombol mouse.  Bentuk efek tampilan, suara, dan kecepatannya 
dapat diatur slide per slide, ataupun berlaku untuk seluruh slide yang ada 
dalam file presentasi tersebut. Caranya adalah:

1)	 Aktifkan menu  Slide Show.
2)	 Klik Slide Transition.
3)	 Setelah muncul jendela Slide Transition,  isi aturan/perintah apa yang 

diinginkan.  

7.	 Menambahkan Tombol Aksi
Tombol aksi adalah sebuah tombol yang dibuat untuk mengerjakan 

perintah tertentu sesuai dengan hyperlink yang dibuat. Misalnya, tombol yang 
berfungsi untuk kembali ke slide sebelumnya. Untuk menambahkan tombol 
aksi pada slide, langkah-langkahnya adalah sebagai berikut:

1)	 Pilih slide yang akan ditempati tombol aksi.
2)	 Pada menu Slide Show, pilih Action Buttons.
3)	 Pilih tombol aksi yang diinginkan, misalnya Home, Movie, Return, dan 

sebagainya.
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Gambar 5.19 Pilihan tombol aksi

Gambar 5.20 Mengatur hyperlink dari tombol aksi
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4)	 Klik pada slide untuk menampilkan tombol aksi. 
5)	 Pastikan bahwa Hyperlink to terpilih.
6)	 Klik OK untuk menerima hyperlink yang ditawarkan dalam daftar 

Hyperlink to, atau tekan tombol panah dan pilih link yang diinginkan.



Bab 5 | Program Presentasi Microsoft PowerPoint 2003 (Pengayaan) 145

8.	 Menampilkan Presentasi
Setelah selesai membuat slide untuk presentasi, kamu dapat 

menampilkan presentasi tersebut. Untuk menampilkan presentasi yang telah 
dibuat, caranya adalah dengan memilih menu Slide Show, kemudian pilih View 
Show. Cara lainnya adalah dengan menekan tombol F5 pada keyboard.

Kegiatanmu

Buatlah sebuah presentasi tentang data diri kamu, kemudian tambahkan 
animasi dan efek suara, sisipkan foto pribadimu di dalamnya, dan 
tambahkan tombol aksi untuk kembali ke slide sebelumnya atau menuju 
ke slide selanjutnya. Selain itu, lakukan pengaturan transisi antarslide. 
Setelah selesai, tampilkan presentasi tersebut.

Sejarah Microsoft PowerPoint
Aplikasi Microsoft PowerPoint ini pertama kali dikembangkan oleh 

Bob Gaskins dan Dennis Austin sebagai presenter untuk perusahaan 
bernama Forethought, Inc yang kemudian mereka ubah namanya 
menjadi PowerPoint. Pada 1987, PowerPoint versi 1.0 dirilis, dan 
komputer yang didukungnya adalah Apple Macintosh. Pada waktu itu, 
PowerPoint masih menggunakan warna hitam dan putih, yang mampu 
membuat halaman teks dan grafik untuk transparansi overhead projector 
(OHP). Setahun kemudian, versi baru dari PowerPoint muncul dengan 
dukungan warna, setelah Macintosh berwarna muncul ke pasaran.

Microsoft pun mengakuisisi Forethought, Inc dan tentu saja 
perangkat lunak PowerPoint dengan harga kira-kira 14 Juta dolar pada 
31 Juli 1987. Pada 1990, versi Microsoft Windows dari PowerPoint (versi 
2.0) muncul ke pasaran, mengikuti jejak Microsoft Windows 3.0. Sejak 
1990, PowerPoint telah menjadi bagian standar yang tidak terpisahkan 
dalam paket aplikasi kantoran Microsoft Office System (kecuali Basic 
Edition).

Versi terbarunya adalah Microsoft Office PowerPoint 2007 
(PowerPoint 12), dirilis pada November 2006, yang merupakan 
sebuah lompatan yang cukup jauh dari segi antarmuka pengguna dan 
kemampuan grafik yang ditingkatkan.

Sumber: Wikipedia dengan perubahan seperlunya

Tahukah Kamu
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Latihan

1.	 Bagaimanakah cara untuk mengaktifkan Microsoft PowerPoint 
2003?

2.	 Jelaskan komponen yang ada pada jendela Microsoft PowerPoint 
2003?

3.	 Bagaimanakah cara untuk menyimpan hasil kerja pada Microsoft 
PowerPoint 2003?

4.	 Bagaimanakah cara untuk menutup program aplikasi Microsoft 
PowerPoint 2003?

5.	 Bagaimanakah cara untuk membuat file baru pada Microsoft 
PowerPoint 2003?

6.	 Bagaimanakah cara untuk memasukkan teks dan Word Art ke 
dalam slide?

7.	 Bagaimanakah cara untuk menambahkan background dan design 
ke dalam slide?

8.	 Temukan jenis-jenis animasi dan efek suara yang ada pada Microsoft 
PowerPoint 2003! (lihat pada bagian Custom Animation)

9.	 Bagaimanakah cara untuk menyisipkan teks dan Word Art ke dalam 
slide?

10.	 Temukan jenis-jenis tombol aksi yang dapat dibuat pada slide! 
(lihat pada bagian Action Button)

1.	 Microsoft PowerPoint merupakan program aplikasi yang akan 
membantu penyusunan sebuah presentasi yang efektif, menarik, 
dan profesional.

2.	 Untuk mengaktifkan Microsoft PowerPoint 2003, langkahnya 
adalah:

	 Start → All Program → Microsoft Office → Microsoft PowerPoint 
2003

3.	 Untuk menyimpan hasil kerja pada Microsoft PowerPoint 2003, 
langkahnya adalah:

	 File →  Save atau File → Save As

Kilasan Materi



Bab 5 | Program Presentasi Microsoft PowerPoint 2003 (Pengayaan) 147

4.	 Untuk menutup program aplikasi Microsoft PowerPoint 2003, 
langkahnya adalah:

	 File →  Exit
5.	 Untuk membuat slide-slide yang akan ditampilkan dalam presentasi, 

buatlah perencanaan sesuai dengan materi presentasi yang akan 
disajikan terlebih dahulu.

6.	 Untuk memasukkan text box, Word Art, gambar, Clip Art, atau 
AutoShapes, gunakan menu Insert.

7.	 Selain warna biasa, dapat pula ditambahkan efek khusus seperti 
gradient, texture, patern, dan picture untuk background.

8.	 Design template adalah background yang telah disediakan oleh 
Microsoft PowerPoint.

9.	 Untuk menambahkan animasi dan efek suara pada slide, 
langkahnya adalah:

	 Slide Show → CustomAnimation
10.	 Untuk mengatur transisi antarslide, langkahnya adalah:
	 Slide Show → Slide Transition
11.	 Tombol aksi adalah sebuah tombol yang dibuat untuk mengerjakan 

perintah tertentu sesuai dengan hyperlink yang dibuat.
12.	 Untuk menampilkan presentasi, langkahnya adalah:
	 Slide Show → View Show

Refleksi

Kamu telah mempelajari program presentasi Microsoft PowerPoint 
2003. Manfaat apa yang kamu dapatkan dengan mempelajari materi 
tersebut? Apakah kamu dapat menerapkannya dalam kehidupan sehari-
hari? Coba ambil salah satu materi untuk diterapkan dalam kehidupan 
sehari-hari.

Refleksi
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Microsoft PowerPoint merupakan program aplikasi yang akan membantu 
penyusunan sebuah presentasi agar tidak ....
a.	 efektif 					     c.	 monoton
b.	 menarik					     d.	 profesional

2.	 Langkah untuk mengaktifkan Microsoft PowerPoint 2003 adalah ....
a.	 Start → All Program → Microsoft Office PowerPoint 200
b.	 Start → Microsoft Office → All Program → Microsoft Office

PowerPoint 2003
c.	 Start → All Program → Microsoft Office PowerPoint 2003 → Microsoft 

Offic
d.	 Start → All Program → Microsoft Office → Microsoft Office

PowerPoint 2003

3.	 Perhatikan gambar berikut ini!

	
Gambar di atas adalah ....
a.	 menu bar					     c.	 formatting menu
b.	 standard menu				    d.	 drawing menu

4.	 Cara untuk menutup program aplikasi Microsoft PowerPoint 2003 
adalah ....
a.	 File → Exit					     c.	 File → Close
b.	 Edit → Exit					     d.	 Edit → Close

5.	 Hal pertama yang harus dilakukan sebelum membuat slide presentasi 
adalah ....
a.	 mengadakan survey ke lapangan
b.	 mempersiapkan bahan presentasi
c.	 membuat perencanaan sesuai dengan materi
d.	 merancang hal yang akan diungkapkan dalam presentasi

Soal-Soal Evaluasi
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6.	 Berikut ini adalah cara untuk membuat filebaru pada Microsoft PowerPoint 
2003, kecuali ....
a.	 klik menu File → New

b.	 klik ikon  pada toolbar standard

c.	 tekan Alt + N pada keyboard
d.	 tekan Ctrl + N pada keyboard

7.	 Bentuk slide layout yang digunakan untuk merancang teks saja disebut ....
a.	 text layouts
b.	 content layouts
c.	 text and content layouts
d.	 other layouts

8.	 Jika slide layout kosong, untuk memasukan teks ke slide dapat 
menggunakan ....
a.	 Clip Art						      c.	 Picture
b.	 AutoShapes					     d.	 Text Box

9.	 Background yang telah disediakan oleh Microsoft PowerPoint 2003 disebut 
....
a.	 fill effec 						      c.	 texture
b.	 design template				    d.	 patern

10.	 Lambang tombol aksi “Home” adalah ....

a.	 						      c.	

b.	 						      d.	

B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan komponen yang ada pada jendela Microsoft PowerPoint 

2003!
2.	 Jelaskan langkah-langkah untuk menambahkan background dan design 

template pada slide!
3.	 Bagaimanakah cara untuk menambahkan animasi dan efek suara pada 

slide presentasi?
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4.	 Bagaimanakah cara mengatur transisi antarslide?
5.	 Bagaimanakah cara untuk menambahkan tombol aksi ke dalam slide?
6.	 Bagaimanakah cara membuat file baru pada Microsoft PowerPoint 

2003?
7.	 Bagaimanakah cara menyisipkan teks dan Word Art ke dalam slide?
8.	 Apa yang dimaksud dengan tombol aksi? Jelaskan!
9.	 Jelaskan cara-cara untuk menyimpan hasil kerja pada Microsoft 

PowerPoint 2003!
10.	 Jelaskan hal-hal yang dapat ditambahkan ke dalam slide ketika sedang 

membuat suatu presentasi!

C.	 Kerjakan bersama teman sekelompokmu.
1.	 Buatlah sebuah presentasi tentang peralatan teknologi informasi dan 

komunikasi.
2.	 Untuk Slide 1, buatlah tampilan seperti berikut ini.

	 Tombol “Hand Phone”, tombol “Notebook”, dan tombol “Komputer” 
adalah tombol aksi (action button) yang hyperlinknya ke slide 
penjelasannya.
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3.	 Slide 2 adalah hyperlink dari tombol “Komputer”. Tampilannya seperti 
berikut.

	 Tombol Home hyperlinknya ke Slide 1 (First Slide).

4.	 Slide 3 adalah hyperlink dari tombol “Notebook”. Tampilannya seperti 
berikut.



152 Satelit TIK untuk SMP/MTs Kelas 9

5.	 Slide 4 adalah hyperlink dari tombol “Hand Phone”. Tampilannya seperti 
berikut.

	 Tombol Home hyperlinknya ke Slide 1 (First Slide).

6.	 Untuk mendapatkan gambar yang akan disisipkan dalam setiap slide, 
silakan kamu download dari Internet.

7.	 Setelah selesai, periksa apakah semuanya telah benar, termasuk 
hyperlink dari setiap tombol aksi. Caranya, klik menu Slide Show, 
kemudian pilih View Show. Atau tekan tombol F5.

8.	 Jika semuanya telah benar, tampilkan presentasi tersebut di depan 
teman-temanmu yang lain.
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A.	 Pilihlah salah satu jawaban yang paling tepat.

1.	 Perangkat lunak yang digunakan untuk mengakses Internet disebut ....
a.	 spyware
b.	 cacher
c.	 web site
d.	 browser

2.	 Berikut ini adalah kelemahan Mozilla Firefox, kecuali ....
a.	 tidak terintegrasi dengan Microsoft Outlook ataupun Outlook 

Express
b.	 menggunakan komponen ActiveX yang sering membahayakan
c.	 memakan banyak memori komputer
d.	 harus diinstall terlebih dahulu ke komputer

3.	 Ikon  pada jendela Internet Explorer berfungsi untuk ....
a.	 melakukan loading kembali dari awal
b.	 menghentikan proses loading sebuah web site
c.	 mengembalikan penjelajahan sebelum fungsi “Back” digunakan
d.	 untuk kembali ke home page yang pertama (tampilan awal)

4.	 Keunggulan Internet Explorer di antaranya adalah ....
a.	 ukuran aplikasi yang relatif lebih kecil
b.	 memiliki fitu  organisasi bookmark yang mampu mengorganisasi 

beberapa tab sekaligus
c.	 tidak memerlukan memori komputer yang terlalu besar
d.	 fiturny  lebih banyak

5.	 Komponen “Stop” pada jendela Internet Explorer berfungsi untuk ....
a.	 menghentikan akses Internet
b.	 menghentikan akses pada sebuah web site
c.	 menghentikan proses loading sebuah web site
d.	 menghentikan proses download sebuah web site

Uji Kompetensi Semester 2
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6.	 Ikon pada jendela Internet Explorer yang berfungsi untuk menampilkan 
jendela yang berisi daftar halaman yang telah diakses adalah ....
a.	  

b.	

c.	

d.	

7.	 Fasilitas Internet yang fungsinya sama dengan pengiriman surat melalui 
Kantor Pos adalah ....
a.	 e-mail
b.	 chatting
c.	 mailing list
d.	 telnet

8.	 Situs tertentu yang dirancang khusus untuk menemukan alamat web 
site atau artikel berdasarkan kata kunci yang diinginkan oleh pencari 
informasi disebut ....
a.	 mailing list
b.	 search engine
c.	 file transfer protoco
d.	 e-mail

9.	 Fasilitas File Transfer Protocol berfungsi untuk ....
a.	 berkomunikasi langsung secara tertulis dengan orang lain yang 

sama-sama sedang online di Internet
b.	 mengakses sebuah komputer dalam jaringan Internet seperti 

layaknya bekerja pada komputer sendiri
c.	 mengirimkan berkas (file  yang berisi tulisan, gambar, animasi, 

musik, atau game dalam Internet
d.	 mengirim dan menerima pesan melalui Internet

10.	 Berikut ini adalah program aplikasi yang dapat digunakan untuk chatting, 
kecuali ....
a.	 Microsoft Word
b.	 mIRC
c.	 Microsoft Comic
d.	 Netmeeting
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11.	 Ikon pada jendela Internet Explorer yang digunakan untuk mencetak 
halaman web yang sedang diakses adalah ....

a.	 							     

b.	 						    

c.	

d.	

12.	 Berikut ini adalah beberapa cara memperlancar browsing, kecuali ....
a.	 tidak menampilkan animasi dan multimedia
b.	 melakukannya pada jam kerja
c.	 tambahkan cache browser
d.	 menghentikan proses download

13.	 Menu klik kanan yang berfungsi untuk membuka halaman yang ditunjuk 
oleh link pada jendela baru adalah ....
a.	 Open
b.	 Save Target As
c.	 Copy Shortcut
d.	 Open in New Windows

14.	 Cara untuk menyimpan situs favorit adalah ....
a.	 Favorites → Add to Favorites
b.	 Tools → Add to Favorites
c.	 File → Save As
d.	 Tools → Favorites → Add to Favorites

15.	 Shortcut untuk membuka jendela Internet Explorer yang baru adalah ....
a.	 Ctrl + N
b.	 Ctrl + Alt + N
c.	 Ctrl + Shift + N
d.	 Alt + Shift + N

16.	 Salah satu cara yang dapat digunakan untuk menghemat atau mengurangi 
penggunaan waktu online adalah ....
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a.	 chatting
b.	 browsing
c.	 shut down 
d.	 offline browsin

17.	 Perhatikan gambar berikut ini!

A

B

D

C

Bagian yang menunjukkan judul e-mail yang dikirimkan adalah ....
a.	 A							       c.	 C
b.	 B							       d.	 D

18.	 Langkah-langkah untuk menyimpan halaman web adalah ....
a.	 Edit → Save As
b.	 File → Save As
c.	 Tools → Save As
d.	 Favorites → Add to Favorites

19.	 Jika kata kunci yang akan dimasukkan ke dalam mesin pencari Google 
terdiri dari dua kata atau lebih, maka harus menggunakan ....
a.	 tanda “ ... “
b.	 tanda ‘ ... ‘ 
c.	 tanda ( ... )
d.	 tanda { ... }
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20.	 Berikut ini adalah hal-hal yang dapat dilakukan ketika menulis dan 
mengirim surat melalui e-mail, kecuali ....
a.	 mengirimkan surat ke banyak orang dalam satu waktu
b.	 menambahkan perangko surat
c.	 melampirkan fil  tambahan
d.	 menuliskan isi surat

B.	 Jawablah pertanyaan berikut ini dengan benar dan singkat.
1.	 Jelaskan pengertian browser, kemudian tuliskan jenis-jenis browser 

beserta kelebihan dan kekurangannya!

2.	 Bagaimanakah cara mengakses halaman web? Jelaskan langkah-
langkahnya secara singkat!

3.	 Jelaskan fungsi komponen pada jendela Internet Explorer berikut ini:

a.	

b.	

c.	

d.	

e.	

f.	

4.	 Bagaimanakah cara memperlancar browsing pada Internet? 

5.	 Bagaimanakah cara menyimpan suatu halaman web agar dapat dibuka 
kembali dengan offline browsin ?

6.	 Bagaimanakah cara membuat alamat e-mail pribadi? Jelaskan cara 
login ke alamat e-mail pribadi?
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7.	 Bagaimanakah cara menulis dan mengirimkan surat melalui e-mail?

8.	 Apa yang dimaksud dengan search engine? Tuliskan jenis-jenis search 
engine dan alamat situsnya!

9.	 Fasilitas apa saja yang terdapat di Internet? Berikan penjelasan singkat 
tentang fasilitas-fasilitas tersebut!

10.	 Jelaskan perkembangan fasilitas chatting di Internet!
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Glosarium

B
Bridge adalah alat yang berfungsi sebagai penghubung antarjaringan.

Browser adalah proglam aplikasi yang dapat digunakan untuk menjelajah 
dunia Internet.

Browsing adalah menelusuri informasi pada Internet menggunakan 
browser tertentu.

C
Cache adalah tempat penyimpanan kode HTML dan grafik dari situs yang 
dikunjungi pada saat browsing dengan menggunakan Internet Explorer.

Chatting adalah ngobrol di internet, baik melalui tulisan, suara, maupun 
video seperti berbicara bertatapan muka.

Client adalah komputer pengakses Internet, biasanya dipakai oleh 
pengguna.

Client-server adalah jaringan komputer dengan komputer yang 
didedikasikan khusus sebagai server.

D
Dial up adalah cara mengakses Internet dengan menghubungkan 
komputer ke Internet melalui saluran telepon rumah.

Download adalah pengambilan data atau informasi dari sebuah web site 
untuk ditampilkan atau disimpan di komputer pengguna.

E
E-mail adalah surat elektronik yang dapat dikirim dan diterima melalui 
Internet.
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F
File Transfer Protocol (FTP) adalah fasilitas dalam Internet untuk 
mengirimkan berkas (file) yang berisi tulisan, gambar, animasi, musik, 
atau game kepada temanmu.

H
Homepage adalah halaman muka sebuah web site, berisi link-link ke 
halaman yang lain dalam web site yang sama atau web site lainnya.

Hot spot adalah sarana untuk mengakses Internet secara wireless.

HTML (Hypertext Mark up Language) adalah standar format untuk 
dokumen hypertext.

HTTP (Hypertext Mark up Language) adalah salah satu protokol bahasa 
yang digunakan untuk berkomunikasi antarserver komputer dalam 
Internet.

Hub adalah alat yang berfungsi sebagai pusat suatu jaringan.

Hyperlink adalah fasilitas untuk mereferensikan atau menghubungkan 
sebuah kata, kalimat, simbol, gambar dengan alamat-alamat di Internet.

Hypertext adalah serangkaian kata pada dokumen HTML yang 
mempunyai hubungan (link) dengan dokumen HTML lain.

I
Internet adalah kumpulan dari jaringan komputer yang terhubung dan 
bekerja sebagai suatu sistem.

Internet Explorer adalah browser bawaan dari sistem operasi Windows.

Intranet adalah sebuah kumpulan jaringan komputer lokal yang 
menggunakan perangkat lunak Internet dan protokol TCP/IP atau 
HTTP.

IP adress adalah identitas komputer dalam jaringan yang terdiri dari 
empat bagian (mulai angka 1 sampai 255).

ISP (Internet Service Provider) adalah perusahaan atau lembaga penyedia 
jasa layanan Internet, seperti Wasantara, Indosatnet, Telkomnet, dan 
sebagainya.
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J
Jaringan komputer adalah sekumpulan komputer individu (personal 
computer) yang dihubung-hubungkan dengan menggunakan protokol 
Transmission Control Protocol/Internet Protocol (TCP/IP).

L
Leased line adalah jalur (telepon) yang digantikan fungsinya menjadi 
jalur Internet.

Local Area Network (LAN) adalah jaringan milik pribadi di dalam sebuah 
gedung atau kampus yang berukuran sampai beberapa kilometer.

M
Mailing list adalah suatu forum atau kelompok diskusi di Internet yang 
dapat saling bertukar informasi antarsesama anggota.

Metropolitan Area Network (MAN) adalah jaringan dengan area lebih 
luas dari LAN, dapat terdiri dari dua atau lebih LAN yang dihubungkan 
bersama-sama dalam batas-batas tertentu, misalnya dalam suatu 
kawasan metropolitan atau satu kota.

Modem adalah sebuah perangkat yang berfungsi untuk mengubah 
data analog menjadi data digital pada saat komputer mengambil data, 
atau mengubah data digital menjadi data analog pada saat komputer 
mengirimkan data.

Modem eksternal adalah modem yang ditempatkan di luar komputer dan 
dapat dipindah-pindah dari satu komputer ke komputer lain.

Modem internal adalah modem yang sudah terpasang di dalam komputer 
(terpasang langsung ke motherboard komputer).

Mozilla Firefox adalah penjelajah web antarplatform gratis yang 
dikembangkan oleh Yayasan Mozilla dan ratusan sukarelawan.

N
Network adalah suatu sistem komunikasi data antarkomputer.
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O
Offlin  adalah kondisi pada saat komputer tidak terkoneksi dengan 
Internet.

Offlin  browsing adalah sebuah cara untuk mengakses halaman web 
yang sudah disimpan pada memori komputer dengan tujuan untuk 
menghemat penggunaan waktu online.

Online adalah kondisi pada saat komputer terhubung ke Internet. 

P
Peer to peer adalah jaringan komputer dimana setiap host dapat menjadi 
server dan juga menjadi client secara bersamaan.

Point of Presence (POP) adalah tempat atau terminal yang digunakan 
untuk mengakses jaringan.

Protokol adalah sejumlah aturan yang menentukan bagaimana dua atau 
lebih komputer saling berkomunikasi.

R
Repeater adalah alat ysng berfungsi sebagai penguat sinyal.

Router adalah alat yang berfungsi sebagai pengatur lalu lintas dalam 
jaringan.

S
Search engine adalah aplikasi pencari data, informasi, alamat web site 
lain melalui input kata kunci dan fitur lainnya

Server adalah komputer penyedia data dan informasi yang akan diakses 
oleh client.

T
Teleconference adalah konferensi atau pertemuan jarak jauh melalui 
fasilitas yang ada di Internet.

Telnet adalah fasilitas dalam Internet untuk mengakses sebuah komputer 
dalam jaringan Internet seperti layaknya bekerja pada komputer sendiri.
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U
Upload adalah pengiriman data dan informasi dari komputer pengguna 
ke suatu web site.

URL (Universal Resource Locator) adalah sistem penamaan alamat 
situs web.

W
WAP (Wireless Application Protocol) adalah protokol yang dapat 
mengakses data-data di Internet secara online dengan menggunakan 
built in browser bagi pengguna ponsel.

Web adalah jaringan yang dapat menampilkan data-data dan informasi 
lain melalui Internet.

Web page adalah bagian dari web site yang merupakan lembaran-
lembaran halaman sebuah web site.

Web site adalah sebuah alamat di www yang menyediakan informasi 
tertentu.

Wide Area Network (WAN) adalah jaringan yang mempunyai jangkauan 
area sangat luas, misalnya antarpulau, negara, benua, bahkan ke luar 
angkasa.

World wide web adalah kumpulan penyedia web untuk dipakai secara 
massal di seluruh dunia.
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Lampiran
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Lampiran 1

Google Chrome
Pada September 2008, Google melancarkan sebuah serangan langsung 

ke lingkup web browser dengan meluncurkan Google Chrome, sebuah 
web browser baru yang diklaim memiliki terobosan baru dalam kecepatan, 
kemudahan penggunaan, serta integrasi yang baik dengan aplikasi berbasis 
web.

Logo web browser Google Chrome
Sumber: www.blogoflux.co

Browser Google Chrome ini didisain dengan memperhatikan sistem 
keamanan, kecepatan, dan stabilitas. Tampilannya seakan-akan merupakan 
gabungan dari sekian banyak browser yang sudah ada. Beberapa tombol 
navigasi dibuat mirip dengan Safari, sedangkan lokasi pengaturan lebih mirip 
dengan Internet Explorer 7, dan tombol untuk memperkecil atau memperbesar 
tampilan hampir mirip dengan Vista.

Sehari sebelum peluncuran pada 2 September 2008, Google 
mengeluarkan sebuah komik online yang menjelaskan latar belakang 
dibuatnya Chrome ini. Lewat komik tersebut, user akan mendapatkan 
penjelasan lengkap mengenai web browser.

Aplikasi ini menelurkan terobosan baru dalam segi pengelolaan memori 
pada suatu browser. Setiap tab di browser akan memiliki mapping sendiri dalam 
memori. Oleh karena itu, setiap tab akan memiliki proses tersendiri dalam 
sistem operasi. Jika ada satu tab yang mengalami error, maka hal tersebut 
tidak akan mempengaruhi tab lain dan browser secara keseluruhan.

Google juga telah menemukan algoritma efisien untuk melakukan 
rendering terhadap Javascript. Dari hasil benchmark awal yang dilakukan 

Google Chrome merupakan browser 
yang dibuat dengan desain praktis agar 
kita dapat mengakses Web dengan lebih 
cepat, mudah, dan aman. Browser ini bisa 
jadi bakal menenggelamkan browser yang 
telah ada selama ini. Pasalnya, Google 
Chrome memiliki kemampuan dan fitur-fitu
yang lebih canggih dibandingkan browser 
lainnya. Yang paling menarik dari browser 
ini adalah mode penyamaran. Maksudnya, 
halaman web yang telah dibuka dan 
diunduh (download) tidak dapat dilacak 
kembali atau disimpan riwayat alamatnya, 
karena langsung terhapus setelah jendela 
penyamaran ditutup. 
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CNet, Chrome unggul mutlak dalam hal kecepatan melakukan render 
Javascript. Pada era web 2.0 yang bertumpu pada teknologi Javascript 
seperti AJAX, Chrome dapat menjadi aplikasi pilihan para pengguna browser 
untuk mendapatkan kenyamanan dalam merambah internet. 

Chrome juga mengintegrasikan Google Gears di dalam inti browser 
tersebut. Gears merupakan tools dari Google yang memungkin aplikasi 
web-base Google seperti Docs, Readers, ataupun Gmail dijalankan secara 
offlin .

Lewat fitur Gears dan kecepatan dalam rendering Javascript, Google 
Chrome dikonsepkan sebagai dasar untuk memperkuat lini aplikasi web Google 
seperti Docs, Spreadsheet, Calendar, dan sebagainya. Google memang 
mempromosikan trend penggunaan aplikasi berbasis web menggantikan 
aplikasi desktop konvensional sebagai solusi aktivitas berkomputasi masa 
depan. 

Google menohok langsung ke jantung pasaran web browser yang masih 
didominasi oleh Internet Explorer (sekitar 75%). Langkah peluncuran ini 
dianggap sebagai langkah antisipatif Google dalam menghadapi datangnya 
Internet Explorer versi 8. Bukan rahasia lagi bila penguasaan pasar browser 
oleh Internet Explorer tersebut berdampak serius pada bisnis layanan 
pencarian Google.

Google Chrome diluncurkan dalam versi beta dan baru tersedia untuk 
platform Windows (Vista/XP). Untuk platform lain, seperti Mac ataupun Linux 
akan menyusul di kemudian hari.
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Lampiran 2

Safari Web Browser 4 Beta
Safari adalah sebuah penjelajah web buatan Apple Inc. yang awalnya 

ditujukan khusus bagi sistem operasi Mac OS. Safari dipasang bersama Mac 
OS X dan merupakan penjelajah web bawaan (default) di sistem operasi 
tersebut sejak Mac OS X v10.3. Sebelumnya, dari 1997 hingga 2003 Mac 
OS X menggunakan Internet Explorer for Mac sebagai penjelajah web 
bawaan. Pada 11 Juni 2007, versi pertama yang untuk Windows dari Safari 
diperkenalkan pada Konfrensi Apple di San Francisco.

Logo Safari web browser
Sumber: www.elementfusion.com

Internet Explorer saja. Namun, sebaiknya kita semua (khususnya masyarakat 
Indonesia) belajar untuk berubah ke arah yang lebih baik, semakin bijak dan 
pintar dalam menentukan pilihan, seperti halnya dalam memilih web browser 
yang baik.

Apple inc telah merilis web browser terbaru, yaitu Safari 4 yang 
menyertakan berbagai fitur baru dan bug fixe , termasuk di antaranya fitur
Cover Flow, full history search, engine JavaScript yang lebih cepat (dubbed 
Nitro), dan berbagai fitur lainnya

Fitur-fitur yang ditawarkan oleh 
Safari adalah:
1)	 Pembaca RSS
2)	 Tabbed browsing

Sebagai penjelajah dunia maya, 
kecepatan akses adalah suatu hal 
yang sangat penting. Kecepatan 
itu tidak hanya dipengaruhi oleh 
koneksi Internet saja, melainkan 
browser yang kita pakai. Pernahkah 
mencoba membandingkan antara 
Internet Explorer, Opera, Firefox, 
Safari, maupun browser yang lain? 
Mungkin bagi seseorang yang fanatik 
dan enggan berpindah persepsi akan 
selalu memakai apa yang diyakininya 
seperti halnya memakai browser 
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Tampilan Safari web browser
Sumber: www.google.com

Tampilan dari Safari adalah sebagai berikut:

Diluar perbaikan penampilan dan style Safari yang semakin sedap 
dipandang, Safari juga menyertakan Nitro Engine, yang diklaim akan membuat 
Safari jauh lebih cepat dan responsif dibandingkan dengan Google Chrome, 
Firefox 3.0, maupun Internet Explorer. Safari 4 ini bahkan diklaim lebih cepat 
3X dibandingkan dengan Firefox dan lebih cepat 30X dibandingkan dengan 
Internet Explorer 7.

Beberapa fitur baru Safari lainnya lebih merupakan tambahan efek untuk 
keindahan dan kemudahan pemakaian. Sebagai contoh, feature Top Sites 
mirip dengan model homepage di Google Chrome yang menampilkan link ke 
berbagai website favorit dalam 1kali klik
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Lampiran 3

Web Browser di Linux
Web browser adalah software yang digunakan untuk menjelajah dunia 

web di dunia maya atau Internet. Di Windows, kita mengetahui ada empat 
web browser yang saling bersaing merebut pasar, yaitu Windows Internet 
Explorer, Mozilla Firefox, Opera, dan Safari. Sedangkan di Linux, ada banyak 
sekali pilihan web browser yang bisa anda gunakan. Web browser tersebut 
ada yang berbasis GUI, bahkan ada juga yang bisa dijalankan di console. 
Jadi, kita bisa bersurfing ria walaupun dalam keadaan GUI dimatikan. Berikut 
adalah penjelasan dari beberapa web browser yang ada di dunia Linux.

1.	 Mozilla Firefox
Tentu kita semua sudah tahu tentang Mozilla Firefox (www.mozilla.

com). Firefox saat ini menjadi web browser open source yang sukses dan 
menjadi web browser kedua yang paling banyak digunakan. Web browser ini 
dikembangkan berbasis Web browser Mozilla yang saat ini sudah pensiun. 
Tidak hanya untuk Windows, Firefox juga tersedia untuk pengguna Linux 
maupun pengguna Mac OS. Di Linux, Firefox telah menjadi default web 
browser pada beberapa distribusi Linux populer seperti Ubuntu. Di Debian, 
Firefox dinamakan dengan Iceweasel karena nama Firefox beserta logonya 
tidak sesuai dengan kaidah software bebas dari Debian (DFSG).

2.	 Opera
Dahulu, Opera tersedia jika anda bersedia membayarnya. Namun saat 

ini, semenjak versi 8, Opera sudah bisa diunduh (download) secara gratis 
dari websitenya. Namun sayangnya, browser dari Norwegia ini masih belum 
tersedia secara Open Source. browser ini dikenal sangat lengkap, ringan dan 
cepat dalam membuka suatu website. Kita bisa mengunduhnya dari website 
resmi Opera di www.opera.com dan menemukan paket software dari Opera 
untuk berbagai macam distro.

3.	 Konqueror
Konqueror (www.konqueror.org) adalah browser serbaguna dan 

ringan dari desktop KDE. Tidak hanya berfungsi untuk browser, Konqueror 
juga bisa digunakan sebagai file manager, ftp client, ssh client, samba 
client, nfs client dan masih banyak lagi fungsi yang lainnya. Pada awalnya, 
browser ini merangkap menjadi file manager default di desktop KDE. Namun, 
semenjak pada versi KDE 4.0, Dolphin menggantikan fungsi file manager 
dari Konqueror. Walaupun begitu, kita masih bisa menggunakan Konqueror 
sebagai file manager. Sayangnya, browser ini masih kurang kompatibel 
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penuh dengan beberapa aplikasi web berbasis AJAX atau Web 2.0, seperti 
Gmail atau Blogger. 

4.	 Epiphany 
Epiphany (www.gnome.org) merupakan browser ringan berbasis 

Mozilla Gecko yang diciptakan khusus untuk desktop GNOME. Browser 
ini fiturnya bisa dikatakan setara dengan Mozilla Firefox. Untuk menambah 
kemampuannya, kita bisa menambahkan extension yang fungsinya sebagai 
add-ons untuk browser ini.

5.	 Seamonkey 
Seamonkey (www.mozilla.org/projects/seamonkey) merupakan 

cikal bakal dari Mozilla Firefox, yang mana dulunya bernama Mozilla Suite. 
Ternyata, browser ini sekarang dikembangkan lagi secara komunitas dan 
diberi nama baru yang bernama Seamonkey. Bagi para pecinta Netscape 
atau Mozilla Suite, tidak akan asing dengan browser ini. Kesan dari Mozilla 
Suite masih kental sekali dengan browser ini. Selain browser, aplikasi ini 
juga menyediakan fitur Mail Client, IRC Client, Web Composer, serta AIM 
Client. Sehingga, browser ini sangat lengkap untuk kebutuhan bersurfing
ria. Di distro Debian GNU/Linux yang menjunjung tinggi DFSG, Seamonkey 
direbrand dengan nama Iceape. 

6.	 Dillo
Dillo (www.dillo.org) merupakan web browser untuk X yang sangat 

ringan, stabil, dan cepat. Tidak heran jika web browser ini dijadikan 
sebagi browser default di beberapa distro mini, seperti DSL, Puppy, dan 
SystemRescueCD. 

7.	 Lynx
Lynx (http://lynx.isc.org) merupakan web browser pertama yang 

berbasis TUI (Text User Interfaces) atau Console. Browser ini berjalan di 
mode teks dan sangat sederhana sekali. Objek seperti gambar dan video 
tidak dapat ditampilkan oleh browser ini. Namun sayangnya, browser ini 
terlalu banyak nanya. Kita akan dikonfirmasi setiap kali browser yang kita 
gunakan diminta untuk menyimpan cookies. 

8.	 Links 
Links (http://artax.karlin.mff.cuni.cz/mikulaz/links) merupakan web 

browser berbasis teks yang sangat lengkap dan hadir dengan menu yang 
terstruktur, layaknya browser masa kini. Browser ini mendukung halaman 
HTML yang sangat kompleks dan dapat mengunduh file di balik laya .
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9.	 Elinks
Elinks (www.elinks.cz) merupakan versi enhanced/extended dari 

browser Links. Browser ini memiliki beberapa kelebihan daripada browser 
Links, yaitu dukungan CSS, Javascript, dan FTP. Web browser ini sangat 
baik menampilkan halaman web, layaknya pada saat ditampilkan di web 
browser biasa.
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